Symantec™ Data Center Security: Server Advanced

Administrator's Guide

Version 6.5
Symantec™ Data Center Security: Server Advanced
6.5 Administrator's Guide

Documentation version: 1.5

Legal Notice

Copyright © 2015 Symantec Corporation. All rights reserved.

Symantec, the Symantec Logo, the Checkmark Logo and are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party ("Third Party Programs"). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED "AS IS" AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 "Commercial Computer Software - Restricted Rights" and DFARS 227.7202, et seq. "Commercial Computer Software and Commercial Computer Software Documentation," as applicable, and any successor regulations, whether delivered by Symantec as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Symantec Corporation
350 Ellis Street
Mountain View, CA 94043

http://www.symantec.com
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan          customercare_apac@symantec.com
Europe, Middle-East, and Africa      semea@symantec.com
North America and Latin America      supportsolutions@symantec.com
<table>
<thead>
<tr>
<th>Technical Support</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chapter 1</strong></td>
<td>16</td>
</tr>
<tr>
<td>Introducing Symantec Data Center Security: Server Advanced</td>
<td>16</td>
</tr>
<tr>
<td>About Symantec Data Center Security: Server Advanced</td>
<td>17</td>
</tr>
<tr>
<td>About the DCS:SA components</td>
<td>19</td>
</tr>
<tr>
<td>How DCS:SA works</td>
<td>23</td>
</tr>
<tr>
<td>About DCS:SA components and features</td>
<td>24</td>
</tr>
<tr>
<td>About application data retrieval</td>
<td>26</td>
</tr>
<tr>
<td>About Unified Management Console</td>
<td>27</td>
</tr>
<tr>
<td>About the UMC interface</td>
<td>27</td>
</tr>
<tr>
<td>Defining the TLS connections in server.xml</td>
<td>28</td>
</tr>
<tr>
<td>About the management console</td>
<td>29</td>
</tr>
<tr>
<td>What you can do from the management console</td>
<td>29</td>
</tr>
<tr>
<td>Starting the management console</td>
<td>31</td>
</tr>
<tr>
<td>Configuring the console to connect to different servers</td>
<td>32</td>
</tr>
<tr>
<td>Defining the SSL connections in server.xml</td>
<td>33</td>
</tr>
<tr>
<td>Selecting a console view</td>
<td>34</td>
</tr>
<tr>
<td>Refreshing the console pages</td>
<td>35</td>
</tr>
<tr>
<td>Setting console preferences</td>
<td>36</td>
</tr>
<tr>
<td>Console timeout</td>
<td>39</td>
</tr>
<tr>
<td>Accessing Help</td>
<td>39</td>
</tr>
<tr>
<td>Verifying agent deployment and configuration</td>
<td>40</td>
</tr>
<tr>
<td>Verifying agent registration with the management server</td>
<td>41</td>
</tr>
<tr>
<td>Determining how an agent is configured</td>
<td>43</td>
</tr>
<tr>
<td>Determining how a group is configured</td>
<td>44</td>
</tr>
<tr>
<td>About agent log files</td>
<td>44</td>
</tr>
<tr>
<td>Viewing log rules that are applied to an agent</td>
<td>44</td>
</tr>
<tr>
<td>Viewing detection parameters applied to an agent</td>
<td>45</td>
</tr>
<tr>
<td>Viewing communication parameters applied to an agent</td>
<td>46</td>
</tr>
<tr>
<td>Viewing event logging parameters applied to an agent</td>
<td>47</td>
</tr>
<tr>
<td>Applying the Symantec policies to agents or groups</td>
<td>50</td>
</tr>
<tr>
<td>Applying a Symantec prevention policy to an agent or group</td>
<td>51</td>
</tr>
<tr>
<td>Applying a Symantec detection policy to an agent or group</td>
<td>53</td>
</tr>
<tr>
<td>Viewing event activity</td>
<td>54</td>
</tr>
</tbody>
</table>
Chapter 2 Using the Home page .............................................. 68

Viewing the Home page ......................................................... 68
Running queries ..................................................................... 69
Setting the event count in the console preferences .................... 69
Using the Home page in the Prevention view ......................... 69
  About the Agent Prevention Summary pane ....................... 69
  About the Network Actions pane ........................................ 70
  About the Agent Statistics pane ......................................... 70
  About the Quick Links pane ............................................. 71
Using the Home page in the Detection view ............................ 71
  About the Agent Detection Summary pane ......................... 71
  About the Event Rule Summary pane ................................. 72
  About the Agent Statistics pane ......................................... 72
  About the Quick Links pane ............................................. 73

Chapter 3 Managing assets .................................................... 74

About assets ............................................................................... 75
Viewing the Assets page .......................................................... 75
About asset search ..................................................................... 76
  Searching assets by attributes ............................................. 77
About console views, agents, and groups ............................... 79
  Using the Network view ........................................................ 79
  Using the Prevention view ................................................... 80
  Using the Detection view ..................................................... 85
  About common configuration groups .................................. 89
Viewing agents registered with the management server ............ 90
  About the management server health ................................. 90
Chapter 4  Managing policies ......................................................... 126

About policies ........................................................................... 127
About the Symantec policy library ........................................... 128
About policy viewer ................................................................. 128
Viewing the Policies page .......................................................... 129
  About the policy workspace .................................................... 130
Creating a prevention policy ...................................................... 131
Creating a detection policy ............................................................ 135
Creating default policies from an installed policy pack .................... 136
Publishing or unpublishing a policy .............................................. 136
Configuring the Domain Controller settings in a policy ..................... 136
Controlling custom sandboxes in prevention policies ...................... 137
Changing the sandbox for multiple events ...................................... 139
Allowing a program to run by using the Protected Whitelisting strategy .............................................................................. 141
About importing a large set of values for a parameter ....................... 141
 About creating an input comma-separated value file ....................... 142
 Importing an input CSV file ...................................................... 143
 Exporting the parameter values into a CSV file ............................ 144
 Adding group tags to custom sandboxes ....................................... 144
 Searching for custom sandboxes by group tags ............................ 145
 Modifying an existing group tag .................................................. 145
 Applying and reapplying policies ............................................... 146
 Applying a policy to an agent or group ....................................... 146
 Reapplying a policy to an agent or group ................................... 147
 Viewing policy properties .......................................................... 148
 Creating a policy folder ............................................................ 149
 Moving a policy to a folder ....................................................... 149
 Editing a policy ........................................................................... 149
 How to determine a policy's policy pack reference ......................... 150
 Copying policy options ................................................................ 151
 Renaming a policy ...................................................................... 152
 Copying a policy ....................................................................... 152
 Deleting a policy ...................................................................... 153
 Importing and exporting policies ............................................... 154
 Importing policies .................................................................. 154
 Exporting policies ................................................................... 155
 Updating a policy ....................................................................... 155
 Verifying prevention policies ...................................................... 157
 Opening the policy viewer .......................................................... 158
 Searching policies ...................................................................... 159
 Searching for policies in the policy viewer .................................... 160
 Policy viewer search filters ....................................................... 161
 Policy viewer display attributes ............................................... 163
 Policy Summary information .................................................... 165
 Advanced settings for SQL stored procedure ............................... 165
Chapter 7 Managing alerts ................................................................................................. 214

About alerts .................................................................................................................. 214
  About email aggregation ......................................................................................... 215
  About SNMP traps ................................................................................................. 215
  About alert text files ............................................................................................. 216
  About troubleshooting alert problems .................................................................... 216
Viewing the Alerts page ............................................................................................ 216
Configuring alert settings ......................................................................................... 217
Creating an alert ......................................................................................................... 218
  Creating an alert filter ........................................................................................... 218
  Specifying an email address template ................................................................... 219

File catalog event types ............................................................................................... 194
Analysis event types ................................................................................................... 194
Audit event types ......................................................................................................... 194
About event severity levels ......................................................................................... 194
About the System State event flag ........................................................................... 195
Viewing the Monitors page ........................................................................................ 196
Viewing event details on the console ......................................................................... 197
Setting the Monitors preferences .............................................................................. 198
Verifying the operation of an agent computer ......................................................... 198
Searching events ......................................................................................................... 198
Grouping events in the console by event type ......................................................... 200
Acknowledging an event ............................................................................................. 200
Resolving events .......................................................................................................... 200
  Using the Event Details command ....................................................................... 201
  Using the Event Agent command ........................................................................ 201
  Using the Event Policy command ....................................................................... 202
  Using the Event Wizard command .................................................................... 202
Suppressing events on the console ............................................................................ 205
Selecting a strategy for a selected group of events .................................................. 206
Updating the configuration rules for suppression strategies ..................................... 207
About real-time monitors ............................................................................................ 207
  Viewing a real-time monitor ................................................................................... 208
  Creating a real-time monitor .................................................................................. 208
  Searching events ...................................................................................................... 210
  Removing an event from a real-time monitor ....................................................... 210
  Importing a real-time monitor .............................................................................. 210
  Exporting a real-time monitor ............................................................................... 211
Remediating bulk events ........................................................................................... 211
Exporting events .......................................................................................................... 212
Purging events ............................................................................................................ 213
Chapter 8

Managing queries and reports

Viewing the Reports page
About the Symantec queries and reports
  About the Symantec queries
  About the Symantec reports
Managing queries
  Running a query
  Exporting query results to multiple file formats
  Creating a query
  Editing a query
Managing reports
  Running a report
  Creating a report
  Editing a report
Publishing a query or report
  Exporting a published report
About the command-line query tool
  Running the command-line query tool
  Distributing query and report output
Using folders
  Creating a folder
  Moving a query or report to a folder
  Deleting a query or report folder
Copying a query or report
Renaming a query or report
Exporting queries and reports
  Exporting a query
  Exporting a report
Importing queries and reports
  Importing a query
  Importing a report
Deleting a query or report ............................................................. 252

Chapter 9 Using the Admin page ...................................................... 253

Viewing the Admin page ............................................................... 254
Creating a user account ............................................................... 254
  Editing account information ..................................................... 256
Assigning roles to a user account ................................................ 257
Removing roles assigned to a user account ..................................... 258
Creating a custom role ............................................................... 258
  Examples of creating custom roles ........................................... 259
Assigning user accounts to a role ................................................ 260
Removing user accounts assigned to a role ................................... 261
Assigning access permissions to roles ........................................ 262
Allowing a role to edit the Security tab ....................................... 263
Resetting a password ............................................................... 264
Deleting a user account ............................................................. 264
Deleting a role ............................................................................ 264
Viewing or modifying system settings ........................................ 265
  About the management server health ...................................... 265
  About the Audit settings ......................................................... 266
  About the Login Notice setting .............................................. 266
  About the Event Management settings .................................... 266
  About the Virtual Agent settings ............................................ 267
  About the Agent Health setting .............................................. 267
  About the duplicate agent registration settings ....................... 268
Adding Active Directory servers ................................................ 269
  Creating users with Active Directory credentials ....................... 270
Viewing and exporting server configuration data ......................... 270
Managing the Tomcat server and Web applications ..................... 271
  Accessing the Tomcat Web server administration tool ............... 272
  Accessing the Tomcat Web Application Manager ...................... 273
  Accessing the Tomcat Server Status ...................................... 273
  About Tomcat terminology .................................................... 273
  Using the Tomcat Web Server Administration tool ................... 274

Appendix A DCS:SA log files ......................................................... 275

About log files ............................................................................ 275
  Agent log files ...................................................................... 275
  Management server log files .................................................. 277
About bulk log transfer .............................................................. 278
  How bulk log files are processed ............................................ 278
Loading bulk log events into the management server database ........................................... 279

Appendix B Event variables ............................................................................................ 281
  About event variables ................................................................................................. 281
  List of event variables ............................................................................................... 281

Appendix C Virtual agent examples ............................................................................... 296
  Capturing static policy-based virtual events from a text log file ......................... 296
  Capturing variable policy-based virtual events from a text log file ................. 297
  Capturing virtual events derived from the Windows event log ....................... 299
  Capturing events forwarded from DCS:SA ......................................................... 299

Appendix D Agent config tool ...................................................................................... 301
  About the agent config tool ..................................................................................... 301
  About the commands ............................................................................................... 302
  Running the agent config tool ................................................................................. 302

Appendix E Additional Resources ............................................................................... 304
  Where to get more information ............................................................................... 304
Introducing Symantec Data Center Security: Server Advanced

This chapter includes the following topics:

- About Symantec Data Center Security: Server Advanced
- About application data retrieval
- About Unified Management Console
- About the management console
- Starting the management console
- Selecting a console view
- Setting console preferences
- Console timeout
- Accessing Help
- Verifying agent deployment and configuration
- Applying the Symantec policies to agents or groups
- Viewing event activity
- Viewing agent, event, and Internet statistics
- About the Symantec queries and reports
- About updating Symantec policy and report packs
Symantec Data Center Security: Server Advanced (DCS:SA) provides a policy-based approach to endpoint security and compliance. The intrusion prevention and intrusion detection features of DCS:SA operate across a broad range of platforms and applications. DCS:SA provides:

- A policy-based host security agent for monitoring and protection.
- Proactive attack prevention using the least privilege containment approach.
- A centralized management environment for enterprise systems that contain Windows, UNIX, and Linux computers.

### Table 1-1

<table>
<thead>
<tr>
<th>Security and protection</th>
<th>Compliance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time proactive enforcement</td>
<td>Real-time monitoring and auditing</td>
</tr>
<tr>
<td>Intrusion and malware prevention</td>
<td>Host intrusion detection</td>
</tr>
<tr>
<td>System hardening</td>
<td>File integrity monitoring</td>
</tr>
<tr>
<td>Application control</td>
<td>Configuration monitoring</td>
</tr>
<tr>
<td>Privileged user access control</td>
<td>Tracking and monitoring of user access</td>
</tr>
<tr>
<td>Vulnerability and patch mitigation</td>
<td>Logging and event reporting</td>
</tr>
<tr>
<td>Does not use signatures or require continual updates to content</td>
<td></td>
</tr>
</tbody>
</table>

The major features of DCS:SA are as follows:

- Intrusion detection facility for compliance auditing
  - Real-time file integrity monitoring
  - Granular change detection of registry values, file contents, and attributes
  - Operating system and application log monitoring
Local event correlation and smart response actions

Intrusion Prevention facility for malware prevention and system lockdown

- Sandbox containment of operating system and application processes by an in-kernel reference monitor
- Granular access control of network, file systems, registry, process-to-process memory access, system calls, and application and child process launches
- Privileged user and program behavior

Anti-malware security
DCS:SA Security Virtual Appliance (SVA) provides agentless anti-malware security services for the virtualized network through integration with the VMware Network and Security Virtualization platform. DCS SVA provides two types of policies: Antivirus policies, and configuration policies.

- Comprehensive out-of-the-box policies for complete system monitoring and protection of physical and virtual systems

Security orchestration using Operations Director. Operations Director is intended to:
- Automate security provisioning workflow.
- Provide application-centric security service.
- Seamlessly integrate with VMware NSX.
- Provide out-of-box security product integration.

Centralized management environment for administering agents, policies, and events

Integration with Security Information and Event Management (SIEM) and other security tools, as well as enterprise infrastructure components such as Active Directory, SMTP, and SNMP

Broad platform support across Windows, Linux, UNIX and virtual environments for critical servers, workstations, laptops, and standalone systems

The major benefits of DCS:SA are as follows:

- Reduces emergency patching and minimizes patch-related downtime and IT expenses through proactive protection that does not require continuous updates.
- Reduces incidents and remediation costs with continuous security. Once the agent has a policy, it enforces the policy even when the computer is not connected to the corporate network. And even if a computer is unable to obtain the latest patches in a timely fashion, DCS:SA continues to block attacks so that the computer is always protected.
Provides visibility and control over the security posture of business-critical enterprise assets.

Uses predefined compliance and hardening policies to provide efficient security management, reporting, alerting, and auditing of activities. Also provides compensating controls for compliance failures.

About the DCS:SA components

DCS:SA includes management console and server components, includes agent components that provide intrusion prevention and detection on physical or virtual computers, and includes the Security Virtual Appliance (SVA) that provides agentless anti-malware protection for VMware guest VMs running Windows. The management server and management console run on Windows operating systems. The management console can be accessed using Java console only. The agents run on Windows and UNIX operating systems. UMC, DCS SVA, and OD are virtual appliances. The UMC is deployed using the VMware. The SVA is deployed into VMWare NSX using UMC. The OD is deployed on UMC using the VMware vCenter.

The management components of DCS:SA can be installed on one system or in a distributed model. Agents are generally deployed to every supported host to be monitored and protected, including the management server, management console, and SQL server database. Remote monitoring can extend file integrity monitoring and log monitoring functionality to systems where no native agent exists. For example, such systems include mainframe zLinux, AS 400, VAX, or VMS systems.

The following diagram displays the DCS:SA environment setup:
Figure 1-1 DCS:SA environment setup

Introducing Symantec Data Center Security: Server Advanced

About Symantec Data Center Security: Server Advanced
### Table 1-2  Key components of DCS:SA

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Center Security: Security Virtual Appliance (DCS SVA)</td>
<td>The DCS SVA provides agentless anti-malware security services for VMware guest virtual machines. The DCS SVA is deployed as the Datacenter Protection Service from the vSphere web client, after registering the service with the NSX Manager. DCS SVA’s reputation based exoneration capabilities minimizes the convictions of false positives. For information on deploying and using the SVA see the <em>Symantec Data Center Security: Server Advanced Implementation Guide Integration with VMware NSX</em>.</td>
</tr>
</tbody>
</table>
| DCS:SA agent for behavior control             | The DCS:SA agent for behavior control provides the following capabilities:  
  ■ Intercepts the system calls to enforce prevention policies  
  ■ Contains multiple detection sensors for monitoring system change events and log files  
  ■ Contains the tools for configuration and diagnostic support  
  ■ Downloads the policies and settings from the management server and uploads events and status information to the management server  
  ■ Natively supports a wide variety of Windows, UNIX and Linux servers and workstations  
  ■ Supported on VMware guest systems for detection and prevention with any of the operating systems that are natively supported  
  ■ Can be used to remotely monitor another host without a native agent, but note that only detection features are available in this mode  
  See the *Symantec Data Center Security: Server Advanced Platform and Feature Matrix* for more information on the supported operating systems, and agent features supported on each operating system. |
| Management server                             | The management server is based on Tomcat Application Server software. The management server provides the following capabilities:  
  ■ Secure communications with agent and console  
  ■ Bulk event file storage management for efficient archival storage of all logged events  
  ■ Store policies in a central location and provides an integrated, scalable, flexible, agent, and policy management infrastructure.  
  ■ Alert processing (SMTP, SNMP, file), data purging, and other management functions  
  ■ Coordinate policy distribution, and manages agent event logging and reporting.  
  The management server supports high availability and scalability. |
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management console</td>
<td>The management console is accessed using the thick console, and provides the following capabilities:</td>
</tr>
<tr>
<td></td>
<td>■ Policy, agent, and event management</td>
</tr>
<tr>
<td></td>
<td>■ Real-time event monitoring from the dashboard</td>
</tr>
<tr>
<td></td>
<td>■ Flexible hierarchy and agent grouping support</td>
</tr>
<tr>
<td></td>
<td>■ Event Wizard for quick policy adjustment</td>
</tr>
<tr>
<td></td>
<td>■ Querying, reporting, alerting</td>
</tr>
<tr>
<td></td>
<td>■ User and role management</td>
</tr>
<tr>
<td></td>
<td>■ Auditing console actions and server events</td>
</tr>
<tr>
<td>Database</td>
<td>The database provides the following capabilities:</td>
</tr>
<tr>
<td></td>
<td>■ Accessible through JDBC/ODBC</td>
</tr>
<tr>
<td></td>
<td>■ Stores the policies, agent information, and real-time actionable events</td>
</tr>
<tr>
<td></td>
<td>■ Lets you configure encrypted communications between the database and the management server</td>
</tr>
<tr>
<td>Predefined Detection and Prevention policies</td>
<td>The predefined Detection and Prevention policies provide the following capabilities:</td>
</tr>
<tr>
<td></td>
<td>■ Best practice policy content for operating system protection of Windows, Linux, and UNIX.</td>
</tr>
<tr>
<td></td>
<td>■ Common use case templates for creating customer-specific rules</td>
</tr>
<tr>
<td></td>
<td>■ Easy policy configuration interface</td>
</tr>
<tr>
<td></td>
<td>■ Flexible administration of the policies that are applied to agents in the SVA.</td>
</tr>
<tr>
<td>Predefined Anti-malware policies</td>
<td>DCS SVA provides out-of-the-box anti-malware policies to protect your virtual environment against malware. DCS SVA provides two types of policies as follows:</td>
</tr>
<tr>
<td></td>
<td>■ Antivirus policies are the policies that provide basic level and advanced level protection from malware.</td>
</tr>
<tr>
<td></td>
<td>For example, antivirus policies can be configured to provide protection to the guest virtual machines from malicious virus attacks.</td>
</tr>
<tr>
<td></td>
<td>■ Configuration policies are predefined configuration settings that are applicable to the DCS SVA.</td>
</tr>
<tr>
<td></td>
<td>For example, configuration policies define the behavior of a DCS SVA and can generate events if any changes are made to the configuration settings of a SVA and its services, and when the settings of scheduled scans and LiveUpdate server are changed.</td>
</tr>
</tbody>
</table>
Table 1-2 Key components of DCS:SA (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified Management Console</td>
<td>The Unified Management Console (UMC) is a console appliance that provides a web-based console to register, configure, and manage various features and products in Symantec Data Center Security: Server.</td>
</tr>
<tr>
<td>Operations Director</td>
<td>Security orchestration feature powered by Operations Director is intended to:</td>
</tr>
<tr>
<td></td>
<td>■ Automate security provisioning workflow.</td>
</tr>
<tr>
<td></td>
<td>■ Provide application-centric security service.</td>
</tr>
<tr>
<td></td>
<td>■ Seamlessly integrate with VMware NSX.</td>
</tr>
<tr>
<td></td>
<td>■ Provide out-of-box security product integration.</td>
</tr>
</tbody>
</table>

See the Symantec Data Center Security: Server Advanced Planning and Deployment Guide for detailed information on planning a DCS:SA deployment in an enterprise environment, and installing the DCS:SA components. The Symantec Data Center Security: Server Advanced Planning and Deployment Guide also provides information on the system requirements for installing the product components. See the Symantec Data Center Security: Server Advanced Operations Director Reference Guide for more information on using Operations Director. See the Symantec Data Center Security: Server Advanced Platform and Feature Matrix for information on the supported operating systems, and agent features supported on each operating system.

How DCS:SA works

DCS:SA controls and monitors what programs and users can do to computers. Agent software at the endpoints controls and monitors behavior based on policy.

The DCS:SA policy library contains prevention and detection policies that you can use and customize to protect your network and endpoints, as follows:

■ A prevention policy is a collection of rules that governs how processes and users access resources.
  For example, prevention policies can contain a list of files and registry keys that no program or user can access. Prevention policies can contain a list of UDP and TCP ports that permit and deny traffic. Prevention policies can deny access to startup folders. Prevention policies define the actions to take when unacceptable behavior occurs.

■ A detection policy is a collection of rules that are configured to detect specific events. An agent can enforce one or more detection policies simultaneously.
For example, detection policies can be configured to generate events when files and registry keys are deleted; when known, vulnerable CGI scripts are run on Microsoft Internet Information Server (IIS); when USB devices are inserted and removed from computers; and when network shares are created and deleted.

You use the Java console to manage agent policies, and customize how agents communicate with the management server.

Agents report events to the management server for storage and are viewed in the Java console. Agent log rules control the events that are logged for that agent. Logged data includes event date and time, event type, importance rating, and any prevention action performed.

DCS:SA includes queries and reports with charts, graphs, and tables that provide detailed and aggregated summary data about events, agents, and policies. You can also create your own queries and reports.

Transport Layer Security using X.509 certificates secures communication between the Java console and the management server, and between the agent and the management server.

About DCS:SA components and features

The key components of DCS:SA and their features are as follows:

Computer security: Offers a flexible computer security solution that includes the following features:

- Day-zero protection: stop malicious exploitation of systems and applications; prevent introduction and spread of malicious code
- Hardened systems: lock down OS, applications, and databases; prevent unauthorized executables from being introduced or run
- Integrated firewall blocks inbound and outbound TCP/UDP traffic; administrator can block traffic per port, per protocol, per IP address or range
- Maintain compliance by enforcing security policies on clients and servers
- Buffer overflow protection
Out-of-the-box security policies offer the following features:

- Intrusion prevention
  - Proactive security against day-zero attacks
  - Protection against buffer over-flow and memory-based attacks
  - Out-of-the-box operating system hardening
  - External device protection
  - Administrative privilege de-escalation

- Intrusion detection
  - Sophisticated policy-based auditing and monitoring
  - Log consolidation for easy search, archival, and retrieval
  - Advanced event analysis and response capabilities
  - File and registry protection and monitoring

- Policies configured with easy enable/disable style options
- Includes application policies for popular Microsoft® interactive applications

Java console

Java console that lets administrators create and deploy policies, manage users and roles, view alerts, and run reports.

Features include the following:

- Configure agent properties to determine how agents communicate with the management server and which events agents send to the management server
- Customize policy options to increase or decrease restrictions enforced by a policy
- Import and export custom and third-party policies

Agent

Agents enforce policy on the endpoint. Features include the following:

- Control behavior by detecting and preventing specific actions that an application or user might take
- Configure polling interval, real-time notification, log consolidation, log rotation
- Apply policies to agents and groups agents
- Load policies without reboot

Management server

Provides secure communication to and from agents and the Java console.

Features include the following:

- Agents automatically register with the management server during installation
- Sends configuration changes to agents
- Real-time and bulk logging of agent events
Platform support

Symantec Data Center Security: Server Advanced offers broad platform support for the following operating systems:

- Ubuntu
- Microsoft Windows
- Sun™ Solaris™
- Red Hat® Enterprise Linux
- CentOS Linux
- Oracle Linux
- SUSE® Enterprise Linux
- IBM® AIX®
- Hewlett-Packard® HP-UX®

See the Symantec Data Center Security: Server Advanced Platform and Feature Matrix to determine the specific operating system versions supported and the specific agent features for each operating system version.

About application data retrieval

In Symantec Data Center Security: Server Advanced v6.5, a new functionality for Windows Get Applications Data is added to retrieve the application data. Get applications data lets you collect information of installed applications and services on the system for a Windows agent.

Currently, when the agent is registered with the server, Application Data Retrieval (ADR) is triggered as per the default setting only once. ADR automatically collects the information of applications.

To enable application data retrieval for an asset

1. In the management console, click Assets.
2. Under the Assets tab, click Prevention.
3. On the Assets page, right click on an individual asset, and then select Get Applications Data.

To enable application data retrieval for an asset group

1. In the management console, click Assets.
2. Under the Assets tab, click Prevention.
3. On the Assets page, right click on an asset group, and then select Get Applications Data.
Note: The command **Get Applications Data** is unavailable till the ADR is in process. As soon as the ADR process is complete, the command is available, and an event is generated.

### About Unified Management Console

The Unified Management Console (UMC) is a console appliance that provides a web-based console for NSX virtual data center protection and orchestration. The console is used to register and configure various features and products in Symantec Data Center Security: Server Advanced (DCS:SA).

UMC provides unification of the common tasks across DCS:S, DCS:SA, and Operations Director.

A UMC administrator has the required rights and permissions to configure and set up the DCS:SA products.

See “About the UMC interface” on page 27.

### About the UMC interface

Unified Management Console helps you configure and set up the various features and products in DCS:S.

Using the Unified Management Console, you can do the following:

- **Home page**
  
  You can view the following from the Home page:
  - Provide step by step guidance to configure DCS:S.
  - View direct links to related workspaces and product help for respective step.

- **Monitor page**
  
  You can do the following from the Monitor page:
  - Facilitates download of UMC and Operations Director logs directly from the console.
You can do the following from the Settings page:

**User Management**
- Search users and groups in the configured Active Directory and assign them roles in DCS:S.

**Product Setup**
- Approve or deny registration requests received from various features and products. Unregister products or features that are already registered.

**Integration**
- Configure the Active Directory
- Configure VMware vCenter server settings.
- Configure VMware NSX server settings.
- Configure Security Virtual Appliance.
- Configure Alerts and Notifications.
- Configure Orchestrated Security Products

**LiveUpdate**
- Configure the LiveUpdate server settings.
- Configure the Proxy server settings.

**Licenses**
- Import licenses for the products registered with UMC.
- Configure data collection for Telemetry.

### Defining the TLS connections in server.xml

Transport Layer Security using X.509 certificates secures communication between the Unified Management Console and the management server, and between the agent and the management server.

If you do not want to use TLS X.509 certificate-based channel encryption for SCSP, you must define the TLS connections in the server.xml file, found on the management server.

The server.xml file is located in the following directory:

```<Installation Directory>\Symantec\Symantec\Data Center Security Server\Server\tomcat\conf\```

**To define the TLS connections in server.xml**

1. In the **New Server Configuration** dialog, uncheck **Use encrypted communications**.
2. Using Notepad or other text editor, edit `server.xml`.

3 In `server.xml`, define the TLS connection in the agent service tag.

   Inside the agent service tag (look for `<Service name="<server name>-Agent-Service">`), a Connector tag defines the default TLS connection. Immediately following this is a commented definition for a non-TLS connection. To enable non-TLS connections, uncomment the second connection, and change its port number if desired. The port that you specify must not be in use by any other programs on the system. To conserve resources, it is not recommended to leave both connectors uncommented unless you need to use both TLS and non-TLS communications.

4 In `server.xml`, define the TLS connection in the console service tag.

   Inside the console service tag (look for `<Service name="SSS-Console-Service">`), there is a similar TLS connector and commented non-TLS connector. Follow the same instructions as for the agent connectors.

5 Save the changes to `server.xml`.

6 Restart the SCSP Server service.

---

### About the management console

The Symantec Data Center Security: Server Advanced management console provides an interface for users and administrators. It is used to manage Symantec Data Center Security: Server Advanced policies and agents, and perform administrative tasks such as creating user accounts, restricting the functions that users can access, and running reports.

### What you can do from the management console

Symantec Data Center Security: Server Advanced divides features and tasks that you can perform in the management console by pages. You can access the other pages in the management console from any page that you are currently viewing, without losing the state of each page.

Using the pages in the management console, you can do the following:
You can do the following from the Home page:

- View statistics about the agents that generated recent events
- View statistics about the network activity of the most recent events
- View statistics about the number of agents registered with management server
- View the current Symantec ThreatCon rating, which provides an overall view of global Internet security
- Access common tasks and functions that you can perform on other pages in the management console

You can do the following from the Assets page:

- List all agents that are registered with the management server
- List agents that are registered with the management server and support prevention and detection features
- View the health of agent and not all software on it
- Apply prevention and detection policies to agents and groups
- Apply prevention and detection configurations to agents and groups
- Configure agent health settings
- Register virtual agents that indirectly detect off-platform event data and associate the data with agents in the management console

You can do the following from the Policies page:

- View policies enforced by agents
- Create and edit policies
- Organize policies in folders
- Copy and delete policies
- Import and export policies

You can do the following from the Configs page:

- View configurations applied to agents
- Create and edit configurations
- Configure communication between agents and the management server
- Configure which events agents send to the management server
- Configure detection parameters: file, event log, audit, registry, syslog, WTMP, BTMP, and C2 collectors
- Copy and delete configurations
- Import and export configurations
Monitors page  You can do the following from the Monitors page:
- View summaries and details of events produced by Symantec Data Center Security: Server Advanced
- Filter events by time: within the last hour, day, week, month, or year
- Use the Event Wizard to resolve events
- Search events based on criteria such as event type, time of occurrence, severity, source computer, and operating system
- Use real-time monitors to view events as they occur

Reports page  You can do the following from the Reports page:
- Run predefined queries and reports with charts, graphs, and tables
- Create custom queries and reports
- Export report results to a file

Alerts page  You can do the following from the Alerts page:
- Send alerts using email and SNMP messages whenever an event matching an alert filter is observed by Symantec Data Center Security: Server Advanced
- Create and edit alerts
- Enable and disable alerts
- Configure alert settings
- Import and Export alerts

Admin page  You can do the following from the Admin page:
- Create, edit, and delete user accounts
- Create roles and grant access to assets based on those roles
- Configure audit settings to audit the execution of searches, queries, and reports
- Configure Active Directory servers
- Manage the Apache Tomcat server and Web applications
- View server configuration on the console

Starting the management console

If you are starting the management console for the first time after installation, you must configure the console. Console configuration prompts you to enter a series of values that consist of port numbers, passwords, and a server name.

Note: The console closes if you enter a wrong password more than thrice.
See the *Symantec Data Center Security: Server Advanced Planning and Deployment Guide* for instructions on how to configure the management console after initial installation.

**To start the management console**

1. Click **Start > Programs > Symantec Data Center Security: Server Advanced > Management Console**.
2. In the **Login** dialog, in the **Username** and **Password** boxes, type your user name and password.
3. In the **Login** dialog, in the **Server** box, select the management server.
4. Click **Login**.

**Configuring the console to connect to different servers**

You can open multiple management console windows that connect to different management servers in your network. For each management server, you need to configure the console.

To configure the console, specify the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Server</td>
<td>A descriptive name for the management server.</td>
</tr>
<tr>
<td>Host</td>
<td>The host name or IP address of the management server computer.</td>
</tr>
<tr>
<td></td>
<td>If you enter a host name, it must be a name that your local system can</td>
</tr>
<tr>
<td></td>
<td>resolve into the management server's IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>The management server port that was used during Symantec Data Center Security: Server Advanced installation.</td>
</tr>
<tr>
<td>Admin Port</td>
<td>The Apache Tomcat administration port that was used during Symantec Data Center Security: Server Advanced installation.</td>
</tr>
<tr>
<td></td>
<td>If you used the default admin port during installation, then use the default admin port (8081).</td>
</tr>
</tbody>
</table>
Use encrypted communications

Check **Use encrypted communications** to use Secure Sockets Layer (SSL) X.509 certificate-based channel encryption for Symantec Data Center Security: Server Advanced.

Default: enabled

If you feel that your system provides adequate firewall security and you do not want to use SSL X.509 certificate-based channel encryption for DCS:SA, uncheck **Use encrypted communications**. If you uncheck **Use encrypted communications**, you must define the SSL connections in the server.xml file, found on the management server.

See “Defining the SSL connections in server.xml” on page 33.

To configure the console to connect to different management servers

1. Click **Start > All Programs > Symantec Data Center Security Server > Management Console**.
2. In the **Login** dialog box, click the green plus sign (+) icon.
3. In the **New Server Configuration** dialog box, specify the configuration information for the management server to which you want to connect.
4. In the **New Server Configuration** dialog box, click **OK** to save your changes.
5. Type the username for your new management server.
6. Click **Login**.
7. In the **Certificate** dialog box, select **Always accept this certificate**, and then click **OK**.
8. In the **Set Password** dialog box, type the password for the management server you want to set, and then click **Set**.

Defining the SSL connections in server.xml

SSL X.509 certificate-based channel encryption secures communication between the management console and the management server, and between the agent and the management server.

If you do not want to use SSL X.509 certificate-based channel encryption for Symantec Data Center Security: Server Advanced, you must define the SSL connections in the server.xml file, found on the management server.

The server.xml file is located in the following directory:

<Installation Directory>\Symantec\Symantec\Data Center Security Server\Server\tomcat\conf\
To define the SSL connections in server.xml

1 In the New Server Configuration dialog, uncheck Use encrypted communications.

2 Using Notepad or other text editor, edit server.xml.

3 In server.xml, define the SSL connection in the agent service tag.

   Inside the agent service tag (look for <Service name="<servername>-Agent-Service"), a Connector tag defines the default SSL connection. Immediately following this is a commented definition for a non-SSL connection. To enable non-SSL connections, uncomment the second connection, and change its port number if desired. The port that you specify must not be in use by any other programs on the system. To conserve resources, it is not recommended to leave both connectors uncommented unless you need to use both SSL and non-SSL communications.

4 In server.xml, define the SSL connection in the console service tag.

   Inside the console service tag (look for <Service name="SSS-Console-Service"), there is a similar SSL connector and commented non-SSL connector. Follow the same instructions as for the agent connectors.

5 Save the changes to server.xml.

6 Restart the Symantec Data Center Security: Server Advanced Server service.

Selecting a console view

The console views let you organize your agents independently for each feature. The agent groups in each view have no relationship to each other. When collecting policy and configuration data for an agent, Symantec Data Center Security: Server Advanced uses the rules for each console view to find the appropriate data and then sends that data to the agent.

Every console view has different set of console pages. Some pages function identically in each view, while other pages are customized for a view.

Table 1-3 Console views and their associated pages

<table>
<thead>
<tr>
<th>Console view</th>
<th>Console pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>■ Summary</td>
</tr>
<tr>
<td></td>
<td>■ Prevention</td>
</tr>
<tr>
<td></td>
<td>■ Detection</td>
</tr>
</tbody>
</table>

Selecting a console view
Table 1-3 Console views and their associated pages (continued)

<table>
<thead>
<tr>
<th>Console view</th>
<th>Console pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td>■ Network</td>
</tr>
<tr>
<td></td>
<td>■ Prevention</td>
</tr>
<tr>
<td></td>
<td>■ Detection</td>
</tr>
<tr>
<td>Policies</td>
<td>■ Prevention</td>
</tr>
<tr>
<td></td>
<td>■ Detection</td>
</tr>
<tr>
<td>Configs</td>
<td>■ Prevention</td>
</tr>
<tr>
<td></td>
<td>■ Detection</td>
</tr>
<tr>
<td>Monitors</td>
<td>■ Events</td>
</tr>
<tr>
<td></td>
<td>■ Alerts</td>
</tr>
<tr>
<td></td>
<td>■ Notifications</td>
</tr>
<tr>
<td>Reports</td>
<td>■ Queries</td>
</tr>
<tr>
<td></td>
<td>■ Reports</td>
</tr>
<tr>
<td></td>
<td>■ Published Results</td>
</tr>
<tr>
<td>Admin</td>
<td>■ Users</td>
</tr>
<tr>
<td></td>
<td>■ Roles</td>
</tr>
<tr>
<td></td>
<td>■ Settings</td>
</tr>
</tbody>
</table>

Your selected console view is preserved as you move among the pages in the management console. You can access the other pages in the console from any page in which you are currently working without losing the state of each page. The management console remembers the last console view that you selected and displays that console view the next time you log on to the management console.

To select a console view

1. In the management console, click any tab.
2. Under the selected tab, click any view.

Refreshing the console pages

The console pages do not refresh automatically. You should manually refresh the console pages to ensure that the information is current.
To manually refresh the Home page
◆ In any of the tabs on the management console, click **Refresh**.

## Setting console preferences

Console preferences comprise the following:

- **General**
- **Assets**
- **Monitors**
- **Policy Tuning Actions**

You can access console preferences from any page in the management console.

**General** preferences are as follows:

<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent Event Count</td>
<td>The maximum number of events on which the Home page statistics are based. The default setting is 500 events. Depending on the size of or the number of events that are generated in your network, you might want to increase or decrease this value.</td>
</tr>
<tr>
<td>Recent Events (hours)</td>
<td>The number of hours on which the Home page statistics are based. The default setting is the last 12 hours (events that occurred in the last 12 hours).</td>
</tr>
</tbody>
</table>
Indicate how the management console connects to the Internet, to view threat alerts. Symantec posts Internet threat alerts, which warn of Internet vulnerabilities. You can view these threat alerts from the management console Home page.

Select one of the following check boxes to indicate how the management console connects to the Internet:

- **Direct connection to the Internet**
  
  Check Direct connection to the Internet if you use a direct connection to the Internet. By default, this check box is selected.

- **Manual proxy configuration**
  
  Check Manual proxy configuration if you use a manual proxy configuration. Type the HTTP proxy and port number.

**Auto increment revision number**

Check to automatically assign a revision number to the policies.

Auto-increment is supported when the policy revision is a numeric value. For policy revisions that use a non-numeric value, this feature is treated as disabled and the existing revision number is displayed. In such cases, you have to manually update the policy revision number.

**Assets page preferences are as follows:**

Number of assets The number of assets to be displayed on each page.

**Monitors page preferences are as follows:**

Number of events per page (Monitors) The number of events per page that are shown on the Monitors page. The default setting is 500.
Show event preview by default | Check **Show event preview by default** to view events and event details in the same window. You can continue to display the Event Details window even when this check box is selected. When changing this setting, you must restart the management console for the setting to take effect. By default, this check box is selected.

Number of events per page (Search) | The number of events per page that are shown in the search windows. The default setting is 500.

Get old events no farther back than <number of> events | The age of the events that are shown in real-time monitors. The default setting is two days. For example, if the value set is two days, then real-time monitors display events that were logged during the past two days.

On startup, get no more than <number of> events | The number of events to accept at a time on startup of real-time monitors. The default setting is 100 events.

Check for new events every <number of> minutes | How many minutes real-time monitors poll for events. The default setting is 1 minute.

Fetch a maximum of n events at a time | The number of events that real-time monitors accept at a time. The default setting is 500 events.

**Policy Tuning Actions** page preferences are as follows:

Check for new policy tuning actions every <number of> minutes | The frequency at which the DCS:SA manager should check for new policy tuning actions on the agent. The default value is 1 minute.
To set console preferences

1. In the management console, on top-right, click **Preferences**.
2. In the **Console Preferences** dialog, on the **General** tab, specify the general preferences.
3. In the **Console Preferences** dialog, on the **Monitors** tab, specify the Monitors page preferences.

**Console timeout**

You can set a timeout value for the console. The sis-server.properties file contains the configuration values. This file is located in the C:\Program Files\Symantec\Data Center Security Server\Server\tomcat\conf directory. You must edit this file manually to set console timeout. If you have multiple Tomcat servers in your Symantec Data Center Security: Server Advanced Server installation, ensure that you edit each server to get consistent timeout behavior.

For example, to turn on this feature and set the console to lock after 15 minutes of inactivity, add the following lines to sis-server.properties file:

```
sissession.autologin.enabled=false
sissession.timeout=15
```

**Table 1-4**  Console timeout configuration values

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| sissession.autologin.enabled | When the value is set to true, the console automatically logs on again when the session expires.  
When the value is set to false, the console prompts the user to enter their password to continue the session. |
| sissession.timeout   | Sets the desired interval of inactivity before the session times out, in minutes. |

**Accessing Help**

If you use Internet Explorer, you may get a security warning or blocked content errors from Internet Explorer Enhanced Security when you try to access the Symantec Data Center Security: Server Advanced help in the console. This issue occurs when a combination of Internet Explorer Enhanced Security and Security Zone GPOs blocks Web access to the help URL in the Symantec Data Center Security: Server Advanced management console. You may or may not be able to
add the site to your Trusted sites zone. The Add button may not be available, or you may see an error.

Following are some actions that may display the Help system on your computer:

- Add the URL for Symantec Data Center Security: Server Advanced to your Trusted sites zone.
- Disable Internet Explorer Enhanced Security.
- Change the Internet zone security level to Medium-high.
- If the Symantec Data Center Security: Server Advanced URL has been added to Restricted Sites, you may need to remove the URL from the Restricted Sites list.

Domain Policy may also need to be adjusted before you can make changes to Internet Options > Security. For example, Domain Policy may prohibit adding URLs to your Trusted sites zone, under Computer Configuration > Administrative Templates > Windows Components > Internet Explorer:

- Security Zones: Use only machine settings
- Security Zones: Do not allow users to change policies
- Security Zones: Do not allow users to add or delete sites

Note: Refer to the following Microsoft article, if you use Internet Explorer 7 on Windows XP, Vista, or Server 2003 and this issue affects you:

You cannot add a Web site to the "Trusted sites" zone when Internet Explorer 7 is installed even when the user account belongs to the Administrators group

Verifying agent deployment and configuration

After installing Symantec Data Center Security: Server Advanced, you can verify your agent deployment and configuration, as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify agent registration</td>
<td>View the Assets page to verify that your agents registered successfully with the management server. See “Verifying agent registration with the management server” on page 41.</td>
</tr>
</tbody>
</table>
### Table 1-5  Steps to verifying agent deployment and configuration (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | View agent and group configuration | View agent and group properties to obtain an overview of how your agents and groups are pre-configured.  
See “Determining how an agent is configured” on page 43.  
See “Determining how a group is configured” on page 44. |
| 3    | Learn about agent log files      | Become familiar with the agent log files.                                                    
See “About agent log files” on page 44. |
| 4    | View agent log rules            | View log rules to determine which events are pre-configured for transmission to the management server.  
See “Viewing log rules that are applied to an agent” on page 44. |
| 5    | View detection parameters       | View detection parameters to determine how the detection features of your agents operate.  
See “Viewing detection parameters applied to an agent” on page 45. |
| 6    | View communication parameters   | View communication parameters to determine how agents are pre-configured to communicate with the management server.  
See “Viewing communication parameters applied to an agent” on page 46. |
| 7    | View event logging parameters   | View logging parameters to determine how agents are pre-configured for event logging.  
See “Viewing event logging parameters applied to an agent” on page 47. |

### Verifying agent registration with the management server

In a centralized database environment, when multiple DCS:SA managers are connected to the same database, it is useful to identify the Management Server to which an agent currently communicates with. It is also useful to identify the number of agents each Management Server hosts when you have more than one Management Server.

Symantec Data Center Security: Server Advanced provides these capabilities by storing the Management Server name against every agent. Symantec Data Center Security: Server Advanced uses the ManagerName field to store the manager name to which an agent communicates to. The field is populated at the time of
registration. The field is updated whenever an agent starts communicating to the fail over server. The new implementation takes care of existing agents, and populates the manager name when the agents starts communicating with the updated server.

Symantec Data Center Security: Server Advanced has a bar graph agent-server distribution that helps you visualize the distribution of agents amongst different Management Server. The new graph can be located under Reports tab.

The exact path is as follows:

Queries > Symantec > #VERSION# > agents

Your agent deployment includes the DCS:SA Manager virtual agent that was automatically created during installation. The DCS:SA manager collects all server-related events. A DCS:SA manager is registered into the Virtual Agents folder in the Network group, in the Master view.

To verify agent registration with the management server

1. In the management console, click Assets.
2. Under the Assets tab, click Network.
3. To view your deployed agents, in the Network Assets tree, click Network.
4. To view the DCS:SA manager virtual agent, in the Network Assets tree, click the Virtual Agents folder.

About the management server health icon

In the management console menu bar, the overall health of the connection between the management server and the database is indicated by one of the following icons:

- A green circle icon indicates that the management server is running.
- A red circle icon indicates that a management server or database error has occurred.

About the agent pane

The agent pane lists the agents in a selected policy or configuration group. The agent pane is located on the right side of the Assets page. The bottom half of the agent pane lists details about a selected agent.

The agent pane comprises the following columns of information about each agent:

Agent Health The first column in the agent pane. It indicates whether an agent is in contact with the management server.
Determining how an agent is configured

You can obtain an overview of how an agent is configured by viewing agent properties. You can view agent properties to determine which policies and configurations are applied to an agent, and in which groups an agent resides. You can view agent properties to track agent event file activities. You can view agent properties to list the agent that most recently collected a virtual event for a virtual agent.

You can view agent properties to track the health of an agent. Agent health is denoted by a green/yellow/red circle icon. A green icon indicates that an agent is online. A yellow icon indicates that an agent is possibly offline. A red icon indicates that an agent is offline. Separate yellow/red default values are provided for native and virtual agents.

To obtain an overview of agents that support prevention or detection features, view agent properties in the Prevention view or Detection view. To obtain an overview of your entire agent deployment, view agent properties in the Master view, as illustrated in the following instructions.

To determine how an agent is configured

1. In the management console, click **Assets**.
2. On the **Assets** page, select an agent, and then right-click **Properties**.
3. In the agent properties dialog box, click a tab to view the properties for the selected agent.
4 In the agent properties dialog box, on the General tab, click Configure Health to view agent health settings.

5 Click OK.

Determining how a group is configured

You can obtain an overview of how a group is configured by viewing group properties. You can view group properties to determine which policies and configurations are applied to a group.

About agent log files

Symantec Data Center Security: Server Advanced agent log files contain events processed by an agent. Agent log files are stored on a local agent computer. Multiple versions of a log file may exist, as old versions are closed and new versions are opened.

You can view the events in a log file to verify the operation of an agent computer, to troubleshoot connectivity problems in your network, to track failed attempts by users to access information or to log on to computers.

The agent log files are as follows:

- **SISIDSEvents*.csv**
  Contains all events recorded by an agent. If bulk logging is enabled for the agent, this file is uploaded to the management server. The asterisk in the file name represents a version number.
  Bulk logging captures events to compressed log files instead of transmitting all events in real-time to the database for storage.

- **SISIPSRTEvents*.csv**
  Contains real-time events processed by an agent. The is a temporary file that is used to speed processing of real-time events. All of the events in the file (as configured in the agent's log rules) are forwarded to the management server. The file is deleted once processing is complete (that is, the file is rolled over). The asterisk in the file name represents a version number.

To learn more about agent log files:

Viewing log rules that are applied to an agent

Agents use log rules to determine which events to send to the management server.

Agents that support prevention features use prevention log rules. Upon initial installation, the default prevention log rules are applied to agents when they register with the management server.
Agents that support detection features use detection log rules. Upon initial installation, the default detection log rules are applied to agents when they register with the management server.

**To view log rules that are applied to an agent**

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. In the left-hand pane, under **Asset Configs**, select a configuration group.
4. On the **Assets** page, in the agent pane, select an agent, and then right-click **View Config**.
5. In the configuration dialog box, click the **Log Rules** tab to view the log rules that are applied to the selected agent.
6. Click **OK**.

**Viewing detection parameters applied to an agent**

Detection parameters control how the detection features of an agent operate. Agents that support detection features use detection parameters. Upon initial installation, the default detection parameters are applied to agents when they register with the management server.

Detection parameters comprise the following:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Collector</strong></td>
<td>The file collector determines how agents monitor files. Intruders often attempt to replace critical system files with Trojan horse versions, or alter system files to create a back door for future intrusions. The file collector detects changes to these system critical files. The file collector is valid for agents that are installed on supported Windows and UNIX operating systems. By default, the file collector is enabled.</td>
</tr>
<tr>
<td><strong>Event Log Collector</strong></td>
<td>The event log collector looks for matches in the Windows event log. By default, the event log collector is enabled.</td>
</tr>
<tr>
<td><strong>Audit Collector</strong></td>
<td>The audit collector monitors events from Windows standard system audit logs. The system audit log sources in Windows are Security, Application, and System. By default, the audit collector is enabled.</td>
</tr>
<tr>
<td><strong>Registry Collector</strong></td>
<td>The registry collector watches for changes made to registry keys on the Windows operating system. By default, the registry collector is enabled.</td>
</tr>
</tbody>
</table>
Syslog Collector  The syslog collector watches for syslog daemon tampering on UNIX-based operating systems. By default, the syslog collector is enabled.

WTMP Collector  The WTMP collector monitors the WTMP logging system on UNIX-based operating systems. By default, the WTMP collector is enabled.

BTMP Collector  The BTMP collector monitors the BTMP logging system on UNIX-based operating systems. By default, the BTMP collector is enabled.

C2 Collector  The C2 collector monitors the C2 audit logging system on Solaris, Linux, HP-UX, and AIX operating systems. By default, the C2 collector is disabled.

To view detection parameters applied to an agent

1. In the management console, click Assets.
2. Under the Assets tab, click Detection.
3. In the left-hand pane, under Asset Configs, select a configuration group.
4. On the Assets page, in the agent pane, select an agent, and then right-click View Config.
5. In the configuration dialog box, click the Parameters tab to view the detection parameters that are applied to the selected agent.
6. Click OK.

Viewing communication parameters applied to an agent

Communication parameters control how agents communicate with the management server.

Upon initial installation, the default communication parameters are applied to agents when they register with the management server.

Communication parameters comprise the following:

Polling Interval  The polling interval is the frequency at which an agent polls the management server for configuration changes. Upon initial agent installation, polling interval is set to 300 seconds.

Polling interval is the most reliable method for agents to obtain configuration changes.
In addition to using the polling interval, agents can use real-time notification to obtain configuration changes. With real-time notification, the management server sends a real-time notification message to an agent as configuration changes occur. Upon receiving the notification, the agent queries the management server for the changes. The agent uses a user-specified port to communicate with the management server.

Upon initial agent installation, real-time notification is enabled.

**Enable real-time notification**

The port that is used by the agent to communicate with the management server, for use with real-time notification.

Upon initial agent installation, port is set to 2222.

**Port**

The connection timeout is the TCP/IP connection timeout for connections initiated by an agent to the management server.

Upon initial agent installation, connection timeout is set to 30 seconds.

**Connection Timeout**

To view communication parameters applied to an agent

1. In the management console, click **Assets**.
2. Under the Assets tab, click **Prevention** or **Detection**.
3. In the left-hand pane, under **Common Configs**, select a common configuration group.
4. On the Assets page, in the agent pane, select an agent, and then right-click **View Config**.
5. In the **Default Common Parameters** dialog box, click the **Communication** tab to view the communication parameters that are applied to the selected agent.
6. Click **OK**.

Viewing event logging parameters applied to an agent

Event logging parameters control how agents log events.

Upon initial installation, the default event logging parameters are applied to agents when they register with the management server.

Event logging parameters comprise the following:
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable log consolidation</td>
<td>Log consolidation controls when an agent consolidates similar log events into a summary event that is sent to the management server. Similar log events that occur consecutively, within a user-specified summary delay period, are consolidated into a summary event. The summary event includes a count of the number of similar log event occurrences. Log consolidation only occurs for prevention events. Upon initial agent installation, log consolidation is enabled. The delay is set to one minute.</td>
</tr>
<tr>
<td>Enable log rotation</td>
<td>Log rotation determines how and when agents rotate event log files. When an agent rotates an event log file, the current log file is closed and nothing more is written to it. A new log file is opened with the same base file name. Once a log file is rotated, the old file might still be in use by the agent. Although no new records are written to the log file, the agent might still have to process events and send them to the management server. Agent log files are compressed into .zip files when processing is finished. The .zip files are stored in the archive subdirectory if the agent is not configured to delete them after processing. The frequency at which agents rotate log files is based on one of the following parameters: - File size: Agents can rotate log files based on log file size. When a log file reaches a user-specified size, a new log file is started. - Time interval: Agents can rotate log files based on a user-specified time interval (monthly, weekly, daily, hourly). Upon initial agent installation, log rotation is enabled. Log files are rotated based on file size, which is set to 10 MB.</td>
</tr>
<tr>
<td>Enable bulk log transfer</td>
<td>Bulk log transfer lets you collect events of long-term interest without burdening the network or flooding the Symantec Data Center Security: Server Advanced database. If bulk log transfer is enabled, the agent log file is transmitted to the management server, where it is stored. When you are ready to load the events into the database, you run the Bulk Loader Utility. This utility interprets a compressed bulk log file and populates the database with the events from the file. Upon initial agent installation, bulk log transfer is disabled.</td>
</tr>
</tbody>
</table>
Delete log files after processing

Delete log files after processing deletes an event log file after Symantec Data Center Security: Server Advanced reads the events in the file.

Upon initial agent installation, the option to delete log files after processing is disabled.

Stop/restart logging at disk usage

An agent monitors the used disk space on the disk that contains the agent log files, to avoid filling the disk completely. The agent checks the percentage of used disk space at each polling interval. If the percentage of used disk space exceeds the configured stop logging threshold, the agent stops logging events to the log file. Logging remains off until the percentage of used disk space drops below the configured start logging threshold. At this point, the agent restarts logging events to the log file. When stopping or restarting logging, the agent generates a log message, which appears on the Monitors page.

Upon initial agent installation, stop logging at disk usage is set to 95 percent, restart logging at disk usage is set to 85 percent.

Reader/writer limit

The reader limit and the writer limit control how an agent processes events that are sent to the Monitors page.

The reader limit is the maximum number of events processed before an agent pauses. By pausing after a specified number of events, the agent avoids consuming too many system resources. Increasing the reader limit lets the agent consume more resources, but gets events to the Monitors page more quickly. Decreasing the reader limit reduces the resources that the agent consumes, but gets events to the Monitors page more slowly.

The writer limit is the maximum number of events that an agent can send in a single TCP/IP connection. Creating a TCP/IP connection is overhead, and sending multiple events in a single connection reduces the average overhead per event.

Upon initial agent installation, reader limit is set to 1000 events, writer limit is set to 10 events.

---

To view event logging parameters applied to an agent

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. In the left-hand pane, under **Common Configs**, select a common configuration group.
4. On the Assets page, in the agent pane, select an agent, and then right-click **View Config**.
5 In the Default Common Parameters dialog box, click the Logging tab to view the event logging parameters that are applied to the selected agent.

6 Click OK.

Applying the Symantec policies to agents or groups

Symantec Data Center Security: Server Advanced includes a library of prevention and detection policies that were developed by Symantec security experts. You can begin enforcing the Symantec Data Center Security: Server Advanced policies on your agents immediately after agent installation and registration with the management server.

Table 1-6 outlines the steps to enforcing the Symantec Data Center Security: Server Advanced policies.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Adjust the policies to meet your environment needs</td>
<td>You can apply the policies out of the box to your agents and policy groups. You can adjust the policies to meet specific environment needs. Use the management console to adjust the policies.</td>
</tr>
<tr>
<td>3</td>
<td>Test a policy on a few agents</td>
<td>Set up a test environment and apply a policy to a few agents. Test the policy, verifying that the agent computers function properly with the applied policy. To verify that an agent computer functions properly with an applied policy, view the events that the agent sent to the management server. See “Viewing event activity” on page 54.</td>
</tr>
</tbody>
</table>
Table 1-6 Enforcing the Symantec Data Center Security: Server Advanced policies (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Apply the policies to your agents</td>
<td>If the agent computers perform as designed in a test environment, then you are ready to apply the policy on a broader scale. You might want to implement a pilot in the production environment, so that you can fine-tune the restrictions enforced by the policies.</td>
</tr>
</tbody>
</table>

Applying a Symantec prevention policy to an agent or group

Symantec Data Center Security: Server Advanced prevention policies protect against inappropriate modification of system resources. You can use the prevention policies with supported Windows, Solaris, AIX, and Linux operating systems.


Before you apply a prevention policy to an agent, please note the following:

- You can select the global disable prevention policy option to temporarily disable the policy. The disable prevention policy option is useful if you want to test a prevention policy. The disable prevention policy option logs policy violations, but does not enforce them. This lets you gather information about how a computer performs, without running the risk of preventing critical aspects of your computer operation.
  
  See “Disabling prevention on an agent computer” on page 52.

- Upon agent installation, the Null prevention policy is applied to every agent that registers with the management server. The Null prevention policy offers no protection for an agent computer.

- The Null prevention policy and the disable prevention policy option both offer no protection for an agent computer. The Null prevention policy does not log policy violations. The disable prevention policy option logs policy violations.

To apply a Symantec prevention policy to an agent or group

1. In the management console, click Assets.
2. Under the Assets tab, click Prevention.
3. On the Assets page, select an agent or policy group, and then right-click Apply Policy.
4  In the **Set Policy Wizard** dialog box, double-click the Symantec folder to list the Symantec policies.

If you are applying a policy directly to an agent, the operating system is selected for you. If you are applying a policy to a policy group, you must select the operating system.

5  In the **Set Policy Wizard** dialog box, select a Symantec policy, and then click **Next**.

6  If you do not want to enforce the Symantec prevention policy at this time, in the **Set Policy Wizard** dialog box, select the **Disable Prevention** check box, and then click **Next**.

7  If prompted, select the merge option, and then click **Next**.

8  In the Set Policy Wizard dialog, review the policy summary, and then click **Finish** to apply the Symantec prevention policy to the agent or policy group that you selected.

9  In the management console, click **Refresh** to update the view.

10 Verify that the agent computer functions properly with the applied policy.

**Disabling prevention on an agent computer**

There may be occasions when you want to disable prevention on an agent computer. For example, you may need to install or uninstall software on the agent computer, or use the agent computer to access blocked resources such as files and networks.

You can disable prevention on an agent computer as follows:

- **Apply the Null prevention policy to the agent**
  The Null prevention policy provides no protection for an agent computer. It does not log policy violations.

- **Enable the global disable prevention policy option in a prevention policy that is applied to the agent**
  The global disable prevention policy option in the Symantec Data Center Security: Server Advanced prevention policies temporarily disables policy prevention for an agent computer. The policy violations are logged by the agent, but are not enforced.

- **Override an agent's prevention policy using the policy override tool**
  The policy override tool overrides prevention policy enforcement on agent computers that run supported Windows and UNIX operating systems. The prevention policy that is applied to an agent computer must be configured for policy override.

  See "Overriding prevention policy enforcement" on page 56.
Applying a Symantec detection policy to an agent or group

Symantec Data Center Security: Server Advanced detection policies monitor events and syslogs, and report abnormal behavior. You can use the detection policies with supported Windows and UNIX operating systems.

Symantec Data Center Security: Server Advanced detection policies include the following features:

■ Sophisticated policy-based auditing and monitoring
■ Log consolidation for easy search, archival, and retrieval
■ Advanced event analysis and response capabilities
■ File and registry protection and monitoring


By default, no detection policies are applied to agents when they register with the management server.

To apply a detection policy to an agent or group

1 In the management console, click Assets.
2 Under the Assets tab, click Detection.
3 On the Assets page, select an agent or policy group, and then right-click Apply Policy.
4 In the Set Policy Wizard dialog box, double-click the Symantec folder to list the Symantec policies.

If you are applying a policy directly to an agent, the target operating system is selected for you. If you are applying a policy to a policy group, you must select the target operating system.

5 In the Set Policy Wizard dialog box, select one or more Symantec policies, and then click Next.

To select multiple detection policies, hold down the Shift or Ctrl key while selecting the policies.

6 If prompted, select the merge option, and then click Next.

7 In the Set Policy Wizard dialog, review the policy summary, and then click Finish to apply the Symantec detection policies to the agent or group that you selected.

8 In the management console, click Refresh to update the view.

9 Verify that the agent computer functions properly with the applied policies.
Applying detection policies to the default OS-specific groups

The following OS-specific detection policy groups are set up during Symantec Data Center Security: Server Advanced installation:

- AIX
- HP-UX
- Linux
- Solaris
- Windows

By default, these OS-specific policy groups do not have any detection policies applied to them. If you apply detection policies to these groups, the policies are automatically applied to agents when they register with the management server.

Viewing event activity

You can verify the operation of an agent computer by viewing the events that were reported by the agent. Events are informative, notable, and critical activities that concern the Symantec Data Center Security: Server Advanced agent and management server. The agent logs events to the management server, and the management console lets you view summaries and details of those events. Agent log rules determine which events the agent sends to the management server.

The key methods that you can use and the locations where you can view event activity are as follows:

- Home page
- Monitors page
- Agent event viewer
- Agent event file health
- Object-specific events
- Event Wizard, Event Agent, Event Details, Event Policy commands

Viewing events generated in your network

You can use the Home page in the management console to obtain an overview of events that are generated in your network.

The Home page includes the following information:
### Agent Prevention Summary
Displays statistics about the agents that generated recent prevention events.

### Network Actions
Displays statistics about the network activity of the most recent events.

### Agent Statistics
Displays statistics about agents that support the prevention features and detection features of Symantec Data Center Security: Server Advanced.

### Agent Detection Summary
Displays statistics about the agents that generated recent detection events.

### Event Rule Summary
Displays statistics about recent rules.

---

## Viewing events reported by the management server

You use the Monitors page in the management console to display events reported to the management server from your entire agent deployment. The Monitors page features filtered event summaries, ad-hoc event searches, and event-specific details. Real-time monitors show events as they are sent in real time to the management server.

## Viewing agent, event, and Internet statistics

You can view current agent, event, and Internet statistics that indicate the health and status of your network. You can identify problem computers and threats to your network’s security by analyzing this information.

The Home page provides the following statistical information about your network:

<table>
<thead>
<tr>
<th>Summary Pane</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Event Summary pane</strong></td>
<td>Displays statistics about the agents that generated recent events. The statistics include the agent computer name, event categories, and the number of events per category. The Agent Event Summary pane is sorted by the descending total number of events for each agent, which causes the agents that generate the most events to be at the top of the list. The length of the bar chart for each agent shows the proportion of the recent events that belong to that agent.</td>
</tr>
<tr>
<td><strong>Event Type Distribution pane</strong></td>
<td>Displays statistics about the most recent events. The statistics include event type, disposition (deny, allow, error, failure, success), and the number of events per disposition. The Event Type Distribution pane is sorted by the descending total number of events for each event type, which causes the event types with the most events to be at the top of the list. The length of the bar chart for each event type shows the proportion of the recent events that belong to that type.</td>
</tr>
</tbody>
</table>
Agent Statistics pane Displays statistics about the number of agents that are registered to the management server.

Threat Level pane Displays the Symantec ThreatCon rating, and the date and time that the Threat Level was last updated. This rating provides an overall view of global Internet security. You can view important information about current threats and security risks, definition updates that are currently available, and network security tips that prevent intrusions.

You can also obtain statistics for agents that support prevention features and for agents that support detection features.

To view agent, event, and Internet statistics

◆ In the management console, click **Summary**.

### About the Symantec queries and reports

Symantec Data Center Security: Server Advanced includes predefined queries and reports that provide an overall view of your deployed environment, as well as prevention, detection, and management activity. The graphical reporting capabilities include tables, pie charts, and graphs (line, bar, and area).

The Symantec queries can help you identify groups with policies that provide no protection or only partial protection. The queries can help you identify agents that are disconnected from the network for a period of time or that are experiencing network connectivity issues.

### About updating Symantec policy and report packs

If you have a valid serial number for Symantec Data Center Security: Server Advanced, you can use the Symantec FileConnect Web site to download policy and report packs. If you have a valid contract ID for Symantec Platinum Support, you can use the Platinum Support Web site to download policy and report packs.

### Overriding prevention policy enforcement

As the Symantec Data Center Security: Server Advanced administrator, you can allow all users or specific users and user groups to override a prevention policy on an agent computer.

To allow a user to override a prevention policy, you configure the global policy override option.

To override a prevention policy, users use the policy override tool.

### About user accounts

User accounts provide secure access to the Symantec Data Center Security: Server Advanced management console.

When you create a user account, you must assign one or more roles to the account. The roles that you assign determine what functions the user can perform in the management console. You can assign predefined roles or custom roles.

Symantec Data Center Security: Server Advanced includes five predefined roles: Administrators, Authors, Guests, Managers, and Query Tool Users. The default account (symadmin) that was created during Symantec Data Center Security: Server Advanced installation is assigned the Administrators role.

### Increasing the amount of memory used for the console

The default heap space for the Symantec Data Center Security: Server Advanced console is 512 MB. At times, it is possible that the console may need even more memory to function properly. If so, you can use the following procedure to increase the heap space.

**To temporarily increase the amount of memory used for the console**

1. Open a window with a command prompt on the computer that runs the console.
2. Change directory to the following:
   - On a 32-bit machine: `drive:\Program Files\Symantec\Symantec\Data Center Security Server\Console`
   - On a 64-bit machine: `drive:\Program Files(x64)\Symantec\Symantec\Data Center Security Server\Console`
3. Type the following command:
   `console.exe -J-Xmx1024m`
To permanently increase the amount of memory used for the console

1. Right-click the management console desktop shortcut icon, and then click **Properties**.
2. On the **Shortcut** tab, add the following to the end of the **TARGET** property:

   -J-Xmx1024m

### About the management console commands

The following table lists the popular management console commands. Many of the commands are available from a menu and by right-clicking a selected agent, policy, or configuration. Some commands are available as tool bar icons.

**Table 1-7** Symantec Data Center Security: Server Advanced commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Console page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh</td>
<td>All</td>
<td>Apply pending agent updates.</td>
</tr>
<tr>
<td>Preferences</td>
<td>All</td>
<td>Set general and Monitors page preferences.</td>
</tr>
<tr>
<td>Help &gt; Contents and Index</td>
<td>All</td>
<td>Display Symantec Data Center Security: Server Advanced Help.</td>
</tr>
<tr>
<td>Help &gt; Online Support</td>
<td>All</td>
<td>Go to the Symantec web site support page.</td>
</tr>
<tr>
<td>Edit Policy</td>
<td>Assets</td>
<td>Edit a policy applied to an agent or group.</td>
</tr>
<tr>
<td>Apply Policy</td>
<td>Assets</td>
<td>Apply a policy to an agent or group.</td>
</tr>
<tr>
<td>Save Applied Policy</td>
<td>Assets</td>
<td>Save an applied policy as a workspace policy.</td>
</tr>
<tr>
<td>Clear Policy</td>
<td>Assets</td>
<td>Clear a policy applied to an agent or group.</td>
</tr>
<tr>
<td>Move To</td>
<td>Assets</td>
<td>Move an agent to a group.</td>
</tr>
<tr>
<td>Move Back</td>
<td>Assets</td>
<td>Move an agent back to its previous group.</td>
</tr>
<tr>
<td>Rename</td>
<td>Assets</td>
<td>Modify the name of an agent.</td>
</tr>
<tr>
<td>View Config</td>
<td>Assets</td>
<td>View a configuration applied to an agent or group.</td>
</tr>
<tr>
<td>Apply Config</td>
<td>Assets</td>
<td>Apply a configuration to an agent or group.</td>
</tr>
<tr>
<td>Clear Config</td>
<td>Assets</td>
<td>Clear a configuration applied to an agent or group.</td>
</tr>
<tr>
<td>New Virtual Agent</td>
<td>Assets</td>
<td>Manually register a virtual agent.</td>
</tr>
</tbody>
</table>
### Table 1-7 Symantec Data Center Security: Server Advanced commands (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Console page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties</td>
<td>Assets</td>
<td>View properties for an agent or group.</td>
</tr>
<tr>
<td>Delete</td>
<td>Assets</td>
<td>Delete an agent in the Master view.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Delete an agent from a detection policy group.</td>
</tr>
<tr>
<td>Edit Policy</td>
<td>Policies</td>
<td>Edit a workspace policy.</td>
</tr>
<tr>
<td>New Policy</td>
<td>Policies</td>
<td>Create a workspace policy.</td>
</tr>
<tr>
<td>New Folder</td>
<td>Policies</td>
<td>Create a policy folder.</td>
</tr>
<tr>
<td>Copy Policy</td>
<td>Policies</td>
<td>Make a copy of a workspace policy.</td>
</tr>
<tr>
<td>Update Policy</td>
<td>Policies</td>
<td>Update a workspace policy with Symantec policy packs.</td>
</tr>
<tr>
<td>Copy Options</td>
<td>Policies</td>
<td>Copy all policy options from one workspace policy to another workspace policy.</td>
</tr>
<tr>
<td>Copy Custom Controls</td>
<td>Policies</td>
<td>Copies the options to control a custom sandbox from one workspace policy to another workspace policy.</td>
</tr>
<tr>
<td>Apply Policy</td>
<td>Policies</td>
<td>Apply a workspace policy to an agent or group.</td>
</tr>
<tr>
<td>Reapply Policy</td>
<td>Policies</td>
<td>Reapply a (modified) workspace policy to an agent or group.</td>
</tr>
<tr>
<td>Move To</td>
<td>Policies</td>
<td>Move a workspace policy to a folder.</td>
</tr>
<tr>
<td>Import Policy</td>
<td>Policies</td>
<td>Import a workspace policy from a file.</td>
</tr>
<tr>
<td>Export Policy</td>
<td>Policies</td>
<td>Export a workspace policy to a file.</td>
</tr>
<tr>
<td>Rename Policy</td>
<td>Policies</td>
<td>Rename a workspace policy.</td>
</tr>
<tr>
<td>Delete Policy</td>
<td>Policies</td>
<td>Delete a workspace policy.</td>
</tr>
<tr>
<td>Create Default</td>
<td>Policies</td>
<td>Create default workspace policies for all policies in an installed Symantec Data Center Security: Server Advanced policy pack.</td>
</tr>
<tr>
<td>Properties</td>
<td>Policies</td>
<td>List the agents and groups to which a workspace policy is applied.</td>
</tr>
</tbody>
</table>
### Table 1-7  Symantec Data Center Security: Server Advanced commands (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Console page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Config</td>
<td>Configs</td>
<td>Create a workspace configuration.</td>
</tr>
<tr>
<td>New Folder</td>
<td>Configs</td>
<td>Create a configuration folder.</td>
</tr>
<tr>
<td>Copy Config</td>
<td>Configs</td>
<td>Make a copy of a workspace configuration.</td>
</tr>
<tr>
<td>Apply Config</td>
<td>Configs</td>
<td>Apply a workspace configuration to an agent or group.</td>
</tr>
<tr>
<td>Reapply Config</td>
<td>Configs</td>
<td>Reapply a (modified) workspace configuration to an agent or group.</td>
</tr>
<tr>
<td>Move To</td>
<td>Configs</td>
<td>Move a workspace configuration to a folder.</td>
</tr>
<tr>
<td>Import Config</td>
<td>Configs</td>
<td>Import a workspace configuration from a file.</td>
</tr>
<tr>
<td>Export Config</td>
<td>Configs</td>
<td>Export a workspace configuration to a file.</td>
</tr>
<tr>
<td>Rename Config</td>
<td>Configs</td>
<td>Rename a workspace configuration.</td>
</tr>
<tr>
<td>Delete Config</td>
<td>Configs</td>
<td>Delete a workspace configuration.</td>
</tr>
<tr>
<td>Properties</td>
<td>Configs</td>
<td>List the agents and groups to which a workspace configuration is applied.</td>
</tr>
<tr>
<td>Event Details</td>
<td>Monitors</td>
<td>View details for a selected event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can invoke Event Details from Recent Events tabs and History tabs.</td>
</tr>
<tr>
<td>Event Agent</td>
<td>Monitors</td>
<td>View the properties of the agent that reported a selected event.</td>
</tr>
<tr>
<td>Event Policy</td>
<td>Monitors</td>
<td>Display the policy that caused a selected event.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can invoke Event Policy from Recent Events tabs.</td>
</tr>
<tr>
<td>Event Wizard</td>
<td>Monitors</td>
<td>Resolve events shown on the Monitors page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can invoke Event Wizard from Recent Events tabs.</td>
</tr>
<tr>
<td>New Monitor (button)</td>
<td>Monitors</td>
<td>Create a new real-time monitor.</td>
</tr>
<tr>
<td>Command</td>
<td>Console page</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>New Folder</td>
<td>Reports</td>
<td>Create a query or report folder.</td>
</tr>
<tr>
<td>Rename Folder</td>
<td>Reports</td>
<td>Rename a query or report folder.</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>Reports</td>
<td>Delete a query or report folder.</td>
</tr>
<tr>
<td>New Query</td>
<td>Reports</td>
<td>Create a query or report.</td>
</tr>
<tr>
<td>New Report</td>
<td>Reports</td>
<td>Create a query or report.</td>
</tr>
<tr>
<td>Edit Query</td>
<td>Reports</td>
<td>Edit a query or report.</td>
</tr>
<tr>
<td>Edit Report</td>
<td>Reports</td>
<td>Edit a query or report.</td>
</tr>
<tr>
<td>Run Query</td>
<td>Reports</td>
<td>Run a query or report.</td>
</tr>
<tr>
<td>Run Report</td>
<td>Reports</td>
<td>Run a query or report.</td>
</tr>
<tr>
<td>Copy Query</td>
<td>Reports</td>
<td>Make a copy of a query or report.</td>
</tr>
<tr>
<td>Copy Report</td>
<td>Reports</td>
<td>Make a copy of a query or report.</td>
</tr>
<tr>
<td>Move To</td>
<td>Reports</td>
<td>Move a query or report to a folder.</td>
</tr>
<tr>
<td>Publish Query</td>
<td>Reports</td>
<td>Save a snapshot of the graphic or tabular results from running a query or report.</td>
</tr>
<tr>
<td>Publish Report</td>
<td>Reports</td>
<td>Save a snapshot of the graphic or tabular results from running a query or report.</td>
</tr>
<tr>
<td>Export Published Results</td>
<td>Reports</td>
<td>Export a published query or report to .zip file.</td>
</tr>
<tr>
<td>Import Published Results</td>
<td>Reports</td>
<td>Import a published query or report from .zip file.</td>
</tr>
<tr>
<td>Export Query</td>
<td>Reports</td>
<td>Export a query or report to .zip file.</td>
</tr>
<tr>
<td>Export Report</td>
<td>Reports</td>
<td>Export a query or report to .zip file.</td>
</tr>
<tr>
<td>Import Query</td>
<td>Reports</td>
<td>Import a query or report from .zip file.</td>
</tr>
<tr>
<td>Import Report</td>
<td>Reports</td>
<td>Import a query or report from .zip file.</td>
</tr>
<tr>
<td>Delete Query</td>
<td>Reports</td>
<td>Delete a query or report.</td>
</tr>
<tr>
<td>Delete Report</td>
<td>Reports</td>
<td>Delete a query or report.</td>
</tr>
<tr>
<td>Rename Query</td>
<td>Reports</td>
<td>Rename a query or report.</td>
</tr>
<tr>
<td>Rename Report</td>
<td>Reports</td>
<td>Rename a query or report.</td>
</tr>
</tbody>
</table>
Diagnosing problems with Symantec Data Center Security: Server Advanced

Symantec provides batch scripts that you can run to collect agent and management server information. Symantec uses this information to diagnose problems with Symantec Data Center Security: Server Advanced.

Do the following if you experience problems with Symantec Data Center Security: Server Advanced:

1. Run the scripts to collect agent and management server information.
2. Save the output files produced by the batch scripts.
3. Contact Symantec Support for further instruction.

To find out how to contact Symantec, visit the Symantec Support Web site:

http://www.symantec.com/techsupp/enterprise/

See “About collecting information on agent computers” on page 62.
See “Collecting information on the management server” on page 66.

About collecting information on agent computers

The DCS:SA Windows agent installs csptags.exe, which is a diagnostic utility. You can find this utility at the following location:

%SDDCSSAGENTROOT%\IPS\tools

The tool displays data on the memory allocations by the DCS:SA driver components from the system paged and nonpaged kernel pools. To run this tool, execute csptags.exe from the command line.

The Agent Collect Info script collects output from the csptags.exe tool. This tool requires the Pool Tag mode to be enabled on the system. Pool Tag Mode is permanently enabled on Windows Server 2003 and later versions. If you run this tool on a system with a disabled pool tag mode, you receive a message to enable the Tag mode.

Note: For more information on how to use memory pool monitor, see http://support.microsoft.com/kb/177415

Tag Mode can be enabled in the following ways:

- By updating the registry
- By executing the Gflags.exe utility
You can also use the Global Flags Editor (Gflags.exe) utility to enable pool tagging. Gflags.exe is available in the \Support\Tools folder of Windows 2000/XP/Server 2003 CD-ROMs.

As pool tagging is permanently enabled in Windows Server 2003, the **Enable Pool Tagging** check box in the **Global Flags** dialog box is dimmed and commands to enable or disable pool tagging fail.

---

**Note:** You can back up the registry before you modify it so that you can restore the registry if an issue occurs.

---

**To change the registry value that enables tag mode for csptags.exe**

1. Open the registry editor by typing `regedit.exe` command from the command line.
2. Locate the following key in the registry:
   
   ```
   HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Session Manager
   ```
3. Note the value of **GlobalFlag**, or save the **Session Manager** key.
4. Double-click the **GlobalFlag** value in the right pane.
5. Change the value to 0x00000400 hexadecimal.

**Note:** When you add the global flag value 0x00000400, it is displayed as 0x400 after it is added. Ensure that you add all the leading zeros.

6. Restart the computer.

   After you complete using the csptags.exe either from the command line or from the **Agent Collect Info**, modify the **GlobalFlag** value to the value that you note down in step 3.

---

**To make the change by using Gflags.exe**

1. Click **Start > Run**.
2. Type `gflags.exe`, and then click **OK**.
3. Select **Enable Pool Tagging**.
4. Click **Apply**, and then click **OK**.
5. Restart the computer.

   After you complete using the csptags.exe either from the command line or from the **Agent Collect Info**, repeat these steps to disable pool tagging.
Collecting information on agent computers

To collect agent information, you run the agent collect info script. You can run the script from an agent computer or the management console.

Running the collect info script from a Windows agent computer

To collect information on a Windows agent computer, you can run the collect info script directly from the agent computer.

To run the collect info script from a Windows agent computer

1. Log on to a Windows agent computer.
2. Click **Start > All Programs > Symantec Data Center Security Server > Collect Agent Info**.

You see the following messages:

Collecting Install Logs...
Collecting Event Logs...
Collecting System Info...
Collecting Registry Info...
Collecting IPS Service Settings...
Collecting IDS Service Logs and Settings...
Collecting Logs...
Collecting IPS Driver Settings...
Collecting Agent Environment Settings...
Zipping Info...
Cleaning Up...

*** Please send the ZIP file:
*** \%temp folder\%\YYYYMMDD_HHmmSS_SerialNo\_CW\_<Host Name>.zip
*** to Symantec support

Press any key to continue...

Running the collect info script from a UNIX agent computer

To collect information on a Solaris, Linux, AIX, HP-UX agent computer, you can run the agent collect info script directly from the agent computer.
To run the collect info script from a UNIX agent computer

1. Log on to a UNIX agent computer.
2. Navigate to the following directory:
   `/opt/Symantec/sdcssagent/IPS/tools/`
3. At a command prompt, type and run the following command:
   
   ```
   # ./getagentinfo.sh
   ```

   You see the following messages:

   Collecting Install Logs...
   Collecting System Info...
   Collecting syslog Files...
   Collecting syslog.conf Files...
   Collecting System Startup Info...
   Collecting SDCSS Logs...
   Collecting Agent Logs...
   Collecting IPS Configuration Settings...
   Collecting IDS Configuration Settings...
   Collecting Agent Environment Settings...
   Collecting Agent Core Files...
   Zipping Info...
   Cleaning Up...
   *** Please send the Info File:
   *** /tmp/<YYYYMMDD_HHMMSS_SerialNo>_CU_<Host name>.gz
   *** to Symantec

Running the collect info script from the management console

To collect information about a Windows or UNIX agent computer to which you do not have login access, you use the DCS:SA_Agent_Diagnostics detection policy. A version of the policy is available for Windows and UNIX agents.


To run the collect info script from the management console

1. Log on to the management console as an administrator.
2. In the management console, under Policies tab, click Detection.
3. On the Policies page, in the Workspace pane, edit the DCS:SA_Agent_Diagnostics policy.
4 In the **DCS:SA_Agent_Diagnostics** dialog box, under **Policy Settings**, click **Diagnostic functions**.

5 In the **DCS:SA_Agent_Diagnostics** dialog box, check **Select a function to run on the agent**, and then click **Edit**.

6 In the **Value** box, select **Run the collect info script**.

7 Click **OK** to save the policy changes.

8 Apply the policy to the agent.

9 Log on to the management server to get the collect info output file. Get the collect info output file from the server directory at the following location:

   On 32-bit machines:
   
   C:\Program Files\Symantec\Data Center Security Server\Server\logfiles\<hostname>\<date>\n
   On 64-bit machines:

   C:\Program Files (x86)\Symantec\Data Center Security Server\Server\logfiles\<hostname>\<date>\n
**Collecting information on the management sever**

To collect management server information, you run the server collect info batch script C:\Program Files\Symantec\Data Center Security Server\Server\tools\getserverinfo.bat.
To collect information on the management server

1 On the management server computer, navigate to the following directory:
   \Program Files\Symantec\Data Center Security Server\Server\tools
2 Double-click getserverinfo.bat.

You see the following messages:

Collecting Install Logs...
Collecting System Info...
Collecting Registry Info...
Collecting App Server Logs and Settings...
Collecting Database Logs and Settings...
Zipping Info...
Cleaning Up...

*** Please send the ZIP file:
*** D:\Temp\sis_server_MACHINENAME_07201350.zip
*** to Symantec support
Press any key to continue...
Using the Home page

This chapter includes the following topics:

- Viewing the Home page
- Running queries
- Setting the event count in the console preferences
- Using the Home page in the Prevention view
- Using the Home page in the Detection view

Viewing the Home page

The Home page provides current agent, event, and Internet security statistics that indicate the health and status of your network. You can identify problem computers and threats to your network’s security by analyzing this information.

You can do the following activities from the Home page:

- View statistics for your entire network.
- View statistics for agents that support prevention features.
- View statistics for agents that support detection features.
- Access popular management console tasks.

You can view the Home page in all three console views. Each view presents a customized view of agent and event statistics.
To view the Home page

1. In the management console, click **Home**.
2. To display a pop-up tool tip, place your cursor over a hypertext link or a bar chart.

**Running queries**

The Home page contains hyperlinks to Symantec Data Center Security: Server Advanced queries. When you click a link, Symantec Data Center Security: Server Advanced runs the corresponding query.

For example, when you click the **Registered Agents** link in the **Agent Statistics** pane, Symantec Data Center Security: Server Advanced does the following:

- Displays the Reports page in the management console.
- Runs the query that provides statistics on registered agents.
- Displays the query results.

**Setting the event count in the console preferences**

You use console preferences to set the recent event count (the maximum number of events) on which the Home page statistics are based. The default setting is 500 events. Depending on the size of or the number of events that are generated in your network, you might want to increase or decrease this value.

**Using the Home page in the Prevention view**

The Home page in the Prevention view provides current agent and event statistics for agents that support the prevention features of Symantec Data Center Security: Server Advanced.

**About the Agent Prevention Summary pane**

The **Agent Prevention Summary** pane lets you view statistics about the agents that generated recent prevention events. The statistics include the agent computer name, action (deny, allow) and the resource type (network, file, registry, overflow, syscall).

The **Agent Prevention Summary** pane is sorted by the descending total number of prevention events for each agent, which causes the agents that generate the
most events to be at the top of the list. The length of the bar chart for each agent shows the proportion of the recent events that belong to that agent.

For troubleshooting purposes, you can view additional prevention event details. To view all prevention events generated for an agent, click the agent computer name. To view a summary of all generated prevention events, click the Summary link.

About the Network Actions pane

The Network Actions pane lets you view statistics about the network activity of the most recent events. These statistics include the IP addresses that appear in recent events, and a bar chart that indicates how the events were handled (deny in/out, allow in/out).

The Network Actions pane is sorted by the descending total number of events for each IP address, which causes the IP addresses that generate the most events to be at the top of the list. The length of the bar for each IP address reflects the proportion of the recent events that originated or were sent to the remote address. For troubleshooting purposes, you can view additional agent details. To view all actions for a remote address, click the remote address link. To view a summary of all actions, click the Summary link.

About the Agent Statistics pane

The Agent Statistics pane lets you view statistics about agents that support the prevention features of Symantec Data Center Security: Server Advanced.

You can view the following statistics:

- **Registered agents**: Displays statistics for agents in the Prevention view.
- **Windows agents**: Displays statistics for Windows agents.
- **Solaris agents**: Displays statistics for Solaris agents.
- **Linux agents**: Displays statistics for Linux agents.
- **Offline agents**: Displays statistics for agents that are offline.
- **Unprotected agents**: Displays statistics for agents with no protection.
- **Agents with null policy**: Displays statistics for agents with the null prevention policy.
- **Agents with errors**: Displays statistics for agents with errors.
### Agents with policy updates
Displays statistics for agents with pending policy updates.

### Agents with configuration updates
Displays statistics for agents with pending configuration updates.

## About the Quick Links pane

The **Quick Links** pane provides the following links:

- **Manage Assets**
  - Display the Assets page.

- **New Prevention Policy**
  - Display the Policies page, and then display the dialog to create a new prevention policy.

- **New Common Config**
  - Display the Configs page, and then display the dialog to create a new common configuration.

- **New Prevention Config**
  - Display the Configs page, and then display the dialog to create a new prevention configuration.

- **View Events**
  - Display the Monitors page.

- **Run Reports**
  - Display the Reports page.

## Using the Home page in the Detection view

The Home page in the Prevention view provides current agent and event statistics for agents that support the detection features of Symantec Data Center Security: Server Advanced.

## About the Agent Detection Summary pane

The **Agent Detection Summary** pane lets you view statistics about the agents that generated recent detection events. The statistics include the agent computer name, event type, and the number of events per type.

The **Agent Prevention Summary** pane is sorted by the descending total number of detection events for each agent, which causes the agents that generate the most events to be at the top of the list. The length of the bar chart for each agent shows the proportion of the recent events that belong to that agent.
For troubleshooting purposes, you can view additional event details. To view all detection events generated for an agent, click the agent computer name. To view a summary of all generated detection events, click the Summary link.

About the Event Rule Summary pane

The Event Rule Summary pane lets you view statistics about recent rules. The statistics include the rule name, event severity, and the number of events per severity.

The Event Rule Summary pane is sorted by the descending total number of rules, which causes the rules with the highest counts to be at the top of the list. The length of the bar for each rule reflects the proportion of the recent events that belong to that rule.

For troubleshooting purposes, you can view additional rule details. To view counts for a rule, click the rule link. To view a summary of all rules, click the Summary link.

About the Agent Statistics pane

The Agent Statistics pane lets you view statistics about agents that support the detection features of Symantec Data Center Security: Server Advanced.

You can view the following statistics:

- Registered agents: Displays statistics for agents in the Detection view.
- Solaris agents: Displays statistics for Solaris agents.
- Linux agents: Displays statistics for Linux agents.
- AIX agents: Displays statistics for AIX agents.
- Offline agents: Displays statistics for agents that are offline.
- Agents with no policy: Displays statistics for agents with no detection policy.
- Agents with errors: Displays statistics for agents with errors.
- Agents with policy updates: Displays statistics for agents with pending policy updates.
Agents with configuration updates

About the Quick Links pane

The Quick Links pane provides the following links:

- **Manage Assets**: Display the Assets page.
- **New Detection Policy**: Display the Policies page, and then display the dialog to create a new detection policy.
- **New Common Config**: Display the Configs page, and then display the dialog to create a new common configuration.
- **New Detection Config**: Display the Configs page, and then display the dialog to create a new detection configuration.
- **View Events**: Display the Monitors page.
- **Run Reports**: Display the Reports page.
Managing assets

This chapter includes the following topics:

- About assets
- Viewing the Assets page
- About asset search
- About console views, agents, and groups
- Viewing agents registered with the management server
- Viewing and configuring agent and group properties
- Creating a policy domain
- Creating an agent group
- About virtual agents
- Modifying an agent name
- Applying a policy to an agent or policy group
- Managing applied policies
- Applying a configuration to an agent or configuration group
- Managing applied configurations
- Viewing the agents that have generated the highest number of events
- Deleting an agent
About assets

Assets are the computers on which agents are installed. Agents are the software that you install on the computers that you want to protect. In most cases, the terms are used synonymously.

Symantec Data Center Security: Server Advanced agents support prevention and detection features. Agents that support prevention features control behavior by allowing and preventing specific actions that an application or user might take. For example, a DCS:SA prevention policy can specify that an email application may not spawn other processes, including dangerous processes like viruses, worms, and Trojan horses. However, the email application can still read and write to the directories that it needs to access.

Agents that support detection features control behavior by detecting suspicious activity and taking action. For example, a DCS:SA detection policy can take action when it detects an attempt by an unauthorized user to gain illegitimate access to a system. No action would be taken for failed attempts that resulted from normal behavior such as an expired password or a user forgetting a password.

An agent is compatible with a policy if the following is true:

- The agent and the policy have the same operating system.
- The agent's version is greater than or equal to the policy's minimum agent version.
- The agent supports the policy type.

Viewing the Assets page

You use the Assets page in the management console to apply policies and configurations to agents, and to monitor the health of your agents.

You can do the following activities from the Assets page:

- Determine how agents communicate with the management server, and which events agents send to the management server.
- View information about the agents in your network, including which policies are enforced on agents, and how the agents are configured.
- View a list of agents that run on Windows, Solaris, Linux, AIX, and HP-UX operating systems.
- Apply policies and configurations to agents and groups.
- Delete an agent's record from the management server database.
To view the Assets page

1. In the management console, click **Assets**.

2. (Optional) On the Assets page, click the size arrows to expand or collapse the panes.

### About asset search

Symantec Data Center Security: Server Advanced includes a search function that lets you perform a search for the assets. Use the **Search** option on the **Assets** workspace in the management console to search for the assets. The search results contain details about the asset in the **Asset Search** pane such as software version, IP address, group, history, and so on. You can select an asset and perform several actions on it. For example, you can clear the configurations that are applied to an agent, rename an agent, add an agent to a specific group, and so on.

You can also export the search results to a comma-separated value file.

You can use a combination of search filters for quick search of assets. These search filters appear in the **Asset Search** dialog box.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source Machine</strong></td>
<td>Search agents by agent name, host name, or IP address.</td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>Search agents based on their version.</td>
</tr>
<tr>
<td><strong>Domain Name</strong></td>
<td>Search agents based on their domain name.</td>
</tr>
<tr>
<td><strong>OS Type</strong></td>
<td>Search agents based on their operating system type.</td>
</tr>
<tr>
<td><strong>OS Version</strong></td>
<td>Search agents based on their operating system version.</td>
</tr>
<tr>
<td><strong>Health</strong></td>
<td>Search agents based on their health status, such as green, yellow, or red.</td>
</tr>
<tr>
<td><strong>Has Pending Changes?</strong></td>
<td>Search agents that are flagged for pending policy or config changes.</td>
</tr>
<tr>
<td><strong>Has errors?</strong></td>
<td>Search agents that have policy or config errors.</td>
</tr>
</tbody>
</table>

The **Policy Options** section in the **Asset Search** includes the following search criteria:
Has a Prevention Policy directly assigned?  Search agents that have a directly assigned prevention policy.

Has Prevention enabled?  Search agents with prevention enabled.

Has a Detection Policy directly assigned?  Search agents that have a directly assigned detection policy.

The Config Options section in the Asset Search includes the following search criteria:

Has a Common Config directly assigned?  Search agents that have a directly assigned common config.

Has a Prevention Config directly assigned?  Search agents that have a directly assigned prevention config.

Has a Detection Config directly assigned?  Search agents that have a directly assigned detection config.

See “Searching assets by attributes” on page 77.

Searching assets by attributes

You can use the Asset Search window to search assets based on their attributes, such as agent name, IP address, domain name. DCS:SA provides several search filters that you can use to optimize your search result.

<table>
<thead>
<tr>
<th>Table 3-2</th>
<th>Search actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action</strong></td>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>
| Double-click | Open the agent Properties dialog box.  
See “Viewing agent properties” on page 96. |
| Properties | List the attributes of an agent in the Agent Properties dialog box.  
See “Viewing agent properties” on page 96. |
| Rename | Modify the name of an agent.  
See “Modifying an agent name” on page 118. |
| Move To | Move an agent to a group. |
| Move Back | Move an agent back to its previous group. |
Table 3-2  Search actions (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Delete an agent. See “Deleting an agent” on page 125.</td>
</tr>
<tr>
<td>Edit Policy</td>
<td>Edit an existing policy applied to an agent.</td>
</tr>
<tr>
<td></td>
<td>See “Editing a policy applied to an agent or group” on page 121.</td>
</tr>
<tr>
<td>Apply Policy</td>
<td>Apply a policy to an agent.</td>
</tr>
<tr>
<td></td>
<td>See “Applying a policy to an agent or policy group” on page 118.</td>
</tr>
<tr>
<td>Clear Policy</td>
<td>Clear a policy applied to an agent.</td>
</tr>
<tr>
<td></td>
<td>See “Clearing a policy applied to an agent or group” on page 122.</td>
</tr>
<tr>
<td>Save Applied</td>
<td>Save an applied policy as a workspace policy on an agent.</td>
</tr>
<tr>
<td>Policy</td>
<td>See “Saving a policy applied to an agent or group” on page 121.</td>
</tr>
<tr>
<td>View Config</td>
<td>View the configuration applied to an agent.</td>
</tr>
<tr>
<td></td>
<td>See “Viewing agent properties” on page 96.</td>
</tr>
<tr>
<td>Apply Config</td>
<td>Apply a configuration to an agent.</td>
</tr>
<tr>
<td>Clear Config</td>
<td>Clear a configuration applied to an agent.</td>
</tr>
<tr>
<td></td>
<td>See “Clearing a configuration applied to an agent or group” on page 123.</td>
</tr>
<tr>
<td>Add To</td>
<td>Add an agent to a group.</td>
</tr>
<tr>
<td></td>
<td>You can add an agent in a group when you are in the Detection view.</td>
</tr>
</tbody>
</table>

To search assets by attributes

1. In the management console, click Assets.
2. On top-right, in the search text box, type an agent name, a host name, or an IP address.
   You can also use wildcards in the search string.
   When you click the Advanced Search link, all of the search filters in the Asset Search window appear blank.
3. Click the search icon or press Enter.
4. In the Asset search window, specify the search filters.

5. Click Search.

   On the right-hand pane, the search result appears in the Asset Search table. You can select the required agent and perform the following actions in Table 3-2.

   See “About asset search” on page 76.

About console views, agents, and groups

When you register an agent with the management server, you can specify whether an agent supports the DCS:SA prevention features, the detection features, or both. The agent is placed in a default group in each console view that it supports, unless a group was assigned during agent installation.

Each console view lets you create agent groups in different ways. Each view has its own rules about policy and configuration assignment to agents, and lets you perform specific actions.

Using the Network view

You use the Network view to monitor your entire agent deployment. You can do the following activities in the Network view:

- List all agents that are registered with the management server.
- View the overall status of each agent in your network.
- View a list of the policies and configurations that are applied to each agent.
- Organize agents in a hierarchy of groups.
- Register virtual agents that indirectly detect off-platform event data and associate the data with agents in the management console.
- Delete an agent's record from the management server database.

Note: You cannot change agent policy or configuration in the Network view.

Agent groups

In the Network view, you organize agents in a hierarchy of groups. You might use groups to reflect your organization's geographical or divisional structure. Every agent lives in exactly one Network view group. You can create as many groups as you need. You can nest agent groups within each other.
The default Master group is named Network. When an agent registers with the management server, it is automatically placed in the Network group.

**Note:** The Network view group hierarchy does not affect agent configuration.

Using the Prevention view

You use the Prevention view to apply policies and configurations to agents that support the prevention features of Symantec Data Center Security: Server Advanced.

You can do the following activities in the Prevention view:

- List all agents that support prevention features.
- List all virtual agents.
- View the overall status of each agent.
- View policy and agent configuration.
- Organize agents in a hierarchy of groups.
- Apply prevention policies to agents and policy groups.
- Apply prevention configurations to agents and configuration groups.

In the Prevention view, you can create the following types of agent groups:

- Policy groups
- Configuration groups

**Prevention policy groups**

You apply prevention policies to policy groups. Policy groups contain one or more agents that support prevention features. Policy groups are organized in a hierarchy of groups.

You might use prevention policy groups for the following reasons:

- The agents use the same policy. You can apply the policy once to the policy group.
- Your network consists of different operating systems. You can have separate policy groups for your Windows, Linux, and Solaris computers.

In the Prevention view, each agent resides in exactly one policy group. The default policy group is named Policy. When an agent that supports prevention features registers with the management server, it is automatically placed in the default Policy group unless a group was assigned during agent installation.
You can group agents in any logical manner that reflects the structure of your network. You can create as many policy groups as you need. You can nest policy groups within each other. When you need to update your agents, you can apply a single policy to the entire policy group, rather than individually to each agent.

**How prevention policies are applied to agents**

Symantec Data Center Security: Server Advanced applies prevention policies to agents based on the following rules:

- Upon initial DCS:SA agent installation, the Null prevention policy is applied to an agent when it registers with the management server.

- An agent uses exactly one prevention policy. For example, if an agent has a prevention policy applied directly to it, and the agent's policy group has a prevention policy applied to it, only one of the prevention policies is used. The two prevention policies are not combined and then applied to the agent.

- An agent uses the closest policy as you move up the agent group tree. If an agent has a prevention policy applied directly to it, then the agent uses that policy, since the agent's policy is closer in the group tree than the agent's group policy.

- Policies that are incompatible with an agent are ignored. For example, consider when a Windows agent and a Solaris agent are in the same policy group. The policy group has a Solaris policy applied to it and the policy group's parent group has a Windows policy applied to it. The Solaris agent uses its group's policy since it is compatible. The Windows agent, however, skips its group's policy and uses the policy of its group's parent, which is compatible.

- Since a policy group can have multiple policies assigned to it, it is possible to have more than one policy that is compatible with an agent. In this case, DCS:SA chooses the most compatible policy, based on the minimum agent version of the policy. The policy with the highest minimum agent version is used.

You apply a policy to an agent directly or through a policy group. When you apply or make changes to a policy from a policy group, the management server determines which agents in that group use the group's policy, and then flags those agents for pending policy updates.

**Prevention configuration groups**

You apply prevention configurations to configuration groups. Configuration groups contain one or more agents that support prevention features. Configuration groups are organized in a hierarchy of groups.

You might use prevention configuration groups for the following reasons:
The agents have the same prevention configuration. You can configure the settings once on the group rather than individually for each agent.

You can manage many configurations. You can organize the configurations in groups so that you can update your agents' configuration settings efficiently.

The default prevention configuration group is named Configuration. When an agent that supports prevention features registers with the management server, it is automatically placed in the default Configuration group unless a group was assigned during agent installation.

**How prevention configurations are applied to agents**

Symantec Data Center Security: Server Advanced applies prevention configurations to agents based on the following rules:

- Upon initial DCS:SA agent installation, the default common parameters and default prevention parameters are applied to an agent when it registers with the management server.
- An agent that supports prevention features uses common parameters and prevention parameters.
- An agent can get its prevention configuration from itself or from a prevention configuration group.
- An agent resides in exactly one prevention configuration group.
- If you apply a prevention configuration to an agent that already has a prevention configuration, then the new prevention configuration replaces the old prevention configuration.

You can configure agents directly or through a prevention configuration group. When you configure agents through a group, the management server determines which agents in the group use the group’s configuration, and then flags those agents for pending configuration updates.

**Common configuration groups**

The common configuration groups are available in the Prevention view.

**Enabling or disabling the state of the prevention feature**

The DCS:SA agent installation kit includes an Enable Intrusion Prevention installation option. When this option is selected, the prevention features of DCS:SA are enabled for the agent. The IPS drivers are loaded on the agent computer, and the agent accepts prevention policies from the management console.
When the Enable Intrusion Prevention installation option is not selected, the prevention features of DCS:SA are completely disabled for the agent. The IPS drivers are not loaded on the agent computer, and the agent does not accept prevention policies from the management console.

If intrusion prevention was disabled during DCS:SA agent installation, you should note the following:

- All agents that support the intrusion prevention feature appear in the Prevention view. On the **Assets** page, an icon indicates whether the feature is currently enabled.
- You can make policy and configuration changes to all agents, even those agents for which the prevention feature is disabled.
- Agents with the intrusion prevention feature disabled request and process prevention and common configuration changes, but not prevention policy changes. Any prevention policy updates remain pending until the prevention feature is enabled on the agents.

If intrusion prevention was disabled during agent installation and you want to enable it, you must log on to the agent computer, run the agent config tool, and then restart the agent computer.

You can enable or disable the state of the prevention feature by using the SISIPSConfig utility or by using the Agent_Diagnostic policy.

See “Enabling or disabling the state of the prevention feature by using the SISIPSConfig utility” on page 75.

See “Enabling or disabling the state of the prevention feature by using the Agent_Diagnostic policy” on page 84.

**Enabling or disabling the state of the prevention feature by using the SISIPSConfig utility**

With SISIPSConfig utility you can enable or disable prevention feature on the agent. The command line `-ipsstate on` option or the `-ipsstate off` option is provided to achieve prevention feature state change.

---

**Note:** To run the agent config tool (sisipsconfig.exe), you must have administrative privileges.

---

On Windows, you can execute this utility as follows:

```
sisipsconfig.exe -ipsstate on
```

This command enables the IPS drivers.

On UNIX or Linux, you can execute this utility as follows:
su - sisips -c "/sisipsconfig.sh -ipsstate on"

**Note:** To complete the change in prevention state, you have to restart the agent system. On fresh install, you can also set the agent driver state to the desired end state by using installation command switches.

**Note:** For more information, see *Symantec Data Center Security: Server Advanced Planning and Deployment Guide*.

See “Enabling or disabling the state of the prevention feature” on page 82.

See “Enabling or disabling the state of the prevention feature by using the Agent_Diagnostic policy” on page 84.

**Enabling or disabling the state of the prevention feature by using the Agent_Diagnostic policy**

The Agent_Diagnostic policy includes two new diagnostic functions, **Enable Prevention** and **Disable Prevention** that enable you to change the prevention state of a group of agents from a central location. When you apply the Agent_Diagnostic policy with **Disable Prevention** function, the agent disables the state of the IPS drivers. When you apply this policy with **Enable Prevention** function, the agent enables the IPS drivers.

The functions invoke the SISIPSConfig utility at the Agent with the **-ipsstate on/off** switch to enable or disable the state of IPS drivers. Use of the Agent_Diagnostic policy to enable or disable prevention generates a corresponding Agent Status event at the DCS:SA console.

Following is an example of an Agent Status event at the DCS:SA console when you use the policy to disable prevention:

**SOURCE**

<table>
<thead>
<tr>
<th>Host IP Address</th>
<th>127.0.0.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Version</td>
<td>5.2.9.541</td>
</tr>
<tr>
<td>OS Type</td>
<td>Windows</td>
</tr>
<tr>
<td>OS Version</td>
<td>Server 2008 R2</td>
</tr>
<tr>
<td>Agent Type</td>
<td>SDCSS Native Agent</td>
</tr>
</tbody>
</table>

**EVENT**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Agent Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Category</td>
<td>Real Time - Management</td>
</tr>
</tbody>
</table>
**Event Severity** Information
**Event Priority** 12
**Event Date** 03-Oct-2012 21:02:06 EDT
**Post Date** 03-Oct-2012 21:02:57 EDT
**Post Delay** 00:00:51
**Event Count** 1
**Event ID** 107

**DETAILS**

**Message** Prevention feature disabled.
Will take effect at next boot.

**Service** AgentConfigTool
**Disposition** Success
**Message ID** 10319

To complete this change in prevention state, you must restart the individual agent systems. The policy performs the function immediately after it is applied to the agent. After confirming that the policy performed the enabled function, you must clear the policy from the agent.

**Note:** Symantec recommends that you change the policy before a maintenance window where the servers can be restarted, so that the policy change does not take effect at a later time, or at an unscheduled restart when the policy change may be forgotten.

See “Enabling or disabling the state of the prevention feature” on page 82.
See “Enabling or disabling the state of the prevention feature by using the SISIPSConfig utility” on page ?.

**Using the Detection view**

You use the Detection view to apply policies and configurations to agents that support the detection features of Symantec Data Center Security: Server Advanced.

You can do the following activities in the Detection view:

- List agents that support detection features
- View the overall status of each agent
- View policy and agent configuration
- Organize agents in policy domains and policy groups
- Organize agents in configuration groups
Apply policies to agents and agent groups
Apply configurations to agents and agent groups
Delete agents from detection policy groups

In the Detection view, you can create the following types of agent groups:

- Policy groups
- Configuration groups

Detection policy domains
You organize agents and policy groups in a hierarchy of policy domains. The default policy domain is named Policy.

You might use policy domains to manage many customers. You can build a customer domain hierarchy, with one customer per domain and multiple policy groups under each domain.

When using domains, please note the following:

- You can create domains within domains. You cannot create domains within groups.
- You can nest domains. Domains can contain other domains, groups, or agents; any combination is permitted.
- Groups can only reside in domains.
- Every agent must reside in at least one group or domain in the detection policy tree. Agents can reside in multiple domains. Agents can reside in domains and groups simultaneously.
- You can delete an agent from a domain (or a group) as long as the domain (or group) is not the last instance of the agent in the tree. The last instance cannot be deleted.
- You cannot delete the default Policy domain.
- You can move agents between domains, between groups, and between domains and groups. You cannot move groups between domains. You cannot move domains between domains.
- You cannot apply policies to domains.

Detection policy groups
You apply detection policies to policy groups. Policy groups contain one or more agents that support detection features. Policy groups are organized in a hierarchy of domains and groups.
During server installation, the following default OS-specific policy groups are created in the default Policy domain:

- AIX
- HP-UX
- Linux
- Solaris
- Windows

You might use policy groups for the following reasons:

- The agents use the same policy. You can apply the policy once to the policy group rather than individually to each agent.
- Your network may contain agents that are installed on different operating systems. You can have separate policy groups based on the operating system type.

When an agent that supports detection features registers with the management server, it is automatically placed in the default OS-specific policy group in the default Policy domain, unless a group was assigned during agent installation. If any detection policies are applied to any of the OS-specific policy groups, these policies are automatically applied to the agent when the agent registers.

**How detection policies are applied to agents**

Symantec Data Center Security: Server Advanced applies detection policies to agents based on the following rules:

- An agent can reside in multiple detection policy groups. If an agent resides in more than one policy group, it gets the combination of all detection policies applied to all the groups in which it resides.
- Every agent must reside in at least one group or domain in the detection policy tree.
- An agent can be deleted from a domain (or a group) as long as the domain (or group) is not the last instance of the agent in the tree. The last instance cannot be deleted.
- You can apply multiple policies to a policy group. If multiple policies are applied to a group, the agents in that group get the combination of all detection policies applied to the group.
- You cannot apply policies to domains.
- An agent can have none, one, or many detection policies applied to it. If an agent has no policies applied to it, the agent does not log any detection events.
Upon initial DCS:SA agent installation, any detection policies applied to the OS-specific policy groups are automatically applied to an agent. Since you can apply multiple detection policies to an agent, you can apply conflicting policies to an agent. DCS:SA resolves policy conflicts based on the following rules:

- If one policy enables a rule, and another policy disables the same rule, then the rule is enabled on the agent. For example, suppose a policy that is applied to a group explicitly enables the record successful logon rule, and another policy that is applied to the same group explicitly disables the same rule. If an agent is placed in both groups, then the record successful logon rule is enabled for the agent.

- If a parameter list has different contents in different policies, then the agent is sent the combined parameter list from the policies. For example, suppose a policy applied to a group lists File A and File B in the watch for file creation rule, and a policy applied to another group lists File 1 and File 2 in the same rule. If an agent is placed on both groups, then the agent receives a watch for file creation list of File A, File B, File 1, and File 2.

Detection configuration groups

You apply detection configurations to configuration groups. Configuration groups contain one or more agents that support detection features. Configuration groups are organized in a hierarchy of groups.

You might use configuration groups for the following reasons:

- The agents have the same configuration. You can configure these settings once on the group rather than individually for each agent.

- You manage many configurations. You can organize the configurations in groups so that you can update your agents’ configuration settings efficiently.

The default detection configuration group is named Configuration. When an agent that supports detection features registers with the management server, it is automatically placed in the default Configuration group unless a group was assigned during agent installation.

How detection configurations are applied to agents

Symantec Data Center Security: Server Advanced applies detection configurations to agents based on the following rules:

- An agent that supports detection features uses common parameters and detection parameters.

- An agent can get its detection configuration from itself or from a detection configuration group.
An agent resides in exactly one detection configuration group.

If you apply a detection configuration to an agent that already has a detection configuration, then the new detection configuration replaces the old detection configuration.

Upon initial DCS:SA agent installation, the default common parameters and default detection parameters are applied to an agent when it registers with the management server.

Common configuration groups
The common configuration groups are available in the Detection view.

About common configuration groups
You apply common configurations to common configuration groups. Common configuration groups contain one or more agents that are registered with the management server.

Symantec Data Center Security: Server Advanced applies common configurations to agents based on the following rules:

- All agents uses common configurations.
- An agent can get its common configuration from itself or from a common configuration group.
- An agent resides in exactly one common configuration group.
- If you apply a common configuration to an agent that already has a common configuration, then the new common configuration replaces the old common configuration.

Common configuration groups are organized in a hierarchy of groups. The default common configuration group is named Common Configuration. When an agent registers with the management server, it is automatically placed in the default Common Configuration group unless a group was assigned during agent installation.

The common configuration groups are available in the Prevention view and Detection view. Changes made in one view are automatically reflected in the other view.
Viewing agents registered with the management server

You use the Network view to view all agents that are registered with the management server. You can determine how well your computer is protected by monitoring and analyzing this information.

Upon initial installation, the following occurs:

- All agents are assigned to the Network group, in the Network view.
- The DCS:SA manager, which collects all server-related events, is assigned to the Virtual Agents folder.
  
  See “About the DCS:SA manager virtual agent” on page 94.

To view all agents registered with the management server

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Network**.
3. On the Network page, in the **Network Assets** pane, click **Network** to list all agents that are registered with the management server.
4. (Optional) To expand or restrict the list of agents, select one of the following filters:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Nodes</td>
<td>Filter that displays all the agents.</td>
</tr>
<tr>
<td>Windows Nodes</td>
<td>Filter that displays the agents that run a Windows operating system.</td>
</tr>
<tr>
<td>Solaris Nodes</td>
<td>Filter that displays the agents that run a Solaris operating system.</td>
</tr>
<tr>
<td>Linux Nodes</td>
<td>Filter that displays the agents that run a Linux operating system.</td>
</tr>
<tr>
<td>AIX Nodes</td>
<td>Filter that displays the agents that run an AIX operating system. Applies to agents that support detection features.</td>
</tr>
<tr>
<td>HP-UX Nodes</td>
<td>Filter that displays the agents that run an HP-UX operating system. Applies to agents that support detection features.</td>
</tr>
</tbody>
</table>

About the management server health

In the management console menu bar, the overall health of the connection between the management server and the database is indicated by one of the following:

- A **Connected To [<server>]** indicates that the management server is running.
A Connected To [<server error>] or Connected To [<database error>] indicates that a management server or database error occurred.

About the agent pane

The agent pane lists the agents in a policy or configuration group. The agent pane is located on the right side of the Assets page. The bottom half of the agent pane lists details about a selected agent.

The agent pane comprises columns of information about each agent.

Agent Health column

Agent Health is the first column in the agent pane. The Agent Health column indicates whether an agent is in contact with the management server. Place your mouse cursor over the Agent Health column to view a pop-up tool tip.

The Agent Health column displays one of the following icons:

- A green circle icon indicates that an agent is healthy.
- A yellow circle icon indicates that an agent is possibly offline and experiencing minor problems.
- A red circle icon indicates that an agent is offline and experiencing major problems.

See “Configuring agent health timeout settings” on page 100.

Feature State column

Feature State is the second column in the agent pane. The Feature State column appears in the Network view and Prevention view. Each prevention feature supported by the management console has a Feature State column. Place your mouse cursor over the Feature State column to view a pop-up tool tip.

The feature state can change from complete protection to limited or no protection if you do the following:

- Apply the DCS:SA Null prevention policy to an agent.
  By default, the Null prevention policy is applied to an agent when it registers with the management server. The Null prevention policy provides no protection.

- Enable the global disable prevention policy option in a DCS:SA prevention policy applied to an agent.
  The disable prevention policy option in the prevention policies disables policy prevention for an agent computer. The policy violations are logged by the agent, but are not enforced.
Override an agent’s prevention policy using the policy override tool. The policy override tool lets a user temporarily or permanently disable prevention policy enforcement on an agent computer. To use the policy override tool, the prevention policy applied to the agent computer must be configured to allow the user to override prevention policy enforcement. The policy override tool runs on Windows and UNIX operating systems.

The feature state icon shows one of the following states:

- Shield icon: An agent is protected
- Shield icon with red X: An agent has limited or no protection
- Shield icon with blue V: An agent is a virtual agent (Network view only)
- Blue triangle icon: Restart the agent computer

- If the blue triangle icon points up, the prevention feature is disabled, but is enabled after a restart. Restart the agent computer.
- If the blue triangle icon points down, the prevention feature is enabled, but is disabled after a restart. Restart the agent computer. The agent continues to enforce the most recent prevention policy until the restart. To stop enforcement before the restart, apply the Null policy before disabling the prevention feature.
- After installing an agent, if the blue triangle appears next to the agent, stop and then restart the intrusion prevention service (click Start > Settings > Control Panel > Administrative Tools > Services, and then select DCS:SA Agent). The blue triangle changes to the shield icon.
- Black circle with diagonal line icon: Prevention feature is completely disabled

**Name column**

The Name column contains the name of the agent.

The lettering of the agent's name and the appearance of an icon indicate the following:

- Normal lettering: No pending changes or outstanding errors.
- Bold and italic: Pending changes to the agent's configuration or policy assignment that have yet to be received by the management server. When the changes are applied to the agent, the lettering reverts to normal.
- Bold: Pending changes to the agent that were received by the management server, but not applied to the agent. Check the agent's property Status tab for information about the failed action, and decide how to manually solve the problem.
- Flag icon: Changes to the agent's configuration or policy assignment are pending.
Exclamation icon: An error has occurred. You can change the name of the agent. See “Modifying an agent name” on page 118.

**IP Address column**
The IP Address column contains the IP address of an agent computer.

**Policy column**
The Policy column contains the name of the prevention policy applied to an agent. You use the Policy column in the Prevention view. A folder icon after the policy name indicates that an agent gets its policy from a group. To find the group name, move the cursor over the policy cell. You can also determine the group name from the Policy tab in the Details pane.

**Version column**
The Version column contains the version of DCS:SA software that is installed on an agent computer.

**OS column**
The OS column contains the operating system of the computer on which the agent is installed.

**Last Contact column**
The Last Contact column contains the date and time that the agent last contacted the management server to request policy and configuration updates.

**Details pane**
The Details pane comprises the following tabs:

- **General tab**: Provides a selected agent’s host name, software version, operating system, IP address, creation, and modification dates, Deny Logs check box.
- **Policies tab**: Lists the policies applied to a selected agent.
- **Configs tab**: Lists the configurations applied to a selected agent.
- **Recent Events tab**: Lists recent prevention or detection events for a selected agent.
History tab  Lists audit events for a selected agent.

About the DCS:SA manager virtual agent

The DCS:SA manager virtual agent represents the DCS:SA entity (front-end servers and database as a single object). All server-related events (startup and shutdown of front-end servers, alert control events, cleanup, database storage errors, aggregate health change events, etc.) are assigned to the DCS:SA manager virtual agent.

Every DCS:SA management server has a DCS:SA manager virtual agent that was created during installation. The DCS:SA manager is registered into the Virtual Agents folder in the Network group, in the Network view.

The DCS:SA manager virtual agent is configured as follows:

<table>
<thead>
<tr>
<th>Host name</th>
<th>DCS:SA manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Virtual agent</td>
</tr>
<tr>
<td>Agent type</td>
<td>DCS:SA Server Entity</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td>IP Address</td>
<td>127.0.0.1</td>
</tr>
</tbody>
</table>

**Health timeouts**

The DCS:SA manager virtual agent is considered possibly offline (yellow icon) after 10000000 seconds.

The DCS:SA manager virtual agent is considered offline (red) after 20000000 seconds.

**Health attribute**

Last event determines the agent health.

**Health events**

No events are generated when the DCS:SA manager virtual agent changes status.

To control user access to the DCS:SA manager virtual agent, you can move the virtual agent into a subgroup.

You can use Search Events on the Monitors page to view all server-related events. Server-related events include event types Server Status and Agent Status. Search events using the source computer name (for example, DCS:SA manager (Sales-GCPX1C)).
About the management server list

An agent's management server list comprises the primary management server and optional alternate management servers. Alternate management servers are used for simple failover. Should the primary management server fail, simple failover lets agents automatically switch to the next management server in an ordered list of alternate servers.

Viewing the management server list

To view an agent's management server list, you use the -view command in the agent config tool.

To view the management server list

1. Log on to the agent computer.
2. Navigate to the agent config tool directory.
3. At a command prompt, type `sisipsconfig -view` (Windows) or `sisipsconfig.sh -view` (UNIX), and then press Enter.

Modifying the management server list

You can modify an agent's management server list using the following methods:

Agent_Diagnostics detection policy

An option in the Agent_Diagnostics detection policy lets you modify an agent's management server list.


Agent config tool

On the agent computer, run the agent config tool using the -host command. The -host command sets the IP address or fully qualified host name of the primary management server and optional alternate management servers used by the agent.

In the command line, specify the primary management server, followed by the optional alternate management servers.

On Windows agents, the command is as follows:

```
sisipsconfig -host primary[,alternate1,alternate2,...]
```

On UNIX agents, the command is as follows:

```
sisipsconfig.sh -host primary[,alternate1,alternate2,...]
```
Viewing and configuring agent and group properties

Agent and group properties provide an overview of how an agent or group is configured.

Viewing agent properties

Agent properties describe how an agent is configured.

In the management console, the agent properties dialog comprises several tabs of information: General, Details, Contact, Status, Policy, Config, Group, Recent Events, History, and Collector.

The following agent properties appear on the **General** tab, which provides general agent information:

- **Host Name**: The name of the agent host computer. This name appears in the management console.
- **Type**: The type of host (agent, virtual agent).
- **Operating System**: The operating system of the agent computer.
- **IP Address**: The IP address of the agent computer.
- **Created**: The date the agent was created.
- **Modified**: The date the agent was last modified.
- **Last Contact**: The date the agent last polled for configuration changes.
- **Last Event**: The date the agent last sent an event.
- **Agent Health**: The health of the agent, indicated by a colored icon. Agent health is denoted by the green/yellow/red circle icon in the Agent Health column on the Assets page. A green icon indicates that an agent is healthy. A yellow icon indicates that an agent is possibly experiencing problems. A red icon indicates that an agent is experiencing problems.

See “Configuring agent health timeout settings” on page 100.
Select the Deny Logs check box to temporarily stop an agent from sending events to the management server. If an agent is experiencing problems, selecting this check box prevents the agent from flooding the management server database with events. After you resolve the agent problem, clear the Deny Logs check box to resume sending events to the management server.

The Deny Logs option overrides an agent's log rules.

Default: Off

A full description of the agent.

The following agent properties appear on the Details tab, which tracks the agent's event file activities:

Service start time: The date the DCS:SA communications service/daemon was last started. If this service is not running, then no communications are possible with the agent.

Last collector update: The date the IDS service/daemon was last started. If this service is not running, then no new events are produced for transmission to the server. This date is usually within a few seconds of the service start time. If it is not, then problems occurred on the agent that caused the service to restart abnormally.

Agent Uptime: A formatted display of the time difference since the service start time and the current time. The agent uptime is shown as number of days, hours, minutes, seconds (DDDd HH:MM:SS).

Example: 28d 01:41:12

Agent Age: The age, in days, of the agent.

Timezone offset: The time, in minutes, that the agent local time is offset from Greenwich Mean Time (UTC).

This value can be negative (for agents to the west of GMT) or positive (for agents to the east of GMT). This may be useful to know when choosing a collector host for virtual agents. The collector host should have the same timezone offset as the virtual agent source system.

Note: All system date/time values are handled as Coordinated Universal Time (UTC). Some system date/time values that are shown in the management console are converted to the local time zone. Converted values are shown with the appropriate time zone values.
### Character set
The character encoding format used by the agent.
UTF-8 indicates single byte environment. UTF-16 indicates double byte environment.

This may be useful to know when choosing a collector host for virtual agents. The collector host should have the same character encoding as the virtual agent source system.

### Last event file
The name of the last bulk event file created on the agent.

### Last file's event count
The number of total events stored in the last bulk event file created on the agent.

### Total event files
The cumulative number of bulk event files produced on the agent.

### Total event count
The cumulative number of events recorded to bulk event files on the agent.

### Last uploaded file
The name of the last bulk event file uploaded to the management server.

### Last upload's event count
The number of total events stored in the last bulk event file uploaded to the management server.

### Total uploaded files
The cumulative number of bulk event files uploaded to the management server.

### Total uploaded events
The cumulative number of events recorded to bulk event files that were uploaded to the management server.

This figure represents the total number of events potentially available for forensic analysis.

### The Contact tab
The Contact tab provides contact information for the agent. You can modify the contact information.

The Contact tab contains the following information:

- **Agent priority**: The priority (0-99) of the agent.
- **Contact name**: The name of the person or organization responsible for the underlying system that the agent represents.
- **Telephone numbers**: The telephone numbers associated with the contact name.
- **Email address**: The email address for the contact name.
- **Location**: The physical or logical address where the system resides.
Business Information

Additional business context information about the agent.
This may include user-defined keywords or phrases for query and reference purposes.
For example, the keywords may refer to business functions (such as Payroll, Sales, Development), regulatory issues (such as HIPAA, SOX, GLBA), or application usage (such as Database, Email, Web).

The following agent properties appear on the **Status** tab, which provides the status of pending policy and configuration updates for the agent:

Policy and configuration status for the agent

Error Messages

Error messages associated with the agent.

The following agent properties appear on the **Policy** tab, which lists the policies applied to the agent or policy group:

Prevention Policies
The prevention policies applied to the agent or policy group.

Detection Policies
The detection policies applied to the agent or policy group.

The following agent properties appear on the **Config** tab, which lists the configurations applied to the agent or configuration group:

Prevention Configs
The prevention configurations applied to the agent or configuration group.

Detection Configs
The detection configurations applied to the agent or configuration group.

The following agent properties appear on the **Group** tab, which lists the groups in which the agent resides:

Network Group
The Network view groups in which the agent resides.

Prevention Groups
The Prevention view groups in which the agent resides.

Detection Groups
The Detection view groups in which the agent resides.

Common Config Group
The common configuration group in which the agent resides.

The following agent properties appear on the **Recent Events** tab, which lists recent events for the agent:
The following agent properties appear on the History tab, which lists audit events for the agent:

- **Date**: The event date.
- **User**: The user that generated the event.
- **Operation**: The operation that generated the event.
- **Description**: A description of the event.
- **Source Machine**: The source machine that generated the event.

The Collector tab lists the DCS:SA agent that most recently collected a virtual event for a virtual agent.

See “About virtual agents” on page 104.

**To view agent properties**

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. On the Assets page, select an agent, and then right-click **Properties**.
4. In the properties dialog box, view or edit the agent properties.
5. Click **OK**.

### Configuring agent health timeout settings

Agent health timeout settings provide control over agent health conditions and change-of-status event generation.

Configured independently of the polling interval, agent health is denoted by the green, yellow, or red circle icon in the Agent Health column on the Assets page. A green icon indicates that an agent is online. A yellow icon indicates that an agent is possibly offline. A red icon indicates that an agent is offline. Separate yellow and red default values are provided for native and virtual agents.
The color of the agent health icon is determined using the following rules:

- Agent health is set to green when the last contact time or the last event time plus the yellow interval seconds is greater than the current time.
- Agent health is set to yellow when the last contact time or the last event time plus the yellow interval seconds is less than the current time and the last contact time or the last event time plus the red interval seconds is greater than the current time.
- Agent health is set to red when the last contact time or the last event time plus the red interval seconds is less than the current time.

Status change events are optionally generated when the agent health icon changes color. These real-time events are available for viewing using real-time monitors or alerts.

The agent health timeout settings are as follows:

Agent is Possibly Offline after [n] seconds (min. 30)

- The number of elapsed seconds before the agent health icon turns yellow.
- Default for native agents: 900
  - The default value for native agents is 3 times the normal polling interval of 5 minutes. This provides enough time for agents to check on a busy system or to accommodate temporary connectivity issues.
  - If the agent health icon skips from green to red, set the yellow interval equal to the red interval. If the agent health icon is perpetually green, set a very large number for the yellow and red intervals.
  - Default for virtual agents: 172800
  - The default value for virtual agents represents a 4-hour interval for a virtual agent to generate an expected event.

Agent is Offline after [n] seconds (larger than above)

- The number of elapsed seconds when the agent health icon turns red.
- Default for native agents: 3000
  - The default value for native agents represents 50 minutes for an agent’s health to turn red (offline).
  - The minimum red interval must be equal to or greater than the yellow interval.
  - Default for virtual agents: 43200
  - The default value for virtual agents represents 12 hours for an event to appear from a virtual agent before turning red.
Select which attribute determines agent health:

- Last Event: The last time the agent sent an event.
- Last Contact: The last time the agent polled for configuration changes.

Default: Last Contact

Agent health is computed using Last Contact unless the agent is configured to use Last Event.

Virtual agents use Last Event, since they do not poll for configuration changes.

Select this checkbox to generate a status change event when the agent goes from offline status to online status.

Default: Off (no event is generated)

Select this checkbox to generate a status change event when the agent goes to possibly offline status.

Default: Off (no event is generated)

Select this checkbox to generate a status change event when the agent goes to offline status.

Default: Off (no event is generated)

To prevent network flooding as agents go offline and then online, a system-wide flood-control option aggregates status change events into a single event.

You can configure agent health settings for a single agent or many agents. The changes are applied to all selected agents.

To configure agent health timeout settings for an agent:

1. In the management console, click Assets.
2. On the Assets page, select an agent, and then right-click Properties.
   - To configure many agents, press and hold the Shift or Ctrl key while selecting the agents, and then right-click Properties. Click the Health tab, and then continue with step 4.
3. In the agent properties dialog box, on the General tab, click Configure Heath.
4. In the Agent Health Settings dialog box, edit the agent health timeout settings.
5. Click OK.
Viewing group properties

Group properties describe how a group is configured. You can view group properties to determine which policies and configurations are applied to a group.

Group properties are as follows:

- **General tab**: Provides group name, group tree path, date group was created, date group was last modified.
- **Policy tab**: Lists the policies applied to a policy group.
- **Configuration tab**: Lists the configurations applied to a configuration group.
- **Security tab**: Lists the roles that have access to a group.
- **Recent Events tab**: Lists recent events for a group.
- **History tab**: Lists audit events for a group.

**To view group properties**

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. On the **Assets** page, select a policy or configuration group, and then right-click **Properties**.
4. In the properties dialog box, view the group properties.
5. Click **Cancel**.

Creating a policy domain

You can create domains within domains. You cannot create domains within groups.

**To create a policy domain**

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Detection**.
3. In the left-hand panel, under **Asset Groups**, right-click **Policy** and then select **Add Domain**.
   
   A new domain is created with the name **New Domain**.
Creating an agent group

Create agent groups so that you can update your agents' policy and configuration settings efficiently. Name agent groups so that you can easily identify which agents to apply to the group.

To create an agent group

1. In the management console, click **Assets**.
2. If you are creating a detection policy group, select a domain.
3. On the Assets page, select the default group or another group, and then right-click **New**. A new agent group is created with the New Group.
4. Type the name of the agent group, and then press **Enter**.

About virtual agents

Symantec Data Center Security: Server Advanced virtual agents indirectly detect off-platform event data and associate the data with agents in the management console. Virtual agents provide the appearance of deployed agents reporting events from endpoint systems where DCS:SA is not directly installed or managed.

Virtual agents greatly expand event collection beyond the traditional DCS:SA endpoint systems.

Using virtual agents, you can do the following:

- Capture event data from legacy systems (such as Symantec Intruder Alert) and represent those agents and events in the management console.
- Forward events from multiple DCS:SA managers into a common manager and console that can display events from agents in your entire deployed environment.
- Handle forwarded operating system event data (such as syslog and Windows event log) as individual source system events.
- Capture event data from a variety of platforms (such as mainframe, Windows 98, AS 400, Mac OS) that DCS:SA does not support with an agent kit.

Symantec Data Center Security: Server Advanced recognizes and processes virtual agent event data that is derived from syslog and Windows event log.

DCS:SA also recognizes and processes virtual agent event data via policy rules. Detection policies let you designate resulting events as originating from virtual agents. Similar to specifying a user-defined text string, you can identify a source system identification tag that indicates the events are from an agent other than the host machine that processed the events.
Virtual agents can be dynamically registered as part of the event flow and manually registered in the management console.

Virtual agents behave like native agents from an event visibility and object management standpoint.

Virtual agents do not accept policies or configurations.

There is no direct relationship between a virtual agent and the native agents that act as collection hosts. The virtual agent mapping is derived from the event data trail.

About agent properties and console behavior

With a few exceptions, you manipulate virtual agents in the Network view and throughout the console like native agents. You can move agents among groups, delete agents, display and edit agent properties, and view recent events and audit history events. All relevant console functions within the Home page, Assets page, Monitors page, Reports page, and Alerts page operate as if you were interacting with a native agent.

The following agent properties pertain specifically to virtual agents:

Agent health settings

A virtual agent's health is based on the last time the agent sent an event.

See General tab > Configure Health button > Health Attribute > Last Event.

You can use this information to configure when the agent health icons turn yellow and red. For example, if a virtual agent typically generates an event every four hours, then this may be an appropriate timeout value to use to cause an agent health status change when no event is received during that period.

See “Configuring agent health timeout settings” on page 100.

Collector tab

The Collector tab lists the DCS:SA agent that most recently collected an event for a virtual agent.

The View button on the Collector tab lets you view agent properties for the collector agent. This is particularly useful when the virtual agent is offline and you want to determine if the collector agent is itself offline.

Deny Logs setting

Virtual agent properties include the Deny Logs setting. When enabled, this setting temporarily stops a virtual agent from sending events to the management server.

The following console behavior pertains specifically to virtual agents:
Home page The Home page contains reporting statistics for virtual agent-related counts, including registered virtual agent count and offline virtual agent count.

Assets page The feature state icon shows virtual agents with the Shield icon and a blue V.

Monitors page The Event Details window includes additional attribute information for virtual events. These virtual events include a description of the source agent type (ITA forwarded, DCS:SA forwarded, OS forwarded, external system/object) and details about the collection agent.

You can use the virtual agent type to configure filters for real-time monitors and event searches.

Reports page A stock query displays all collection hosts for virtual agents based on the event trail.

You can use the virtual agent type to configure filters for queries.

Alerts page You can use the virtual agent type to configure filters for alerts.

About virtual agent types

Every virtual agent is assigned a virtual agent type. The virtual agent type reflects the source environment that originally collected the event data.

The predefined virtual agent types are as follows:

ITA Agents whose source events were collected via Symantec Intruder Alert.

DCS:SA Forwarded Agent Agents whose source events were collected by a DCS:SA agent that was controlled and managed by another DCS:SA manager.

Derived Agents whose sources events originated from a system other than the system on which the DCS:SA agent resides.

Typical examples include OS forwarded syslog or Windows event logs.

External Agents whose source events originated from a system or object completely external and unknown to DCS:SA.

These virtual agents may represent a system (such as a Mainframe), a device (such as a printer), an object (such as a database or user) or even abstract concepts (such as applications, rule names, categories, actions).
Native agents running DCS:SA agent on the local machine.
This is the default agent type that is used when a DCS:SA agent registers with the management server.

DCS:SA Server Entity
The virtual agent associated with every DCS:SA management environment.
See “About the DCS:SA manager virtual agent” on page 94.

About collector hosts
The DCS:SA agents act as collector hosts for virtual agents. Collector hosts capture virtual events and represent those virtual agents and events in the management console.

The following information may be useful when choosing the DCS:SA agents that act as collector hosts:

- The collector host should have the same timezone offset as the virtual agent source system being monitored.
  In the agent properties, the timezone offset is the time, in minutes, that the agent local time is offset from GMT (UTC). This value can be negative (for agents to the west of GMT) or positive (for agents to the east of GMT).

- The collector host should have the same character encoding as the virtual agent source system being monitored.
  The character set is the character encoding format used by the DCS:SA agent. UTF-8 indicates single byte environment, UTF-16 indicates double byte environment.

You must configure the DCS:SA agents that act as collector hosts to do the following:

- Transmit virtual events to the management server
  You must configure agent log rules to transmit virtual events to the management server.
  You can configure agent log rules based on the virtual tag. A virtual tag identifies the source system or abstract object where a virtual event originated. It can be a text string (such as Mainframe01) or a variable (such as {VIRTUAL_TAG}).

- Bulk log virtual events
  If the virtual agent system-wide settings are configured to bulk log virtual events, you must enable bulk logging on the agent.
  See “Configuring Virtual Agent settings” on page 108.

About virtual agents and log rules
You can configure agent log rules based on the following event variables:
For example, you can bulk log all virtual agent events for Mainframe01 using a wildcard character match on Virtual Agent/Tag.

You can transmit all virtual events as real-time console events by matching System State equal to V.

About virtual events and bulk logging

The bulk log transfer feature in DCS:SA supports virtual agents. Virtual bulk log files are generated for every virtual agent represented by event data.

The main event file is separated into component host files, as follows:

- An event file is produced for the native collector host.
- An event file is produced for each virtual agent that is identified in the event stream.

For example, suppose an agent rotates its event logs daily, and the current event log file contains events for the local host and four virtual agents. Upon log rollover, the agent produces five bulk log files, each labeled according to the source system identifier. Bulk log processing occurs five times; each compressed log file is moved to the upload directory for transmission to the management server.

Virtual bulk files use the general bulk file naming convention, as follows:

YYYYMMDD_HHMMSS_QQQQ-FT_HOSTNAME

Virtual bulk files use file type V (virtual) and OS type O (other).

For example:

- 20070413_170421_001-VO_Mainframe01
- 20070407_131415_456-VO_192.168.12.25

Configuring Virtual Agent settings

The Virtual Agent settings on the Admin page control the storage of virtual events and the dynamic registration of virtual agents.

Virtual agents can be dynamically registered as part of the event flow and manually registered in the management console. Manual registration gives you complete control over the definition of a virtual agent. With manual registration, you explicitly set all the registration information for an agent, as well as place the agent into the desired Network view group.
Dynamic registration saves time when registering large numbers of agents. With
dynamic registration, agents are automatically registered as part of the event flow
and placed into the appropriate Master group and Manager subgroups.

Dynamically registered agents are placed into the following Master groups:

- Agents whose source events were collected via Symantec Intruder Alert or
  DCS:SA appear in a Master group named ITA Forwarded and DCS:SA
  Forwarded, respectively.

- Agents whose source events originated from a system other than the system
  on which the DCS:SA agent resides (for example, forwarded syslog or Windows
  event logs) appear in the appropriate OS Forwarded Master group.

- Agents whose source events originated from an external system or object appear
  in the appropriate External group.

Manually registering a virtual agent

During manual registration, you explicitly set all of the registration information for
an agent, and place the agent into the desired Network view group.

Make sure you configure the system-wide setting that controls virtual agent
registration and virtual event storage.

See “Configuring Virtual Agent settings” on page 108.

Make sure you configure log rules for the DCS:SA agents that act as collector hosts.

See “About collector hosts” on page 107.

To manually register a virtual agent

1. In the management console, click Assets.

2. Under the Assets tab, click Network.

3. In the Network Assets pane, right-click Virtual Agents and select New Virtual
   Agent.
4 In the **New Virtual Agent** dialog box, configure the agent properties, and then click **Next**.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the virtual agent. The name appears in the management console. The name is intended but not required to be a unique name among all virtual agents.</td>
<td>Required</td>
</tr>
<tr>
<td>Agent Type</td>
<td>Select or enter the virtual agent type. The virtual agent type reflects the source environment that originally collected the event data. See “About virtual agent types” on page 106.</td>
<td>Required</td>
</tr>
<tr>
<td>Host Name</td>
<td>The name of the source machine or system that originally processed the virtual events. The host name is not considered unique.</td>
<td>Optional</td>
</tr>
<tr>
<td>IP Address</td>
<td>The address of the source machine or system that originally processed the virtual events. This IP address is not considered unique.</td>
<td>Optional</td>
</tr>
<tr>
<td>Manager Name</td>
<td>A name for the aggregation or consolidation point for the virtual agent. Example: For ITA or DCS:SA forwarded environments, the manager name is the server name. The manager name is not considered unique. <strong>Note:</strong> For ITA forwarded events, the IP Address plus the Manager Name uniquely represent an agent within the ITA universe.</td>
<td>Optional</td>
</tr>
</tbody>
</table>
5 In the **New Virtual Agent** dialog box, configure the display properties, and then click **Finish**.

Operating System  The operating system of the source machine or system that originally processed the virtual events.

Description  A description of the virtual agent.

### Monitoring virtual agents through syslog aggregation

Most UNIX-flavored systems allow forwarding of syslog messages to remote systems. This mechanism can be used to monitor syslog events as virtual events on remote systems. This solution does not require the transfer of syslog files. It also allows the administrator to monitor logs as soon as they are forwarded.

The logs from the systems you want to monitor for systems or platforms that are not supported by DCS:SA must be sent to one or more nodes with the installed DCS:SA agent (DCS:SA Collector Node). The DCS:SA Collector Node acts as an aggregation point for syslog or other information you want to monitor.

You can configure a single DCS:SA server and a single supported DCS:SA agent to monitor syslog information that is aggregated from one or more unsupported systems.

A Linux collector node is used as an example. Any operating system that DCS:SA supports can be used as a **Collector Node**. Ensure that the network firewalls allow forwarding of syslog messages from the remote host to the collector node. You may need to adapt syslog daemon configurations instructions for both the DCS:SA collector node and the remote systems in your environment.

The steps in the following sections enable you to automatically create and register virtual agents for the unsupported systems being monitored by using the syslog collector.

See "Enabling automatic registration of virtual agents on the server" on page 111.
See “Updating the LocalAgent.ini file on the DCS:SA Collector Node” on page 112.
See “Configuring syslog forwarding on an unsupported system” on page 115.
See “Creating the virtual agent syslog policy” on page 117.

### Enabling automatic registration of virtual agents on the server

You must enable automatic registration of virtual agents on the server before updating the LocalAgent.ini file on the Collector Node.
To enable automatic registration of virtual agents on the server

1. In the DCS:SA management console, click Admin > Settings.
2. In the System Settings pane, select the Agent Settings tab.
3. In the Agent Settings tab, under the Virtual Agents section, check both the checkboxes.

See “Monitoring virtual agents through syslog aggregation” on page 111.
See “Updating the LocalAgent.ini file on the DCS:SA Collector Node” on page 112.
See “Configuring syslog forwarding on an unsupported system” on page 115.
See “Creating the virtual agent syslog policy” on page 117.

Updating the LocalAgent.ini file on the DCS:SA Collector Node

The local configuration file for the loghost agent must be modified so that the syslog collector can derive and route virtual agent events.

To update the LocalAgent.ini file on the DCS:SA Collector Node

1. For a default install, locate the LocalAgent.ini in the /opt/Symantec/sdcssagent/IDS/system directory.
2. To turn on the automatic derivation of virtual agents for the syslog collector, open the LocalAgent.ini file in an editor. Find the section with the following heading:

   [Syslog Collector]
3 Modify the line for the setting Derive Virtual Agents to turn on this feature. By default, the option is both turned off and commented. Therefore, you must remove the comment character from the beginning of the line and change the value of the setting from 0 to 1.

Following is the default values in the LocalAgent.ini file:

```ini
[Syslog Collector]
#Derive Virtual Agents=0
#Syslog Daemon=DEFAULT
#Syslog NG Source=sdcss_src
#Syslog NG Filter=sdcss_filter
```

Following is the LocalAgent.ini file after modification:

```ini
Derive Virtual Agents=1
#Syslog Daemon=DEFAULT
#Syslog NG Source=sdcss_src
#Syslog NG Filter=sdcss_filter
```

4 Save your changes and restart the IDS service on the agent.

For example:

On a Linux system, you can accomplish this task using the following service command:

```
[root@esxmb-rh63 system]#service sisidsagent restart
Stopping SDCSS IDS Agent (PID 8552)..
SDCSS IDS Agent stopped successfully after 5 seconds
SDCSS IDS Agent started successfully (PID 9313)
[root@esxmb-rh63 system]#
```

See “Monitoring virtual agents through syslog aggregation” on page 111.
See “Enabling automatic registration of virtual agents on the server” on page 111.
See “Configuring syslog forwarding on an unsupported system” on page 115.
See “Creating the virtual agent syslog policy” on page 117.

Configuring syslog aggregation on the DCS:SA Collector Node

After you enable automatic registration of virtual agents on the server and update the LocalAgent.ini file, you must configure syslog aggregation on the DCS:SA Collector Node. The following examples illustrate the steps to configure syslog
aggregation. For more information, refer the appropriate `rsyslogd man page` or the `syslogd man page`.

Example of syslog aggregation by using rsyslogd utility on Red Hat Enterprise Linux 6:

When you use the `rsyslogd(8)` utility, you must enable syslog aggregation. Uncomment the lines under `Provides UDP syslog reception` and `Provides TCP syslog reception` as follows:

```
####MODULES####

$ModLoad imuxsock  #provides support for local system logging
    (e.g. via logger command)
$ModLoad imklog   #provides kernel logging support
    (previously done by rklogd)
#$ModLoad immark  # provides --MARK-- message capability

Provides UDP syslog reception
$ModLoad imudp
$UDPServerRun 154

Provides TCP syslog reception
$ModLoad imtcp
$InputTCPServerRun 514

Restart the rsyslog daemon by using the following command:

[root@esxmdb-rh63 etc]# service rsyslog restart

Shutting down system logger: [OK]
Starting system logger: [OK]
[root@esxmdb-rh63 etc]#
```

Example of syslog aggregation by using syslogd utility on Red Hat Enterprise Linux 5 and earlier:

Enable remote syslog connections to this agent

Open the `/etc/sysconfig/syslog` file and add the `-r` option to the variable `SYSLOGD_OPTIONS` as follows:

```
[root@localhost~]#cat /etc/sysconfig/syslog
```

114 Managing assets
About virtual agents
# Options to syslogd
# -m 0 disables 'MARK' messages.
# -r enables logging from remote machines
# -x disables DNS lookups on messages received with -r
# See syslogd(8) for more details
SYSLOGD_OPTIONS="-m 0 -r"

# Options to klogd
# -2 prints all kernel oops messages twice; once for klogd to decode,
#   and once for processing with 'ksymoops'
# -x disables all klogd processing of oops messages entirely
# See klogd(8) for more details
KLOGD_OPTIONS="-x"

SYSLOG_UMASK=077
# set this to a umask value to use for all log files as in umask(1).
# By default, all permissions are removed for "group" and "other"
[root@localhost~]#

Restart the syslog service by using the following command:

[root@localhost~]# service syslog restart

Shutting down kernel logger: [ OK ]
Shutting down system logger: [ OK ]
Starting system logger: [ OK ]
Starting kernel logger: [ OK ]
[root@localhost~]#

See “Monitoring virtual agents through syslog aggregation” on page 111.
See “Enabling automatic registration of virtual agents on the server” on page 111.
See “Updating the LocalAgent.ini file on the DCS:SA Collector Node” on page 112.
See “Configuring syslog forwarding on an unsupported system” on page 115.
See “Creating the virtual agent syslog policy” on page 117.

Configuring syslog forwarding on an unsupported system

After configuring syslog aggregation on the DCS:SA Collector Node, you must configure the syslog daemon on the unsupported system to forward syslog entries to the loghost.

For example:
On a Linux system, configure the log forwarding by editing the `/etc/syslog.conf` file to add an entry that causes syslogd to send a copy of all messages to our loghost. Edit the syslog.conf file as follows by adding the following line and IP address of the loghost:

```
*.<Tab><Tab> @<IP address of loghost>
```

**Note:** The `syslog.conf` file uses Tab characters to delimit fields. For more information on file format, see the man page for syslogd(8).

```
[root@localhost ~]# cat /etc/syslog.conf
# Log all kernel messages to the console.
# Logging much else clutters up the screen.
#kern.* /dev/console
*.*   @

# Log anything (except mail) of level info or higher.
# Don't log private authentication messages!
*.info;mail.none;authpriv.none;cron.none /var/log/messages

# The authpriv file has restricted access.
.authpriv.* /var/log/secure

# Log all the mail messages in one place.
mail.* /var/log/maillog

# Log cron stuff
cron.* /var/log/cron

# Everybody gets emergency messages
*.emerg *

# Save news errors of level crit and higher in a special file.
uucp, news.crit /var/log/spooler

# Save boot messages also to boot.log
local7.* /var/log/boot.log
```

Restart the syslog service by using the following command:

```
[root@localhost ~]# service syslog restart
```

Shutting down kernel logger: [ OK ]
Shutting down system logger: [ OK ]
Starting system logger: [ OK ]
Starting kernel logger: [ OK ]
[root@localhost~]#

See “Monitoring virtual agents through syslog aggregation” on page 111.
See “Enabling automatic registration of virtual agents on the server” on page 111.
See “Updating the LocalAgent.ini file on the DCS:SA Collector Node” on page 112.
See “Creating the virtual agent syslog policy” on page 117.

Creating the virtual agent syslog policy

After configuring syslog forwarding on an unsupported system, you must create a policy with a custom rule for monitoring the syslog on your loghost.

The policy that is detailed in this section causes all events from the loghost to be sent to the DCS:SA server. This may be adequate for illustration. However, you may need to tune the policy to determine appropriate priority or to set event patterns to be ignored.

To create the virtual agent syslog policy

1. In the Detection tab, under Policies, create a copy of the Unix_Template_Policy.
   Provide any name to the policy and move it to an appropriate folder.
2. Edit the policy to add a custom rule, name the rule, and set the category to Syslog.
3. Click Finish.
4. Under the My Custom Rules section, open the Settings and select Syslog Rule Options.
   This step enables the rule.
5. Select OK to save the new rule.
6. Update the policy revision and apply it to the loghost agent.

Once the new policy is successfully applied, new syslog entries from remote, unsupported nodes should trigger the creation of new virtual agents in the server.
To see the agents in the DCS:SA console and examine their events

1. In the management console, go to **Assets > Network**.
2. In the left-hand pane, under the **Network Groups** section, select **Virtual Agents**.
3. In the **Network Assets** pane, select the virtual agent for which you want to see the events.

See “Monitoring virtual agents through syslog aggregation” on page 111.
See “Enabling automatic registration of virtual agents on the server” on page 111.
See “Updating the LocalAgent.ini file on the DCS:SA Collector Node” on page 112.
See “Configuring syslog forwarding on an unsupported system” on page 115.

### Modifying an agent name

When modifying the agent name, please note the following:

- An agent name must be between 1 and 128 characters in length.
- By default, the agent name is the host name of the agent computer. If you use the default agent name, and the host name changes, the agent name will also change.
- You can modify the agent name via the Name column on the Assets page (see the following procedure) or the **General** tab in agent properties. See “Viewing agent properties” on page 96.
- The agent name extends throughout the management console.
- Duplicate agent names (and host names) can occur.

**To modify an agent name**

1. In the management console, go to **Assets > Network**.
2. In the **Network Assets** pane, right-click an agent and then click **Rename**.

### Applying a policy to an agent or policy group

You apply a policy to an agent directly or through a policy group. When you apply a policy to a policy group, the management server determines which agents in that group use the group's policy and then flags those agents for pending policy updates.

You should consider the following information before applying policies to agents:
The **Set Policy Wizard** shows the policies that match the agent's operating system type and have a minimum agent version equal to or lower than the agent's version.

The **Set Policy Wizard** also shows UNIX policies. You can apply UNIX policies to any non-Windows agent. When a UNIX prevention policy is applied to a group with an OS-specific policy, the agent uses the OS-specific policy unless the UNIX policy uses a higher minimum agent version.

Review the policy option settings before applying a policy.

Checking the Disable Prevention box in the Set Policy Wizard automatically checks the global Disable Prevention option in the policy option tree.

When applying a new policy, apply it to a small set of agents and then verify that the agent computers are functioning properly with the applied policy.

In the Detection view, you can apply multiple detection policies to agents and policy groups. If you apply detection policies to any of the default OS-specific policy groups, the policies are automatically applied to an agent when the agent registers with the management server.

### To apply a policy to an agent or policy group

1. In the management console, click **Assets**.
2. Under the Assets tab, click **Prevention** or **Detection**.
3. On the Assets page, select an agent or policy group, and then right-click **Apply Policy**.
4. In the **Set Policy Wizard** dialog box, select the policy that you want to apply to the agent or policy group, and then click **Next**.
   
   Double-click the **Symantec** folder to list the Symantec policies.
   
   If applying a policy directly to an agent, the operating system is selected for you. If applying a policy to a group, select the operating system, and then select the policy.
   
   To select multiple detection policies, hold down the Shift or Ctrl key while selecting the policies.
5. If the agent or group already has a policy (other than the Null policy) applied to it, in the **Set Policy Wizard** dialog box, select the merge option, and then click **Next**.
6. (Optional) If you want to edit the policy options before applying the policy, in the **Set Policy Wizard** dialog box, click **Edit Policy**.
7 In the **Set Policy Wizard** dialog box, review the policy summary, and then click **Finish** to apply the policy to the agent or agent group that you selected.

8 In the management console, click **Refresh** to apply the agent updates.

**About merging policy options**

DCS:SA prompts you to select a merge option if you are applying a policy to an agent or policy group that already has a policy, and the policies have the same agent version and operating system.

You are prompted to select a merge option in the following situations:

- When updating a workspace policy with a library policy
- When applying a library policy to an agent or policy group that already has a policy
- When applying a workspace policy to an agent or policy group that already has a policy
- When using the Copy Options command to merge the option settings from two workspace policies

In these situations, you must select one of the following merge options:

<table>
<thead>
<tr>
<th>Merge option settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain current option settings</td>
<td>Keep the current policy's option settings. This option uses the current policy settings and ignores the new policy.</td>
</tr>
<tr>
<td>Merge the changed options</td>
<td>Merge all changes in the current policy with the option settings in the new policy. Preference is given to the new policy when an option in both policies has changed or neither option has changed. In most cases, you will select this option. It gives you the best of both policies. All changes from the base in the current policy are retained. All other option settings are taken from the new policy.</td>
</tr>
<tr>
<td>Take the new option settings</td>
<td>Discard the current policy's option settings and apply the new policy's option settings. This option ignores the current policy and uses the new policy settings.</td>
</tr>
</tbody>
</table>
Managing applied policies

You can edit, save, and clear policies that are applied to an agent or policy group.

Editing a policy applied to an agent or group

You can edit policies applied to agents or policy groups. When you edit policies applied to a policy group, the management server determines which agents in that group use the group's policy and then flags those agents for pending policy updates.

Your policy option changes affect only the selected agent or policy group. The changes do not affect the workspace policy.

To edit a policy applied to an agent or group

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. On the Assets page, select an agent or policy group, and then right-click **Edit Policy**.

   If you are editing a policy that is applied to a group, select the policy, and then click **OK**.

4. In the policy dialog, configure the policy options.
5. Click **OK** to save your changes.
6. Click **View > Refresh** to apply the agent updates.

Saving a policy applied to an agent or group

You use the Save Applied Policy command to save an applied policy as a workspace policy. The workspace policy is saved in a user-specified workspace folder, using the same name and revision as the applied policy. If a policy with the same name already exists, a number is appended to the workspace policy name.

To save a policy applied to an agent or group

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**
3. On the Assets page, select an agent or policy group, and then right-click **Save Applied Policy**.
4. In the **Save Policy** dialog box, select a policy to save.
5. In the **Save Policy** dialog box, select a destination folder.
6. Click **OK**.
Clearing a policy applied to an agent or group

You can clear policies that are applied to agents and policy groups.

When clearing policies, you should note the following:

■ When you clear a policy that is applied to a policy group, the policy is deleted from the group. The management server determines which agents in the group (or the group’s descendants) use the group’s policy and then flags those agents for pending policy updates.

■ (Prevention policies) If any of the agents in a group cannot find a compatible policy, the clear policy request is denied.

■ (Prevention policies) If a request to clear a policy is denied because a compatible policy cannot be found, replace the policy that you want to clear by applying another policy.

See “Applying a policy to an agent or policy group” on page 118.

To clear a policy applied to an agent or group

1 In the management console, click Assets.
2 Under the Assets tab, click Prevention or Detection.
3 On the Assets page, select an agent or group, and then right-click Clear Policy.
4 In the Clear Policy dialog box, select the policy that you want to clear, and then click OK.
5 Click Refresh to apply the agent updates.

Applying a configuration to an agent or configuration group

You apply a configuration to an agent directly or through a configuration group.

When you apply a configuration to a group, the management server determines which agents in that group use the group’s configuration and then flags those agents for pending configuration updates.

To apply a configuration to an agent or configuration group

1 In the management console, click Assets.
2 Under the Assets tab, click Prevention or Detection.
3 On the Assets page, select an agent or group, and then right-click Apply Config.
4  In the **Apply Config Wizard** dialog box, select a configuration, and then click **Finish**.

   Double-click the **Symantec** folder to list the Symantec configurations.

5  Click **Refresh** to apply the agent updates.

### Managing applied configurations

You can view and clear configurations that are applied to agents and configuration groups.

#### Viewing a configuration applied to an agent or group

You can view details about the configurations that are applied to agents and configuration groups.

**To view a configuration applied to an agent or group**

1  In the management console, click **Assets**.

2  Under the **Assets** tab, click **Prevention** or **Detection**.

3  On the Assets page, select an agent or group, and then right-click **View Config**.

4  In the **View Config** dialog box, select a configuration, and then click **OK** to view the configuration.

5  In the configuration dialog box, click **OK**.

### Clearing a configuration applied to an agent or group

You can clear configurations that are applied to agents and configuration groups. When clearing a configuration, you should note the following:

- When you clear a configuration that is applied to a configuration group, the configuration is deleted from the group. The management server determines which agents in the group (or the group’s descendants) use the group’s configuration and then flags those agents for pending configuration updates.

- Each configuration type has its own group hierarchy. Each agent must be able to find a configuration object, either applied directly to it or from the group hierarchy.

- If a request to clear a configuration is denied because a compatible configuration of the same type cannot be found, replace the configuration that you want to clear by applying another configuration of the same type.
To clear a configuration applied to an agent or group

1. In the management console, click **Assets**.
2. Under the **Assets** tab, click **Prevention** or **Detection**.
3. On the Assets page, select an agent or configuration group, and then right-click **Clear Config**.
4. Click **Refresh** to apply the agent updates.

Viewing the agents that have generated the highest number of events

The DCS:SA console lets you view the agents that report the highest number of events. You can group the agents by using the **Group Details** filter that is present in the left-hand pane on the management console. The various other filters that you can use to group the DCS:SA agents are as follows:

- Process name
- Process set
- Agent name/SVA VM Name
- Resource
- Guest VM MOID
- Event type
- Disposition
- Rule name
- Policy name

To view the agents that have generated the highest number of events

1. In the DCS:SA management console, go to **Assets > Prevention** if you want to view the agents that have the prevention policies applied.
   
   Or,
   
   In the DCS:SA management console, go to **Assets > Detection** if you want to view the agents that have the detection policies applied.

2. In the left-hand pane, in the **Group By** section, click **Agent Name**.
   
   In the assets pane, you can see the agents that have generated the highest number of events at the top of the list.
Deleting an agent

You can delete agents in the Network view and the Detection view.

Deleting an agent in the Network view

When you delete an agent in the Network view, the agent's record in the management server database is deleted. Deleting an agent in the Network View automatically removes the agent from all hierarchies in the Prevention view and the Detection view.

If the agent software is not removed from the agent computer, the agent automatically re-registers with the management server during the agent's next polling interval. During re-registration, the policies that were applied to the agent before it was deleted are re-applied.

To delete an agent in the Network view

1. In the management console, click Assets.
2. Under the Assets tab, click Network.
3. On the Assets page, select an agent, and then right-click Delete.
4. In the Confirm Deletion dialog box, click Yes to delete the agent.
5. Uninstall the agent software from the agent computer.
6. In the management console, click Refresh to apply the agent updates.

Deleting an agent in the Detection view

You can delete an agent from a detection policy group, as long as the agent resides in at least one other detection policy group.

You cannot delete an agent from a configuration group. Every agent resides in exactly one configuration group at all times.

To delete an agent in the Detection view

1. In the management console, click Assets.
2. Under the Assets tab, click Detection.
3. On the Assets page, navigate to and select the agent, and then right-click Delete.
4. In the Confirm Deletion dialog box, click Yes to delete the agent.
5. Click Refresh to apply the agent updates.
Managing policies

This chapter includes the following topics:

- About policies
- About policy viewer
- Viewing the Policies page
- Creating a prevention policy
- Creating a detection policy
- Creating default policies from an installed policy pack
- Publishing or unpublishing a policy
- Configuring the Domain Controller settings in a policy
- Controlling custom sandboxes in prevention policies
- Changing the sandbox for multiple events
- Allowing a program to run by using the Protected Whitelisting strategy
- About importing a large set of values for a parameter
- Adding group tags to custom sandboxes
- Applying and reapplying policies
- Viewing policy properties
- Creating a policy folder
- Editing a policy
- Copying policy options
About policies

Symantec Data Center Security: Server Advanced uses the following types of policies:

Prevention policies  The prevention policies confine each process on a computer to its normal behavior. Programs that are identified as critical to system operation are given specific behavior controls, while generic behavior controls provide compatibility for other services and applications.


Detection policies  Detection policies monitor events and syslogs, and report anomalous behavior. Features include sophisticated policy-based auditing and monitoring; log consolidation for easy search, archival, and retrieval; advanced event analysis and response capabilities; and file and registry protection and monitoring.

Policies have options that let you configure a policy for assignment to a target computer. Policy options comprise a simplified set of controls that you can use to enable or disable features in a policy. Some options have parameters, which let you customize the behavior of the option.

See “Creating a prevention policy” on page 131.

See “Creating a detection policy” on page 135.

About the Symantec policy library

Symantec Data Center Security: Server Advanced is packaged with pre-configured prevention and detection policies, which are stored in the policy library, in the Symantec folder. The policies are read-only and cannot be modified or deleted.

The policy library may also contain custom policies that you authored, as well as policies from third-party policy developers.

About policy viewer

The policy viewer enables you to search policies through the management console. However, you cannot make changes to the policies in the policy viewer. After you search for policies, you can export the data in the Policy Summary section to a CSV, HTML or PDF file.

The policy viewer enables you to search for a policy based on Policy ID, PolicyName, and GroupName. You can arrive at a specific policy search result with the help of search filters. These search filters are Os Type, Category, Instance, Status, Time Frame, Version, and Resource Type. In addition, you can select the display attributes to control the display of search results in the Policy Summary section. These display attributes are Data Detail, Content Display, Content Hidden, Symbol, Header, Footer, and Indent Style.

The Policy Summary section displays the search results based on the search filters and the display attributes.

The SQL section displays the SQL stored procedure for all search attributes that you have selected.

Note: The policy viewer displays only primary policies. It does not display the custom policies that you have added.

See “Searching for policies in the policy viewer” on page 160.

See “Policy viewer search filters” on page 161.
Viewing the Policies page

You use the Policies page in the management console to manage the policies that agents enforce on your computers.

You can do the following activities from the Policies page:

- Create and edit policies
- Apply and reapply policies to agents and policy groups
- View policy properties
- Create folders to organize your policies
- Reset policy options
- Rename, copy, and delete policies
- Apply revisions to the Symantec policies
- Updated policy, copy options, and custom controls
- Import and export policies

To obtain an overview of prevention policies or detection policies, view policies in the Prevention view or Detection view. To obtain an overview of all your policies, view policies in the Master view.

To view the Policies page

1. In the management console, click **Policies**.
2. On the Policies page, in the Policies tree, click the **Symantec** folder to list the DCS:SA policies.
3  (Optional) To expand or restrict the list of policies, in the Filters tree pane, select one of the following filters:

- **All Policies**: Filter that displays all prevention or detection policies.
- **Windows Policies**: Filter that displays the Windows prevention or detection policies.
- **Solaris Policies**: Filter that displays the Solaris prevention or detection policies.
- **Linux Policies**: Filter that displays the Linux prevention or detection policies.
- **AIX Policies**: Filter that displays the AIX detection policies.
- **HP-UX Policies**: Filter that displays the HP-UX detection policies.
- **UNIX policies**: Filter that displays the unified UNIX detection policies.

4  (Optional) To expand or collapse the panes in the Policies page, click the size arrows.

**About the policy workspace**

The policy workspace lists the policies that agents enforce on your computers. The policy workspace is located on the right side of the Policies page. Upon installation of Symantec Data Center Security: Server Advanced, the policy workspace is populated with the predefined DCS:SA policies.

You can populate your policy workspace with the following policies:

- Policies that you created using the predefined policies as a baseline
- Policies that you obtained from third-party policy developers

The policy workspace comprises the following information:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. Agent</td>
<td>The minimum agent version needed to support a policy. Every Symantec policy is assigned a version number and a revision number. The version number refers to the minimum agent version needed to support a policy. The policy can only be applied to agents of this version or higher. Symantec uses the revision number to track changes to a policy.</td>
</tr>
<tr>
<td>Rev</td>
<td>The policy revision number used to track changes to a policy.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the predefined policy. Policies that were changed from the baseline settings are marked with a blue asterisk (*).</td>
</tr>
</tbody>
</table>
Creating a prevention policy

Use the New Prevention Policy Builder wizard to create a master prevention policy or a custom prevention policy that is based on an existing prevention policy.


To create a master prevention policy

1. In the management console, go to Policies > Prevention.
2. In the Prevention Policies pane, click Add.
3. In the Select a Prevention Policy Builder wizard, click Launch against Policy Builder.
4. In the Policy Name panel, from the Policy Pack drop-down list, select the policy pack that you want to use as the baseline for the new policy.
5. In the Name text box, enter a name for the policy that you create, and then click Next.
6. In the Protection Strategy panel, use the slider to select any of the strategies.

The Protection Strategy panel lets you select any of the following protection strategies:

- **Protected Whitelisting**: Lets you opt for a security posture that denies access to all applications that are not listed.
- **Hardened**: Lets you opt for a security posture that allows behavior control for known applications as defined by Symantec.
- **Basic**: Lets you opt for a security posture that allows basic protection for all applications that are not configured in the policy.

7. In the Trusted Updaters panel, click Add and then do the following in the given order:

   - In the Select Type dialog box, select the updater from the following list and then click Next.
     - Predefined applications
     - Applications that you want add newly.
■ Users.
■ Groups.
■ Directories.
■ Publishers.

Note: The list of predefined applications is populated through the agent data retriever. You can edit or delete an updater that you have already added to the list.

■ In the relevant panel that displays after you click Next, provide the necessary information and then click Add.
■ In the Trusted Updaters panel, click Next.

8 In the Application Rules panel, click Add, and then do the following in the given order:
■ In the Select Type dialog box, select the type of the application from the following list and then click Next.
  ■ Predefined applications
  ■ Application.
  ■ User.
  ■ Group.
  ■ Directory.
  ■ Publisher.

Note: The list of predefined applications is populated through the agent data retriever. You can edit or delete an updater that you have already added to the list.

You can edit or delete a rule that you have already added to the list.
■ In the relevant panel that displays after you click Next, provide the necessary information and then click Add.
■ In the Application Rules panel, click Next.

9 In the Policy Quick Links panel, click Configure against the following quick links that are provided, configure the required settings and then click Next.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prevention Mode</td>
<td>Lets you change the state of the prevention policy.</td>
</tr>
<tr>
<td>Network Perimeter</td>
<td>Lets you define the inbound and outbound network perimeter for the selected policy by using the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Globally set the default inbound rules to deny.</td>
</tr>
<tr>
<td></td>
<td>■ Inbound hosts list.</td>
</tr>
<tr>
<td></td>
<td>■ Globally set the default outbound rules to deny.</td>
</tr>
<tr>
<td></td>
<td>■ Outbound hosts list.</td>
</tr>
<tr>
<td>Policy Override</td>
<td>Lets you specify the users who are allowed to disable prevention by using the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Allow all users to disable prevention completely.</td>
</tr>
<tr>
<td></td>
<td>■ Allow specific users to disable prevention completely.</td>
</tr>
<tr>
<td></td>
<td>■ Allow specific groups to disable prevention completely.</td>
</tr>
<tr>
<td>Agent Tools And Programs</td>
<td>Lets you configure global access control rules for agent tools by using the following options:</td>
</tr>
<tr>
<td></td>
<td><strong>Config tools</strong> tab</td>
</tr>
<tr>
<td></td>
<td>■ Allow SDCSS configuration tools to run with full privileges for specific users</td>
</tr>
<tr>
<td></td>
<td>■ Allow SDCSS configuration tools to run with full privileges for specific groups</td>
</tr>
<tr>
<td></td>
<td><strong>Event Viewer</strong></td>
</tr>
<tr>
<td></td>
<td>■ Allow all users to run the SDCSS Agent Event Viewer</td>
</tr>
<tr>
<td></td>
<td>■ Allow specific users to run the SDCSS Agent Event Viewer</td>
</tr>
<tr>
<td></td>
<td>■ Allow specific groups to run the SDCSS Agent Event Viewer</td>
</tr>
</tbody>
</table>

1. In the **Summary** panel, click **Save**.
To create a custom prevention policy

1. In the management console, go to Policies > Prevention.
2. In the Prevention Policies pane, click Add.
3. In the Select a Prevention Policy Builder wizard, click Launch against Custom Policy Builder.
4. In the Policy Name panel, from the Policy Pack drop-down list, select the policy pack that you want to use as the baseline for the new custom policy.
5. In the Name text box, enter a name for the policy that you create, and then click Next.
6. In the Application Rules panel, click Add, and then do the following in the given order:
   - In the Select Type dialog box, select the type of the application from the following list and then click Next.
     - Predefined applications
     - Application
     - User
     - Group
     - Directory
     - Publisher

   **Note:** The list of predefined applications is populated through the agent data retriever. You can edit or delete an updater that you have already added to the list.

   You can edit or delete a rule that you have already added to the list.

   - In the relevant panel that displays after you click Next, provide the necessary information and then click Add.
   - In the Application Rules panel, click Next.
7. In the Summary panel, click Save.

See “Creating a detection policy” on page 135.
See “Editing a policy” on page 149.
See “Copying a policy” on page 152.
See “Deleting a policy” on page 153.
Creating a detection policy

Detection policies monitor events and syslogs, and report anomalous behavior.


You use the New Detection Policy Builder wizard to create the detection policies.

To create a detection policy

1. In the management console, go to Policies > Detection.
2. In the policy pane, click Add.
3. In the New Policy wizard, in the Select a starting policy panel, do the following:
   - In the Name text box, enter the name of the new policy that you want to create.
   - From the Operating System drop-down list, select the operating system for which you are creating the new policy.
   - From the Policy Pack drop-down list, select the policy pack. The details section displays the policies that the selected policy pack contains.
   - From the policy details section, select a policy that you want to use as the base for the new policy and then click Next.
4. In the Set Policy Summary panel, click Edit Policy if you want to make modifications in the policy.
5. In the Adjust your policy settings dialog box, make the required changes and then click OK.
6. In the New Policy wizard, click Finish.

See “Creating a prevention policy” on page 131.
See “Editing a policy” on page 149.
See “Copying a policy” on page 152.
See “Deleting a policy” on page 153.
See “Applying and reapplying policies” on page 146.
See “Importing and exporting policies” on page 154.
Creating default policies from an installed policy pack

You can create default policies from all the compiled policies in an installed DCS:SA policy pack. The policies are created in a folder of your choice.

Before using these instructions, you must download the latest DCS:SA policy packs.

To create default policies from an installed policy pack

1. In the management console, click Policies.
2. Under the Policies tab, Prevention or Detection.
3. On the Policies page, select a folder in which to store the default policies, and then right-click Create Default.
4. In the Create Default Policies dialog box, select an installed DCS:SA policy pack.
5. Click Create.

Publishing or unpublishing a policy

After you create a policy, you must publish the policy so that all users can use the policy. You can unpublish a policy if you do not want the policy to be used. You may want to unpublish a policy if you want to modify its content.

Only an administrator or an operator can publish or unpublish a policy.

To publish or unpublish a policy

1. In the management console, go to Policies > Prevention or Policies > Detection.
2. In the Policies workspace, select a policy and then click Publish.
3. Select a policy that is already in the published state and click Unpublish to unpublish the policy.

An unpublished policy cannot be used.

Configuring the Domain Controller settings in a policy

The Domain Controller Settings section let you harden the security posture of the domain controllers in your environment.
To go to the Domain Controller Settings

1 On the prevention policies page, select a policy and then click **Edit**.
2 Click **Advanced**, and then click **Global Policy Options**.

   The **Domain Controller Settings** are under the **General Settings** section.

You configure the **Domain Controller Settings** in the policy that you want to apply on the agent that is installed on a domain controller machine. The security configurations that you make in a policy let you control user rights to access or modify existing data on a domain controller.

Following are the areas that you can strengthen for data protection on a domain controller:

- **File data**
  - Lets you specify the files on the Domain Controller that you do not want any user to access or modify.

- **Registry keys data**
  - Lets you specify the registry keys on the Domain Controller that you do not want any user to access or modify.

- **Process data**
  - Lets you specify the processes on the Domain Controller that you do not want any user to access or modify.

The domain controller settings are applied on the computers thru the prevention policies. If you have multiple domain controllers that need different security hardening strategies, then you must configure different policies as appropriate and apply them on the relevant domain controllers.

**Controlling custom sandboxes in prevention policies**

The prevention policy editor includes a feature called **My Custom Sandboxes and Lists**.

Custom sandboxes are defined based on the existing sandboxes, where you can add or edit sandbox rules. You can use custom sandboxes while defining an application rule where you can add the application in a newly created custom sandbox.
Table 4-1  My Custom Sandboxes and Lists options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable prevention - log but don’t prevent policy violations</td>
<td>Disables prevention of policy violations by programs in the custom group.</td>
</tr>
<tr>
<td>Enable logging of trivial policy violations</td>
<td>Logs all policy violations by programs in the custom group.</td>
</tr>
<tr>
<td>Block modifications to executable files</td>
<td>Prevents programs in the custom group from modifying executables files on disk.</td>
</tr>
<tr>
<td>Block modifications to startup folders</td>
<td>Prevents programs in the custom group from modifying the contents of startup folders.</td>
</tr>
<tr>
<td>Block registration of COM and ActiveX controls</td>
<td>Prevents COM objects and ActiveX controls from registering as an in-process server for programs in the custom group.</td>
</tr>
<tr>
<td>Enable buffer overflow detection</td>
<td>Enables buffer overflow detection for programs in the custom group.</td>
</tr>
<tr>
<td>Enable thread injection detection</td>
<td>Enables thread injection detection for programs in the custom group.</td>
</tr>
<tr>
<td>Resource lists</td>
<td>Defines file access for programs in the custom group.</td>
</tr>
<tr>
<td>Network controls</td>
<td>Controls network access for programs in the custom group.</td>
</tr>
<tr>
<td>SysCall options</td>
<td>Controls privileged system calls made by programs in the custom group.</td>
</tr>
<tr>
<td>Process logging options</td>
<td>Controls process logging by programs in the custom group.</td>
</tr>
</tbody>
</table>

To control custom sandboxes in prevention policies

1. In the management console, click Policies.
2. Under the Policies tab, click Prevention.
3. On the Policies page, double-click a selected prevention policy.
4. In the policy editor dialog box, under Policy Settings, click My Custom Sandboxes and Lists, and then click Add a new Custom Control icon.
5 In the **New Custom Control Wizard** dialog box, specify the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Type a descriptive name for the custom options. This text appears in the management console, in the policy editor dialog, under My Custom Sandboxes and Lists.</td>
</tr>
<tr>
<td>Category</td>
<td>Select a program type.</td>
</tr>
<tr>
<td>Identifier</td>
<td>Type a name to identify the custom options. The identifier must not include spaces or special characters. The identifier is used to create the process set name, which uses the format cust_identifier_ps.</td>
</tr>
<tr>
<td>Group Tags</td>
<td>Type a Group Tag name. You can associate a single group tag or multiple group tags with custom sandboxes. You can specify multiple group tags as comma separated values. For example, GRPTAG1, GRPTAG2, GRPTAG3 and so on.</td>
</tr>
<tr>
<td>Description</td>
<td>Type a full description of the program that is controlled by the custom options.</td>
</tr>
</tbody>
</table>

6 Click **Finish**.

7 In the policy editor dialog box, under My Custom Sandboxes and Lists, click **Edit** icon next to the custom sandbox to view the policy options.

8 In the policy editor dialog box, check or uncheck the required policy options under **General Settings**, **Network Controls**, **File Rules**, and **Registry Rules**.

9 Click **OK** to save the policy changes,

### Changing the sandbox for multiple events

The existing functionality to change the strategies for a single event has been enhanced to include multiple events and change their current strategies. You can use this feature to suppress the events that you do not want to be generated by modifying the sandboxes.

You use the **Event Wizard** to change a sandbox. You can launch the Event Wizard from any of the following workspaces:

- **Monitors > Events**.
- **Recent Events** tab under **Assets > Prevention**, **Assets > Detection**, or **Assets > Network**.
To change the sandbox for multiple events

1. Select a group of events for which you want to change the sandbox and then select **Event Wizard**.

   You can use the **Group By** filter to group events based on the available category.

2. In the **Event Grouping** panel, use the **Group the selected events by** drop-down list to sort the events, and then click **Next**.

3. In the **Select policies to modify** panel, select the policy and then click **Next**.

4. On the next panel, do the following and then click **Next**:
   - In the **Strategies** tab, right-click the sandbox that you want to change and click **Change the Sandbox**.

   **Note:** The **Change the Sandbox** option is available only for the strategies that act on sandboxes.

   - In the **Select a Sandbox To Apply Strategy On** box, select one or more sandboxes that you want to apply and then click **OK**.
     The **Select a Sandbox To Apply Strategy On** box displays the sandboxes that the selected policy includes. The **Custom Sandboxes** panel is visible only if the selected policy has any custom programs defined in it.

   - In the **Actions** tab, click **Next**.

5. In the **Select a config** panel, select the configurations that you want to apply and then click **Next**.

   You either update a policy or a config. This depends on the strategy that you have selected to change the sandbox.

6. In the **Apply the config changes** panel, click **Update**, and then click **Submit**.

   In the **Submit Changes** box, you may optionally enter a brief description about the changes that you made.

7. Click **Finish** to complete the procedure of updating the sandboxes.

After the changes are made, go to the **Prevention Policies** workspace and double-click the policy to launch the **Adjust your policy settings** page. In the **Adjust your policy settings** page, under **Policy Changes and Summary**, click **Changes from base** view the updated settings.
Allowing a program to run by using the Protected Whitelisting strategy

The Protected Whitelisting strategy lets you specify an application that you always want to allow access or permission to run. When you whitelist a process or an application, all the other processes and applications that are not included in the list are denied access.

To allow a program to run by using the Protected Whitelisting strategy

1. In the management console, click the Policies tab and then click Prevention.
2. In the Policies workspace, click Add.
4. In the Policy Name panel, from the Policy Pack drop-down list, select the policy pack that you want to use as the baseline for the new custom policy.
5. In the Name text box, enter a name for the policy that you create.
6. Check Create a custom prevention policy, and then click Next.
7. In the Protection Strategy panel, use the slider to select Protected Whitelisting.
8. In the Trusted Updaters panel, click Add, and then in the Select Type dialog box, select the type of updater that you want to add.

The Trusted Updaters list is populated through the agent data retriever. You can edit or delete an updater that you have already added to the list.
9. Click Next.
10. In the Application Rules panel, click Add, and then in the Select Type dialog box, select the type of rules that you want to add.

You can edit or delete a rule that you have already added to the list.
11. In the Global Policy Options panel, click Configure to configure the global policy settings, and then click Next.
12. In the Summary panel, click Save.

About importing a large set of values for a parameter

The Symantec Data Center Security: Server Advanced Policy Editor lets you import a large set of values for a parameter in the DCS:SA policy. For example, suppose that you want to create a network rule that blocks all incoming connections from a
set of IP addresses. In this case, you can create a set of values for the IP address parameter in a comma-separated value (CSV) format. You can then import the file that contains the value set into the DCS:SA policy. After you import the CSV file, the parameter values are populated at the top of the existing list of parameter values.

To import a set of parameter values, use Microsoft Excel or any application that supports the CSV format to create a CSV file. When you import parameter values, you can either add new parameter values to the existing list of parameter values or you can replace the existing list.

By default, the Policy Editor ignores the duplicate parameter values. However, if you type a parameter value that already exists in the list, DCS:SA displays an error message.

Also, you can export an existing list of parameter values in the DCS:SA policy in the CSV file format.

### About creating an input comma-separated value file

The input comma-separated value (CSV) file contains parameter values in a comma-separated format. Each parameter type has its own format that includes the data fields in the corresponding parameter type. The first line in the CSV file contains a comma-separated list of column headers.

<table>
<thead>
<tr>
<th>Parameter type</th>
<th>Column headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>String-value, rule-name, comment</td>
</tr>
<tr>
<td>stringlist</td>
<td>String-value, rule-name, comment</td>
</tr>
<tr>
<td>processlist</td>
<td>program, command-line, id, group-id, rule-name, comment</td>
</tr>
<tr>
<td>processesnocmdlist</td>
<td>program, id, group-id, rule-name, comment</td>
</tr>
<tr>
<td>resourcelist</td>
<td>String-value , program, command-line, id, group-id, rule-name, comment</td>
</tr>
<tr>
<td>networklist</td>
<td>Action, protocol, local-port, remote-ip, remote-port, log, rule-name, comment</td>
</tr>
<tr>
<td>networkprocesslist</td>
<td>Action, protocol, local-port, remote-ip, remote-port, log, program, command-line, id, group-id, rule-name, comment</td>
</tr>
<tr>
<td>datetimevalue</td>
<td>date, time-zone, rule-name, comment</td>
</tr>
<tr>
<td>Datetimeduration</td>
<td>duration, rule-name, comment</td>
</tr>
</tbody>
</table>
Table 4-2  List of parameter types, column headers, and the parameter value format. *(continued)*

<table>
<thead>
<tr>
<th>Parameter type</th>
<th>Column headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>date</td>
<td>timerepeat</td>
</tr>
</tbody>
</table>

In the CSV file, each row should contain one value set of the parameter. Each row includes the components of the parameter, such as protocol, action, local port, remote port, remote IP address.

For example, if you import a CSV file that contains values for Network Rules parameter, the CSV file looks like:

| action, protocol, Local-port, remote-ip, remote-port, log, rule-name, comment |
| net_action_choice_allow, net_protocol_choice_tcp, %iis_accept_tcp_list%, %iis_netaccept_addr_list%, net_log_choice_none, rul1, Symantec default |

**Importing an input CSV file**

**To import an input CSV file**

1. In the management console, click Policies.
2. Under the Policies tab, click Prevention.
4. In the Adjust Policy Settings dialog box, under Resource Lists, click Network Rules.
5. In the Network Rules panel, click the Inbound Rules tab.
6. Under Kernel Driver Options [kernel_ps], click Edit [+] , and then click Network Controls.
7. In the Network Controls > Inbound Components or Network Controls > Outbound Components, click Edit [+] .
8. Click Import.
9. In the Import dialog box, select the CSV file to import and then click Import.
Exporting the parameter values into a CSV file

To export the parameter values into a CSV file

1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention**.
3. On the **Policies** page, in the **Symantec** folder, edit any of the predefined Windows prevention policies.
4. In the **Adjust Policy Settings** dialog box, under **Resource Lists**, click **Network Rules**.
5. In the **Network Rules** panel, click the **Inbound Rules** tab.
6. Under **Kernel Driver Options [kernel_ps]**, click **Edit [+]**, and then click **Network Controls**.
7. In the **Network Controls > Inbound Components** or **Network Controls > Outbound Components**, click **Edit [+]**
8. Click **Import**.
9. In the **Export** dialog box, select the CSV file to import and then click **Import**.

Adding group tags to custom sandboxes

You can organize custom sandboxes by grouping them in folders. To do so, in the **Policy Editor** dialog box, you can assign a group tag to each custom control. However, a custom sandbox can have zero or more group tags associated with it. You can also select a single or multiple custom controls in the **Policy Editor** dialog box and group them in a single or multiple folders.

A custom sandbox without a group tag is grouped under the **Default** folder. The **Group Tags** tab in the **Policy Editor** dialog box displays a list of all the custom sandboxes that are grouped together by their group tags.

To add group tags to custom sandboxes

1. In the management console, go to **Policies > Prevention**.
2. In the policies pane, select a policy and then click **Edit**.
3. In the **Adjust the policy settings** page, click **Advanced**.
4. In the **Advanced Policy Settings** group, click **My Custom Sandboxes and Lists**.
5. In **My Custom Sandboxes and Lists**, click the **Programs** tab.
6. Click on the plus (+) sign to add a new custom sandbox.
In the **New Custom Control Wizard**, perform the following actions:

| **Display Name** | Type a descriptive name for the custom options. This text appears in the management console, in the **Policy Editor** dialog box, under **My Custom Sandboxes and Lists**. |
| **Category** | Select a program type. |
| **Identifier** | Type a name to identify the custom options. The identifier cannot include spaces or special characters. The identifier is used to create the process set name, which uses the format `cust_identifier_ps`. |
| **Group Tags** | Type a Group Tag name. You can associate a single group tag or multiple group tags with custom sandboxes. You can specify multiple group tags as comma-separated values. For example, you could use `GRPTAG1, GRPTAG2, GRPTAG3` and so on. The **Group Tags** tab displays all the group tags with their associated custom sandboxes. |
| **Description** | Type a full description of the program that is controlled by the custom options. |

Click **Finish**.

### Searching for custom sandboxes by group tags

You can search for a custom sandbox by its group tag.

**To search for custom sandboxes by group tags**

1. In the management console, go to **Policies > Prevention**.
2. In the policies pane, select a policy and then click **Edit**.
3. In the **Adjust the policy settings** page, click **Advanced**.
4. In the **Advanced Policy Settings** group, click **My Custom Sandboxes and Lists**.
5. In the top-right search box, type a group tag name and press **Enter**.

### Modifying an existing group tag

You can modify an existing group tag in the **Group Tags** tab of the **Policy Editor** dialog box.
To modify an existing group tag
1. In the management console, go to Policies > Prevention.
2. In the policies pane, select a policy and then click Edit.
3. In the Adjust the policy settings page, click Advanced.
4. In the Advanced Policy Settings group, click My Custom Sandboxes and Lists.
5. In My Custom Sandboxes and Lists, click the Group Tags tab, check the box beside the custom sandbox that you want to edit.
6. Click the Add group tags to selected Custom Controls icon.
7. In the Add Group Tags dialog box, type a new group tag name for the selected custom sandbox.

Applying and reapplying policies

You use the Apply Policy command to apply a policy to agents and policy groups that do not currently enforce the policy.

You use the Reapply Policy command to reapply a policy to agents and policy groups that currently enforce the policy. The Reapply Policy command is useful when you need to reapply a policy that was modified.

After you apply or reapply a prevention policy to a target computer, you should verify the operation of the computer.

See “Verifying prevention policies” on page 157.

Applying a policy to an agent or group

When applying a policy, you are prompted to select the agents and policy groups that will enforce the policy.

To apply a policy to an agent or group
1. In the management console, click Policies.
2. Under the Policies tab, click Prevention or Detection.
3. On the Policies page, select a policy to apply, and then right-click Apply Policy.
   To select multiple policies, hold down the Shift or Ctrl key while selecting the policies.
4 In the **Apply Policy** dialog box, select the agents and policy groups, and then click **Apply**.

To select multiple agents and agent groups, hold down the Ctrl key while making your selection.

5 In the management console, click **Refresh** to update the management console page.

Refreshing the page lets you confirm that the agents successfully processed the policy changes.

See “Creating a prevention policy” on page 131.

See “Creating a detection policy” on page 135.

See “Editing a policy” on page 149.

See “Copying a policy” on page 152.

See “Deleting a policy” on page 153.

See “Importing and exporting policies” on page 154.

See “Renaming a policy” on page 152.

**Reapplying a policy to an agent or group**

When reapplying a policy, you are presented with a list of agents and policy groups that currently enforce the policy. You can reapply the policy to some or all of those agents and groups.

When reapplying a policy, you can choose to retain the old policy option settings, merge the old and new option settings, or take the new option settings.

**To reapply a policy to an agent or group**

1 In the management console, click **Policies**.

2 Under the Policies tab, **Prevention** or **Detection**.

3 On the Policies page, select a policy to reapply, and then right-click **Reapply Policy**.

   To select multiple policies, hold down the Shift or Ctrl key while selecting the policies.

4 In the **Reapply Policy Wizard** dialog box, select the agents and policy groups, and then click **Next**.

   To select multiple agents and agent groups, hold down the Ctrl key while making your selection.

5 In the **Reapply Policy Wizard** dialog box, select the merge option.
6 Click **Finish**.

7 In the management console, click **Refresh** to update the management console page.

Refreshing the page lets you confirm that the agents successfully processed the policy changes.

See “Creating a prevention policy” on page 131.

See “Creating a detection policy” on page 135.

See “Editing a policy” on page 149.

See “Copying a policy” on page 152.

See “Deleting a policy” on page 153.

See “Importing and exporting policies” on page 154.

See “Renaming a policy” on page 152.

---

**Viewing policy properties**

Policy properties provide the following information about a policy:

- **General tab**: Provides policy name and description, tree path, revision number, and target operating system. You can modify the policy name, description, and revision number.

- **Applied To tab**: Lists the agents and groups to which a policy is currently applied.

  From this tab, you can reapply a policy. Select the agents and policy groups, and then click Reapply. To select multiple agents and groups, hold down the Ctrl key while making your selection.

- **Recent Events tab**: Lists recent events for a policy.

- **History tab**: Lists audit events for a policy.

---

**To view policy properties**

1 In the management console, click **Policies**.

2 Under the Policies tab, click **Prevention** or **Detection**.

3 On the Policies page, select a policy, and then right-click **Properties**.

4 In the properties dialog box, view and edit the policy information.

5 Click **OK**.
Creating a policy folder

You use folders to organize your policies. For example, you might use folders to reflect the structure of your network environment, or to group policies by operating system. There is no limit to the number of folders that you can create. You can create nested folders within other folders.

The default policy folder is named Workspace. It contains the Symantec folder, which contains the policies that are included with DCS:SA.

Create policy folders so that you can edit policy options efficiently. Name policy folders so that you can easily identify which policies to assign to the folders.

To create a policy folder

1. In the management console, click Policies.
2. Under the Policies tab, click Prevention or Detection.
3. On the Policies page, in the Policies tree, select the default folder or another folder, and then right-click New Folder.

   A new policy folder is created with the name New Folder.
4. Rename the policy folder, and then press the Enter.

Moving a policy to a folder

You move policies to folders using the following methods:

- Drag-and-drop operation
  You can move a policy from one folder to another folder in a drag-and-drop operation. In the Workspace pane, select a policy, and then drag it to the desired folder in the Policies tree.

- Move To command
  You can move a policy from one folder to another folder using the Move To command. In the Workspace pane, select a policy, and then right-click Move To. In the Move Folder dialog box, select the folder to receive the policy, and then click Move To.

Editing a policy

You can edit a policy to adjust the policy options.

You are prompted to complete a change request that describes the policy modifications.
Policy modifications are saved in your policy workspace. The modifications are not applied to the agents and policy groups that enforce the policy. You must manually reapply the policy to take advantage of the modifications.

To edit a policy

1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention** or **Detection**.
3. On the Policies page, click **Edit**.
   Alternatively, right-click a policy, and then select **Edit Policy**.
4. In the **Adjust your policy settings** dialog box, click **Prevention Enabled** to enable or disable prevention.
5. Select from any of the following policy settings that you make to edit:
   - Advanced Policy Settings
   - Resource Lists
   - Policy Changes and Summary
   - Global Network Access
   - Trusted Users, Groups, and Applications
   - Agent Tools and Programs
6. In the policy dialog box, enable or disable the policy options as needed.
7. Check **Show options hidden in the policy** to display options that are normally hidden in the policy.
8. Click **Apply** and then click **OK**.

How to determine a policy's policy pack reference

In the policy dialog, the general policy information identifies the DCS:SA policy pack in which a policy is contained.

To determine a policy's policy pack reference

1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention** or **Detection**.
3 On the Policies page, click **Edit**. Alternatively, right-click a policy, and then select **Edit Policy**.

4 **In the Adjust your policy settings** dialog box, in the top right-hand corner, click **About**.

You see one of the following messages:

- **This policy references the latest policy pack**
  You see this message, along with a green circle icon, when the referenced policy pack is the latest version.

- **A newer policy pack exists; this policy should be updated**
  You see this message when the referenced policy pack is not the latest version.
  If the referenced policy pack is not the latest version, you should update the policy with the latest policy pack.
  See “Updating a policy” on page 155.

See “Creating a prevention policy” on page 131.
See “Creating a detection policy” on page 135.
See “Copying a policy” on page 152.
See “Deleting a policy” on page 153.
See “Applying and reapplying policies” on page 146.
See “Importing and exporting policies” on page 154.
See “Renaming a policy” on page 152.

### Copying policy options

The Copy Options command copies policy options from one policy to another policy. The Copy Options command assists in maintaining a consistent set of policies across platforms. For example, suppose you customized the options in `Prevention_Windows_Policy_A` and you want to reuse the options in `Prevention_Windows_Policy_B`. Without the Copy Options command, you would have to manually re-enter all the options into `Prevention_Windows_Policy_B`.

With the Copy Options command, you simply select the policy that contains the options you want to copy, select the target policy, and then indicate how you want to merge the policy options.

When copying policy options, the policies must be of the same type (prevention or detection). All policy options are copied to the target policy.
To copy policy options

1. In the management console, click **Policies**.
2. Under the Policies tab, click **Prevention** or **Detection**.
3. On the Policies page, in the pane, select the policy that contains the options you want to copy, and then right-click **Copy Options**.
4. In the **Copy Policy Options Wizard** dialog box, select the target policy, and then click **Next**.
5. In the **Copy Policy Options Wizard** dialog box, select **Merge the changed options** or **Take the new option settings** (default).
6. Click **Finish**.

### Renaming a policy

You can rename policies.

**To rename a policy**

1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention** or **Detection**.
3. On the Policies page, select a policy, and then right-click **Rename Policy**.
4. Type a new policy name, and then press **Enter**.

See “Creating a prevention policy” on page 131.
See “Creating a detection policy” on page 135.
See “Editing a policy” on page 149.
See “Copying a policy” on page 152.
See “Deleting a policy” on page 153.
See “Applying and reapplying policies” on page 146.
See “Importing and exporting policies” on page 154.

### Copying a policy

Copying a policy creates a copy of the policy. The copy is saved in the same folder as the original policy. The copy name is prefixed with Copy_of followed by the original policy name. For example:

Copy_of_sym_win_protection_core
After copying a policy, you should move the copy to your own policy folder. Do not store the copy in the Symantec folder.

To copy a policy
1  In the management console, click Policies.
2  Under the Policies tab, click Prevention or Detection.
3  On the Policies page, select a policy, and then right-click Copy Policy.
   To copy multiple policies, hold down the Shift or Ctrl key while selecting the policies.

See “Creating a prevention policy” on page 131.
See “Creating a detection policy” on page 135.
See “Editing a policy” on page 149.
See “Deleting a policy” on page 153.
See “Applying and reapplying policies” on page 146.
See “Importing and exporting policies” on page 154.
See “Renaming a policy” on page 152.

Deleting a policy

You can delete policies from the policy workspace.

To delete a policy
1  In the management console, click Policies.
2  Under the Policies tab, click Prevention or Detection.
3  On the Policies page, select the policy that you want to delete, and then right-click Delete Policy.
4  In the Confirm Deletion dialog box, click Yes to delete the selected policy.

See “Creating a prevention policy” on page 131.
See “Creating a detection policy” on page 135.
See “Editing a policy” on page 149.
See “Copying a policy” on page 152.
See “Applying and reapplying policies” on page 146.
See “Importing and exporting policies” on page 154.
See “Renaming a policy” on page 152.
Importing and exporting policies

You can import and export prevention and detection policies.

Importing policies

You can import the following policies from files:

■ Library policies
  Symantec periodically releases policy packs that contain revisions to the DCS:SA policies. Symantec releases the policy packs in zip files. Once imported, library policies are visible when you create a new policy. You can identify these policies by their revision numbers.

  Note: DCS:SA v6.6 policies are incompatible with previous versions of the Management Server.

■ Custom policies
  You can import custom policies that were previously exported. Once imported, custom policies are immediately visible in the policy workspace. You can update custom policies with the Symantec library policies.

The import process is the same for library policies and custom policies. The management console recognizes the policy pack type and imports the policies to the correct destination, which is the policy library or your policy workspace.

To import policies

1  In the management console, click Policies.
2  Under the Policies tab, click Prevention or Detection.
3  On the Policies page, in the Policies tree, navigate to and select the folder and then right-click Import Policy.

   The policy pack that you import must be a .zip file.
4  In the Import dialog box, browse to the policy pack that you want to import.
5  Click Import to import the policy into the policy library.

   In the Import dialog box, each successfully imported policy is marked with a green check mark.
Exporting policies

You can export your custom policies to files. Exporting policies is useful for sharing policies with other DCS:SA administrators. You can export one or more policies. Exported policies are saved in .zip files.

To export policies
1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention** or **Detection**.
3. On the Policies page, in the Policies tree, navigate to and select the folder that contains the policies that you want to export, and then right-click **Export Policy**.
   - To select multiple policies, hold down the Ctrl key while selecting the files.
4. In the **Export** dialog box, browse to the folder where you want to export the policies.
5. In the **Export** dialog box, in the File Name box, type a name for the export file, and then click **Export**.
   - The selected policies are exported to a .zip file, using the file name that you specified.
   - In the **Export** dialog box, each successfully exported policy is marked with a green check mark.
6. In the **Export** dialog box, click **Close**.

Updating a policy

Symantec periodically releases policy packs that contain updates to the DCS:SA policies. These policy packs contain internal improvements and additional policy option controls. To incorporate DCS:SA policy updates with your policies, you use the Update Policy command.

Before you update a policy, you should note the following:

- You must obtain the DCS:SA policy packs. The easiest way to get a policy pack is to use LiveUpdate.
- Make a backup copy of the policy that you want to update. This lets you revert to the pre-updated version in case any problems occur with the updated version.
- When updating a policy that was applied to an agent, you must decide how you want to merge the option settings of the policy with the baseline settings of the DCS:SA policy.
- You can update a UNIX policy with a new UNIX policy, but you cannot update a UNIX OS-specific (for example, Solaris) policy with a new UNIX policy.
You may attempt to retain the policy settings by creating a new UNIX policy, and using the Copy Options command to copy the option settings from the Linux policy to the UNIX policy. The success of this approach depends on how many of the option and parameter names are consistent between the policies.

- You can update multiple policies at once. When updating multiple policies, you are prompted to select a currently-installed policy pack, and choose a merge strategy to apply to all selected policies. The selected pack is searched for a new compiled policy with the same name and OS type as the old compiled policy. If a matching compiled policy is found, the policy is updated and merged. If a matching compiled policy is not found, the policy is not updated or merged. You will not see a results screen that lists which policies were updated. As an informal measure, the names of the policies being updated appear briefly on-screen. You can determine if a policy was updated by checking the policy settings.

To update a policy

1. In the management console, click **Policies**.
2. Under the **Policies** tab, click **Prevention** or **Detection**.
3. In the Workspace pane, select a policy, and then right-click **Update Policy**.

To select multiple policies, press and hold the Shift or Ctrl key while selecting the policies.

4. In the **Update Policy Wizard** dialog box, select the DCS:SA policy that you want to use to update your policy, and then click **Next**.
5. In the **Update Policy Wizard** dialog box, select the policy merge option.
6. In the **Update Policy Wizard** dialog box, click **Finish** to save your changes.
7. In the management console, click **Refresh**.
8. (Optional) Reapply the updated policy to agents and policy groups.

See “Creating a prevention policy” on page 131.

See “Creating a detection policy” on page 135.

See “Editing a policy” on page 149.

See “Copying a policy” on page 152.

See “Deleting a policy” on page 153.

See “Applying and reapplying policies” on page 146.

See “Importing and exporting policies” on page 154.

See “Renaming a policy” on page 152.
Verifying prevention policies

Once you apply a prevention policy to a target computer, you can verify the operation of the computer using the Monitors page. The Monitors page displays event information reported to the management server from your entire agent deployment.

Using the Monitors page, search for events from the target computer.

Events that indicate unexpected activity or problems include the following:

- Events with a severity of warning indicate unexpected activity or problems that have already been handled by DCS:SA. If the event has an event type of file access, network access, OS call, or buffer overflow, the warning severity indicates abnormal application behavior that was stopped. Since the behavior was stopped, no further action is required.

- Even if the policy is not enforcing prevention (that is, the disable prevention option is set), improper access to resources by a service or application generates events. With the disable prevention option set, the disposition property indicates allow instead of deny, and the severity property appears in blue instead of red.

- If the policy is enforcing prevention (the disable prevention option is not set), then warning events with an event type of file access, network access, or OS call indicate that a resource access which violated the policy was attempted and then stopped. A warning event with an event type of buffer overflow indicates that a buffer overflow which violated the policy was attempted and then stopped. These warning events might indicate that a service or application on the target computer is functioning improperly with the applied policy.

After investigating the policy violations, you can configure the policy and allow the service or application access to the specific resources if necessary.

You can use the following methods to configure a policy to allow the computer to function properly:

- If there are multiple warning entries from a service or interactive program, and that program has individual behavior controls written for it, you can tailor the policy specifically for that program.

- If there are no individual behavior controls written for the program, the program falls into either the Default Services or Default Interactive Programs group. In this case, you can configure the policy using the Default Service Options or the Default Interactive Program Options.

- You can also configure the policy using the Policy Quick Links. The settings apply to the entire computer.

- To adjust the policy, look at the warning severity-type events, with an event type of file access, network access, or OS call, that are being generated on the
The process set shown on the Monitors page corresponds to an option group in the policy option tree.

The following rules apply to the Windows Strict prevention policy:

If the process set in the event is svc_stdpriv_ps or int_stdpriv_ps

Configure the process using one of the following:
- Default Service Options [svc_stdpriv_ps]
- Default Interactive Program Options [int_stdpriv_ps]

If the process set in the event is svc_safepriv_ps or int_safepriv_ps

The process has been granted safe privilege. Modify either the group level options for interactive programs or services, or the global options:
- General Service Options
- General Interactive Program Options
- Policy Quick Links

If the process set in the event is svc_fullpriv_ps or int_fullpriv_ps

The process has been granted full privilege. Modify either the group level options for interactive programs or services, or the global options:
- General Service Options
- General Interactive Program Options
- Policy Quick Links

Full privilege programs and services are not restricted from accessing any files or registry keys on the computer. However, they are restricted in terms of the networking they can perform. These processes obey the Network Remote Access restrictions, and the Network Resource Lists.

Other process sets

All other process sets can be found in one of the following option groups:
- Application Service Options
- Core OS Service Options
- Specific Interactive Program Options

Opening the policy viewer

If you have created policies and want to view these policies, you can open the policy viewer.

To open the policy viewer

1. In the management console, click Policies.
2. Under the Policies tab, click Prevention or Detection.
3. In the Workspace pane, select a policy and right-click **Edit Policy**.

4. In the policy editor dialog box, under **Policy Changes and Summary**, click **Policy Viewer**.

## Searching policies

You can search for policies in the policy viewer. The ability to search policies lets you find a specific policy that you want to view. You must have full administration rights to search policies.

Table 4-3 provides the tasks you can perform to search for policies.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the policy viewer</td>
<td>See “Opening the policy viewer” on page 158.</td>
</tr>
<tr>
<td>2 (Optional)</td>
<td>Enter the <strong>Policy ID</strong>: (number)</td>
<td>Use this search filter to search for a policy with a specific <strong>Policy ID</strong>. This filter cannot be used with any other filter since it is intended to find a specific policy to process. However, you can use the <strong>Resource Type</strong> filter with <strong>Policy ID</strong>.</td>
</tr>
<tr>
<td>3 (Optional)</td>
<td>Enter the <strong>PolicyName</strong>, <strong>FolderName</strong>, or <strong>date</strong></td>
<td>Optionally, use any of these search filters to search for a policy with the <strong>PolicyName</strong>, <strong>FolderName</strong>, or <strong>date</strong>. Enter the date using the format DD-MON-YYYY. For example: 29-JAN-2011</td>
</tr>
<tr>
<td>4 (Optional)</td>
<td>Enter the <strong>GroupName</strong>, <strong>AgentName</strong> or <strong>date</strong></td>
<td>Optionally, use any of these search filters to search for a policy with the <strong>GroupName</strong>, <strong>AgentName</strong>, or <strong>date</strong>. Enter the date using the format DD-MON-YYYY. For example: 29-JAN-2011</td>
</tr>
</tbody>
</table>
Table 4-3  Tasks to search policies (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5    | Select the appropriate search filters. | You can filter the policy search results with the search filter values.  
      |      | See “Policy viewer search filters” on page 161. |
| 6    | Select the appropriate display attributes. | You can determine the policy display in the Policy Summary section by selecting the appropriate display attributes.  
      |      | See “Policy viewer display attributes” on page 163. |
| 7    | Click Search. | The search displays the policies in the Policy Summary section. It also shows the SQL stored procedures for the search result in the SQL section.  
      |      | See “Policy Summary information” on page 165. |

See “About policy viewer” on page 128.

Searching for policies in the policy viewer

You can use the policy viewer to search and view policies in the DCS:SA environment.

Note: The policy viewer displays only primary policies. It does not display the custom policies that you have added.

To search for policies in the policy viewer
1  Open the policy viewer.
2  Optionally, type the policy ID: (number) that you want to search.
3  Optionally, type the PolicyName, FolderName, or date of the policy that you want to search.
4  Optionally, type the GroupName, AgentName, or date of the policy that you want to search.
5  Select the appropriate search filters.
6 Select the appropriate display attributes.
7 Click Search.

See “About policy viewer” on page 128.
See “Policy viewer search filters” on page 161.
See “Policy viewer display attributes” on page 163.
See “Policy Summary information” on page 165.

Policy viewer search filters

When you open the policy viewer, the Policy Summary section is empty. You can use the default settings to search and populate the summary. You can filter the search results with the search filter values.

Table 4-4 provides the description for the search filters in the policy viewer.

<table>
<thead>
<tr>
<th>Search filter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Os Type       | Use this search filter to search for policies that are applied on operating systems. Following operating system options are available:
  - allOS
    Use this search filter to select policies for all the operating systems.
  - windows
  - unix
  - solaris
  - linux
  - hpux
  - aix |
| Category      | Use this search filter to search for policies with the following policy categories:
  - allcategories
    Use this category to search for detection and prevention policies.
  - detection
  - prevention |
<table>
<thead>
<tr>
<th>Search filter</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Instance** | Use this search filter to search for policies that are applied on instances. Following instance options are available:  
- workspace  
- applied  
- allinstance  
  Use this category to search for **workspace** and **applied** policy instances. |
| **Status** | Use this search filter to search for policies that are applied with the following status:  
- active  
- archived  
- allstatus  
  Use this category to search for policies with **active** and **archived** status. |
| **Time Frame** | Use this search filter to search for policies that are applied with the following time frame:  
- alltime  
  Use this category to search for policies with **day**, **week**, **week**, and **month** time frames.  
- day  
- week  
- month |
| **Version** | Use this search filter to search for policies that are applied for the following versions:  
- allversions  
  Use this category to search for policies with **V5.1** and **V5.2** versions.  
- V5.1  
- V5.2 |
Table 4-4  Policy viewer search filters (continued)

<table>
<thead>
<tr>
<th>Search filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Type</td>
<td>Use this search filter to search for policies that are applied for the following resource types:</td>
</tr>
<tr>
<td></td>
<td>■ file</td>
</tr>
<tr>
<td></td>
<td>■ registry</td>
</tr>
<tr>
<td></td>
<td>■ network</td>
</tr>
<tr>
<td></td>
<td>■ memory</td>
</tr>
<tr>
<td></td>
<td>■ process</td>
</tr>
<tr>
<td></td>
<td>■ user</td>
</tr>
<tr>
<td></td>
<td>■ group</td>
</tr>
<tr>
<td></td>
<td>■ disabled</td>
</tr>
<tr>
<td></td>
<td>■ logging</td>
</tr>
<tr>
<td></td>
<td>■ login</td>
</tr>
<tr>
<td></td>
<td>■ logMon</td>
</tr>
<tr>
<td></td>
<td>■ allresources                                                               Use this category to search for policies with all resource types.</td>
</tr>
</tbody>
</table>

See “About policy viewer” on page 128.

Policy viewer display attributes

Once you have decided on the policies you want to search, you can determine how the display of results through the display attributes.

Table 4-5 shows the available display attributes with the description.

Table 4-5  Policy viewer display attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Detail</td>
<td>Enables you to view the policies either with details or without details. Following are the data detail options:</td>
</tr>
<tr>
<td></td>
<td>■ nodetail</td>
</tr>
<tr>
<td></td>
<td>■ detail</td>
</tr>
</tbody>
</table>

Managing policies  
Policy viewer display attributes  
163
### Table 4-5  Policy viewer display attributes (continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content Display</strong></td>
<td>Following are the content display options:</td>
</tr>
<tr>
<td></td>
<td>■ current</td>
</tr>
<tr>
<td></td>
<td>■ allviews</td>
</tr>
<tr>
<td></td>
<td>■ baseline</td>
</tr>
<tr>
<td></td>
<td>■ summary</td>
</tr>
<tr>
<td></td>
<td>■ wchanges</td>
</tr>
<tr>
<td></td>
<td>■ allchanges</td>
</tr>
<tr>
<td><strong>Content Hidden</strong></td>
<td>Following are the content hidden options:</td>
</tr>
<tr>
<td></td>
<td>■ nohidden</td>
</tr>
<tr>
<td></td>
<td>■ hidden</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td>Following are the symbol options:</td>
</tr>
<tr>
<td></td>
<td>■ symbols1</td>
</tr>
<tr>
<td></td>
<td>■ nosymbols</td>
</tr>
<tr>
<td><strong>Header</strong></td>
<td>Following are the header options:</td>
</tr>
<tr>
<td></td>
<td>■ header</td>
</tr>
<tr>
<td></td>
<td>■ noheader</td>
</tr>
<tr>
<td><strong>Footer</strong></td>
<td>Following are the footer options:</td>
</tr>
<tr>
<td></td>
<td>■ nofooter</td>
</tr>
<tr>
<td></td>
<td>■ footer</td>
</tr>
<tr>
<td><strong>Indent Style</strong></td>
<td>Following are the indent style options:</td>
</tr>
<tr>
<td></td>
<td>■</td>
</tr>
<tr>
<td></td>
<td>■ periods</td>
</tr>
<tr>
<td></td>
<td>■ spaces</td>
</tr>
<tr>
<td></td>
<td>■ underscores</td>
</tr>
<tr>
<td></td>
<td>■ noindent</td>
</tr>
</tbody>
</table>

**Note:** By placing multiple items that conflict each other from the same category such as **baseline** and **summary**, or **hidden** and **nohidden** may produce unwanted results.

See “About policy viewer” on page 128.
Policy Summary information

The Policy Summary section in the policy viewer displays the results of your search. Table 4-6 shows the summary information that is displayed.

Table 4-6 Summary information

<table>
<thead>
<tr>
<th>Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy ID</td>
<td>This number identifies the policy uniquely.</td>
</tr>
<tr>
<td>Item Status</td>
<td>For policies, the value is either Start or End. For an option, it is either On or Off. Blank items are lists, with values.</td>
</tr>
<tr>
<td>Item Description</td>
<td>For a policy or an option, the text that is displayed in the Console. For lists, each value in the list has its own line.</td>
</tr>
<tr>
<td>Bread Crumbs</td>
<td>The path on the option tree where the item or policy was found.</td>
</tr>
</tbody>
</table>

See “About policy viewer” on page 128.

Advanced settings for SQL stored procedure

The policy viewer uses an SQL stored procedure. You can use the viewer to determine the argument parameters that you need to extract policy information. Once you have the parameters you want, you can copy and paste the SQL statement. You can use the statement to extract information instead of the policy viewer user interface. You can also use the information to modify the SQL string to add columns or to do additional filtering or sorting.

Table 4-7 shows the table structure that is used in the SQL procedure. You can use this information to modify the SQL string to add columns or to do additional filter operation or sort operation.

Table 4-7 Advanced settings table structure

<table>
<thead>
<tr>
<th>Column name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>PolicyID</td>
<td>int</td>
</tr>
<tr>
<td>RID</td>
<td>int</td>
</tr>
<tr>
<td>SEQ</td>
<td>int</td>
</tr>
<tr>
<td>Column name</td>
<td>Datatype</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>ELEMENTRID</td>
<td>int</td>
</tr>
<tr>
<td>LEVEL</td>
<td>int</td>
</tr>
<tr>
<td>BASETYPE</td>
<td>varchar(16)</td>
</tr>
<tr>
<td>SETID</td>
<td>char(1)</td>
</tr>
<tr>
<td>OPTNAME</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OPTTYPE</td>
<td>varchar(63)</td>
</tr>
<tr>
<td>STATE</td>
<td>bit default 1</td>
</tr>
<tr>
<td>READONLY</td>
<td>bit default 0</td>
</tr>
<tr>
<td>HIDDEN</td>
<td>bit default 0</td>
</tr>
<tr>
<td>OPTVAL</td>
<td>nvarchar(1024)</td>
</tr>
<tr>
<td>OPTPROCESS</td>
<td>nvarchar(260)</td>
</tr>
<tr>
<td>OPTARGUMENTS</td>
<td>nvarchar(1024)</td>
</tr>
<tr>
<td>OPTUSERNAME</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OPTGROUPNAME</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OPTTIMEZONE</td>
<td>nvarchar(10)</td>
</tr>
<tr>
<td>OPTRULE</td>
<td>nvarchar(64)</td>
</tr>
<tr>
<td>OPTINFO</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OPTDESC</td>
<td>nvarchar(2048)</td>
</tr>
<tr>
<td>DELETED</td>
<td>bit default 0</td>
</tr>
<tr>
<td>BASESTATE</td>
<td>bit default 1</td>
</tr>
<tr>
<td>TypeID</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>ControlID</td>
<td>int</td>
</tr>
<tr>
<td>OptLocalPort</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OptRemotePort</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OptRemoteIp</td>
<td>nvarchar(128)</td>
</tr>
</tbody>
</table>
Table 4-7  Advanced settings table structure (continued)

<table>
<thead>
<tr>
<th>Column name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>OptGenVal1</td>
<td>nvarchar(256)</td>
</tr>
<tr>
<td>OptProtocol</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OptAction</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>OptIdx</td>
<td>Int</td>
</tr>
<tr>
<td>OptLog</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>PolicyTime</td>
<td>datetime</td>
</tr>
<tr>
<td>AppliedTime</td>
<td>datetime</td>
</tr>
<tr>
<td>AppliedPath</td>
<td>nvarchar(512)</td>
</tr>
<tr>
<td>WsPolicyName</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>WSPATH</td>
<td>nvarchar(512)</td>
</tr>
<tr>
<td>WSCreateTime</td>
<td>datetime</td>
</tr>
<tr>
<td>WSModTime</td>
<td>datetime</td>
</tr>
<tr>
<td>WsRevision</td>
<td>varchar(16)</td>
</tr>
<tr>
<td>WSRID</td>
<td>int</td>
</tr>
<tr>
<td>OSTYPE</td>
<td>nvarchar(64)</td>
</tr>
<tr>
<td>AgentVersion</td>
<td>varchar(16)</td>
</tr>
<tr>
<td>PolicyType</td>
<td>nvarchar(64)</td>
</tr>
<tr>
<td>ElementType</td>
<td>varchar(16)</td>
</tr>
<tr>
<td>CompiledPolicyName</td>
<td>nvarchar(128)</td>
</tr>
<tr>
<td>CompiledPath</td>
<td>nvarchar(512)</td>
</tr>
<tr>
<td>CompiledCreatetime</td>
<td>datetime</td>
</tr>
<tr>
<td>CompiledRevision</td>
<td>varchar(16)</td>
</tr>
<tr>
<td>BaseLineView</td>
<td>varchar(3)</td>
</tr>
<tr>
<td>SettingsView</td>
<td>varchar(3)</td>
</tr>
<tr>
<td>SummaryView</td>
<td>varchar(3)</td>
</tr>
</tbody>
</table>
Table 4-7  Advanced settings table structure (continued)

<table>
<thead>
<tr>
<th>Column name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSChangesView</td>
<td>null</td>
</tr>
<tr>
<td>ChangesView</td>
<td>varchar(3)</td>
</tr>
<tr>
<td>TreePath</td>
<td>varchar(128)</td>
</tr>
<tr>
<td>BreadCrumbs</td>
<td>nvarchar(2048)</td>
</tr>
<tr>
<td>ParentNode</td>
<td>int</td>
</tr>
</tbody>
</table>

See “About policy viewer” on page 128.
Managing configurations

This chapter includes the following topics:

- About configurations
- About common configurations
- About prevention configurations
- About detection configurations
- Viewing the Configs page
- Setting up your configuration workspace
- Applying and reapplying workspace configurations
- Importing configurations
- Exporting configurations

About configurations


About common configurations

Common configurations control how agents communicate with the management server.

Common configurations comprise the following parameters:

- Communication parameters
  - Polling interval
- Enable real-time notification
- Connection timeout
- Logging parameters
  - Enable log consolidation
  - Enable log rotation
  - Enable bulk log transfer
  - Delete log files after processing
  - Stop and restart logging at disk usage (%)
- Reader and writer limits
- Event Management
  - Check **Collect SHA-256** to add SHA-256 as an extended attribute to the event details along with other attributes. This option is not selected by default.

### Polling interval

The polling interval is the frequency at which an agent polls the management server for configuration changes. Polling is the most reliable method for agents to obtain configuration changes.

An agent learns of changes to its configuration in the following ways:

- During system startup, the agent queries the management server for configuration changes. This ensures that the agent immediately applies any changes made while the agent was shut down or disconnected from the network.
- The agent uses the polling interval to periodically poll the management server for configuration changes. In extremely large deployments (over 100,000 computers), you might need to increase the polling interval.

The polling interval also controls how often an agent updates its policy state information (indicated by the shield icon) and how often an agent performs disk space monitoring.

### Enable real-time notification

In addition to using the polling interval, agents can use real-time notification to obtain configuration changes. With real-time notification, the management server sends a real-time notification message to an agent as configuration changes occur. Upon receiving the notification, the agent queries the management server for the changes. The agent uses a port that you specify to communicate with the management server.
By default, real-time notification is enabled. When real-time notification is disabled, the management server does not send any messages to the agent and relies on the polling interval to update the agent.

**Connection timeout**

The connection timeout is the TCP/IP connection timeout for connections initiated by the agent to the management server. While the agent is waiting for a connection to time-out, it suspends some activities, including responding to policy override requests, which are made using the policy override tool. Increasing the connection timeout may improve agent connectivity with the management server on slow or congested networks. However, it can also cause the policy override tool to time-out while waiting for the agent to respond to the override request.

See the *Symantec Data Center Security: Server Advanced Agent Guide* for instructions on how to use the policy override tool.

**Enable log consolidation**

Log consolidation controls when an agent consolidates similar log events into a summary event that is sent to the management server. Similar log events that occur consecutively, within a user-specified summary delay period (for example, one minute), are consolidated into a summary event. The summary event includes a count of the number of similar log event occurrences.

Log consolidation only occurs for prevention events.

For similar log events to be consolidated, the following fields in each event must match:

- Severity code
- Event type
- Process ID
- Process name
- Disposition

**Enable log rotation**

Log rotation determines how and when agents rotate event log files.

When an agent rotates a log file, the current log file is closed and nothing more is written to it. A new log file is opened with the same base file name, but with the next highest sequence number added to the file name. Once a log file is rotated, the old file might still be in use by the agent. Although no new records are written
to the log file, the agent might still have to process events and send them to the management server.

Log files are compressed into .zip files when processing is finished.

The frequency at which agents rotate log files is based on one of the following parameters:

- **File size**
  Agents can rotate log files based on log file size (in MB). When a log file reaches the size that you specify, a new log file is started.

- **Time interval**
  You can rotate log files based on the following time intervals:

  - **Monthly**
    The numerical day of the month to rotate log files.
    Examples: 1, 2, 3, 4, etc.

  - **Weekly**
    The day of the week to rotate log files.
    Examples: Sunday, Monday, Tuesday, etc.

  - **Daily**
    The time of day (on the hour) to rotate log files.
    Examples: Midnight, 1:00 A.M., 2:00 A.M., 3:00 A.M., etc.

  - **Hourly**
    The hour intervals to rotate log files are as follows:
    - On the hour
    - 15 minutes past the hour
    - 30 minutes past the hour
    - 45 minutes past the hour

---

**Enable bulk log transfer**

Bulk log transfer collects events of long-term interest, without burdening the network or flooding the Symantec Data Center Security: Server Advanced database with events that have no immediate reporting or actionable purpose. Events of long term interest are generally used for audit or forensic analysis needs.

Table 5-1 lists the high-level steps for configuring bulk log transfer.
### Table 5-1: Bulk log transfer steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Enable bulk log transfer in the agent's common configuration</td>
<td>Enable the Enable Bulk Log Transfer option in the agent's common configuration, on the Configs page. When full, the agent's log file is transmitted to the management server, where it is stored.</td>
</tr>
</tbody>
</table>
| 2    | Enable or disable deleting the transmitted bulk log files               | If you disable the **Delete Log Files After Processing** option in the agent's common configuration, then the agent log files that were successfully transmitted to the management server for bulk log storage are copied to the following archive folder:  
On 32-bit machines:  
<install directory>\Symantec\Data Center Security Server\Agent\sdcsslog\archive  
On 64-bit machines:  
<install directory>\Symantec\Data Center Security Server\Agent\sdcsslog\archive  
If you enable the Delete Log Files After Processing option, then the agent log files that were successfully transmitted to the management server for bulk log storage are deleted.  
See "Delete log files after processing" on page 174. |
| 3    | Configure the agent's log rules for bulk logging                       | When configuring the agent's log rules, set the Transmit Action to Bulk Log Only.  
You access the agent's log rules from the Configs page. The agent has prevention log rules and detection log rules, which you configure separately.  
See "About prevention configurations" on page 175.  
See "About detection configurations" on page 177. |
| 4    | Verify bulk logging                                                    | Verify that the agent log files are being transmitted to the management server for storage.  
Search the Monitors page. Look for events of type Agent Status, with the operation Bulk Log Transfer. The name of the compressed log file appears in the event message. |
When an agent is configured for bulk log transfer, the following processing occurs:

- The event log files that are waiting to be uploaded for bulk logging are copied to the upload folder at the following location: `<install directory>`\Symantec\Data Center Security Server\Agent\sdcsslog\upload.

- The bulk file name format is `YYYYMMDD_HHMSS_QQQQ-FT_HOSTNAME`. QQQQ is a sequence number, F is a file type, T is the OS type, and Hostname is the agent name, host name, or IP address.

- To verify that the upload for bulk logging occurred, search the Monitors page in the management console. Look for events of type Agent Status, with operation Bulk Log Transfer. The name of the compressed log file appears in the event message.

- If the delete flag is set to false, files that were successfully uploaded for bulk logging are copied to the archive folder at the following location: `<install directory>`\Symantec\Data Center Security Server\Agent\sdcsslog\archive.

- You must run the bulk loader utility to load bulk log events into management server database.

- Bulk file transmission does not block ongoing agent activities such as filtering, real-time event transmission, or update processing.

- By default, bulk log transfer is disabled for an agent.

### Delete log files after processing

Delete log files after processing deletes an event log file after DCS:SA reads the events in the file. If an agent is configured to transfer event logs to the management server, the deletion occurs after the transfer is successful.

By default, delete log files after processing is disabled.
Stop/restart logging at disk usage

The agent monitors the used disk space on the disk that contains the logs, to avoid filling the disk completely. The agent checks the percentage of used disk space at each polling interval. If the percentage of used disk space exceeds the configured stop-logging threshold, the agent stops logging events to the log files. Logging remains off until the percentage of used disk space drops below the configured start-logging threshold. At that point, the agent restarts logging events to the log files. When stopping or restarting logging, the agent generates a log message that appears on the Monitors page.

The stop-logging threshold must be at least five percent greater than the restart-logging threshold.

You can change the stop-logging and restart-logging thresholds using the agent config tool (sisipsconfig.exe).

Reader/writer limits

The reader limit and writer limit control how the agent processes events that are sent to the Monitors page.

The reader limit is the maximum number of events processed before the agent pauses. By pausing after a specified number of events, the agent avoids consuming too many system resources. Increasing the reader limit lets the agent consume more resources, but gets events to the Monitors page more quickly. Decreasing the reader limit reduces the resources that the agent consumes, but gets events to the Monitors page more slowly.

The writer limit is the maximum number of events that the agent can send in a single TCP/IP connection. Creating a TCP/IP connection is overhead, and sending multiple events in a single connection reduces the average overhead per event.

About prevention configurations

Prevention configurations comprise log rules. You use log rules to configure the transmission of events that agents send to the management server.

Log rules comprise the following:

- Filter rules
- Transmit action

You use the log rule editor to specify filter rules and a transmit action.
About filter rules

Each filter rule comprises <field, operator, value>. You can configure multiple filter rules for each log rule. Events must match all filter rules.

Please note the following when configuring filter rules:

■ Examples of valid fields include event type, event severity, event date, disposition, event priority, process, user name, remote IP.

■ Examples of valid operators include equals, not equals, in, not in, contains, not contains, greater than, less than. Some operators support the use of wildcard characters in a value. Valid wildcard characters are asterisk (*), which represents zero or more consecutive characters, and question mark (?), which represents exactly one character.

■ Not all operators are valid for all fields. For example, greater than and less than only make sense for numeric fields.

■ The equals/not equals operator supports the wildcard character asterisk (*) for zero or more characters, and the wildcard character question mark (?) for a single character.

■ The in/not in operator allows multi-select for fields with drop-down lists of possible values. For fields that have free-form text entry, the operator accepts a comma-separated list (no wildcard character support).

■ Valid values vary, depending on the field. Some fields are limited to a pre-defined list, while other fields allow free-form typing.

■ You can use Event Value1 through Event Value26 to specify additional fields in an event.

■ Ordering is significant in log rules. Events are matched against log rules from top to bottom. The agent uses the transmit action of the first log rule that matches the event. If the transmit action is transmit in real-time, the agent sends the event to the management server. If the transmit action is bulk log only, the agent does not send the event. If the event does not match any of the log rules, the event is ignored.

■ There is an implicit bulk-log-only default rule. A prevention configuration with zero log rules implies that all events are transmitted in bulk log only.

About transmit actions

The transmit actions are as follows:
Real-time events are actionable events that are transmitted to the management server for storage in the DCS:SA database.

The default transmit log rules are as follows:

- Transmit when EventType in Memory Access, File Access, Network Access, OS Call, Registry Access, Process Access
- Transmit when EventType Equals Process Assignment AND
- Transmit when EventType In Agent Status, Configuration, AND
- Transmit when EventType In IDS Error, IDS Status, Event File Summary, Policy Override

Bulk log events are events of long-term interest that have no immediate reporting or actionable purpose.

Bulk log events are recorded in log files on the agent computer. When full, the log files are compressed and transferred to the management server for storage. Bulk log events are loaded into the management server database using the bulk loader utility. The events are loaded into the analysis event table (the default) or the real-time event table.

**About detection configurations**

Detection configurations comprise the following parameters:

- Parameters that control how the detection features of an agent operate. These parameters include the following:
  - File collector
  - Event log collector
  - Audit collector
  - Registry collector
  - Syslog collector
  - WTMP collector
  - BTMP collector
  - C2 collector
  - Log rules

**Parameters that control how detection features operate**

DCS:SA includes collectors that watch for changes to files, registry keys, event logs, and audit logs.
File collector

The file collector determines how agents monitor files. Intruders often attempt to replace critical system files with Trojan horse versions, or alter system files to create a back door for future intrusions. The file collector detects changes to these system critical files.

The file collector is valid for agents that are installed on supported Windows and UNIX operating systems. By default, the file collector is enabled.

On Windows operating systems, the file collector is a real-time collector.

On Windows, the file collector monitors the following file attributes:

- Create date
- Modified date
- Read-only
- Hidden
- System
- Size
- Compression
- Encryption
- Temporary
- Index service

On UNIX operating systems, file monitoring is implemented as polling. When you add a file to the filewatch list, you can specify a priority level of Normal or High. Files with Normal priority are polled for changes on the long poll interval. Files with the High priority are polled for changes on the short poll interval.

On UNIX operating systems, the file collector monitors the following attributes:

- Size
- Owner ID
- Group ID
- Permissions
- Number of hard links
- Access time
- Modified time
On UNIX operating systems, if a filewatch entry corresponds to a symbolic link or contains a wildcard character that expands to include a symbolic link, the file to which the link points is monitored.

You can monitor additional files by adding the files to a filewatch list. When the file tampering policy is applied to an agent, the filewatch list detects and reports when an agent computer file is added, deleted, modified, or renamed.


Agents can determine if a file in the filewatch list was changed while the agent was shut down. At agent shutdown, all associated attributes of all watched files are written to a file on the agent computer. When the agent restarts, the attributes' state is compared to the attributes in this file. If a modified attribute is detected, an event is recorded.

Agents use the following settings to determine how to monitor files:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Monitor Last Access Time | The file collector monitors a file's last access time in addition to the file attributes. A file's last access time is checked at agent startup to determine whether the file was modified since DCS:SA was last shut down. This parameter monitors the following: 
  ■ Access time changes (indicating that a file was read) 
  ■ Non-content related bit settings on Windows: Archive, Offline, Read-only, Reparse-point, Sparse File, Temporary, Indexed Changes to this parameter require agents to be restarted. |
| Monitor File Checksums   | The file collector computes checksums to determine whether a file has changed. Changes to this parameter require agents to be restarted. |
Search Depth
If you use a wildcard character at the end of a path in the file collector list, the recursion level determines how many directory levels are watched.

Select one of the following recursion levels:
- Recursion level 1 causes the collector to monitor all files in a specified directory.
- Recursion level 2 causes the collector to monitor all files in a specified directory and in the sub-directories of that directory.
- Recursion levels 3, 4, and 5 add additional levels of sub-directory monitoring.

Symantec Data Center Security: Server Advanced does not watch all levels below a specified directory to avoid severe impact on system performance.

Changes to this parameter require agents to be restarted.

High Priority Polling Interval
The high-priority polling interval, in seconds.
Files with the high priority are polled for changes on the short poll interval.

Normal Priority Polling Interval
The normal-priority polling interval, in minutes.
Files with normal priority are polled for changes on the long poll interval.

Event log collector
The event log collector looks for matches in the Windows event log. By default, the event log collector is enabled.

Audit collector
The audit collector monitors events from Windows standard system audit logs.
The system audit log sources in Windows are as follows:
- Security
- Application
- System
By default, the audit collector is enabled.

Registry collector
The registry collector watches for changes made to registry keys on the Windows operating system. By default, the registry collector is enabled.
Syslog collector
The syslog collector watches for syslog daemon tampering on UNIX-based operating systems. By default, the syslog collector is enabled.

WTMP collector
The WTMP collector monitors the WTMP logging system on UNIX-based operating systems. By default, the WTMP collector is enabled.

BTMP collector
The BTMP collector monitors the BTMP logging system on UNIX-based operating systems. By default, the BTMP collector is enabled.

C2 collector
The C2 collector monitors the C2 audit logging system on Solaris, Linux, HP-UX, and AIX operating systems. By default, the C2 collector is disabled. When the C2 collector is enabled, the agent automatically transmits C2 log events to the management server.

Log rules
You use log rules to configure and control the transmission of events that an agent sends to the management server.

You configure detection log rules in the same way that you configure prevention log rules.

See “About prevention configurations” on page 175.

Viewing the Configs page
You use the Configs page in the management console to manage the configurations that you apply to agents and configuration groups.

You can do the following activities from the Configs page:

- Create and edit common, prevention, and detection configurations
- Organize configurations in folders
- Apply and reapply configurations to agents and configuration groups
- Copy, rename, and delete configurations
- Import and export configurations
To view the Configs page

1. In the management console, click **Configs**.
2. Under the **Configs** tab, select any view.
3. On the Configs page, in the Configs pane, click the **Symantec** folder to list the Symantec default configurations.
4. (Optional) To restrict or expand the configuration list, in the Filters tree pane, select one of the following filters:
   - **All Configs**: Filter that displays all configurations.
   - **Common Parameters**: Filter that displays common configurations.
   - **Prevention Parameters**: Filter that displays prevention configurations.
   - **Detection Parameters**: Filter that displays detection configurations.
5. (Optional) To expand or collapse the panes, click the size arrows.

**Setting up your configuration workspace**

Your configuration workspace is where you store the configurations that you apply to agents and configuration groups.

Upon initial installation of DCS:SA, your configuration workspace is automatically populated with the Symantec default configurations.

You can also populate your configuration workspace with the following configurations:

- Configurations that you created based on modifications to the Symantec default configurations
- Configurations that you obtained from other DCS:SA administrators

**Creating a common configuration**

All agents use common configurations.

See “About common configurations” on page 169.
To create a common configuration

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.

2. In the left-hand pane, under the **Workspace Folders** section, select the folder where you want to store the new configuration.

3. In the **Configs** pane, click **Add**.

4. In the **New Config Wizard** dialog box, click the **Common Parameters** icon.

5. In the **New Config Object** panel, in the **Name** box, type a name for the new configuration, and then click **Finish**.

Creating a prevention configuration

Agents that support prevention features use prevention configurations.

See “**About prevention configurations**” on page 175.

To create a prevention configuration

1. In the management console, click **Configs > Prevention**.

2. In the left-hand pane, under the **Workspace Folders** section, select the folder where you want to store the new configuration.

3. In the **Configs** pane, click **Add**.

4. In the **New Config Wizard** dialog box, click the **Prevention Parameters** icon.

5. In the **New Config Object** panel, in the **Name** box, type a name for the new configuration, and then click **Finish**.

Creating a detection configuration

Agents that support detection features use detection configurations.

See “**About detection configurations**” on page 177.

To create a detection configuration

1. In the management console, click **Configs > Detection**.

2. In the left-hand pane, under the **Workspace Folders** section, select the folder where you want to store the new configuration.

3. In the **Configs** pane, click **Add**.

4. In the **New Config Wizard** dialog box, click the **Detection Parameters** icon.

5. In the **New Config Object** panel, in the **Name** box, type a name for the new configuration, and then click **Finish**.
Editing a workspace configuration

Modifications to common, prevention, and detection configurations are saved in your configuration workspace. The modifications are not automatically applied to the agents and configuration groups that use the configuration. You must manually reapply the configuration to the agents and configuration groups to take advantage of the modifications.

To edit a workspace configuration

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.
2. On the Configs page, select a configuration, and then right-click **Properties**.
3. In the properties dialog box, edit or view the settings for a common, prevention, or detection configuration.
4. Click **OK** to save your changes.

See “About common configurations” on page 169.
See “About prevention configurations” on page 175.
See “About detection configurations” on page 177.

Renaming a workspace configuration

You can rename workspace configurations.

To rename a configuration

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.
2. In the Configs workspace, right-click a configuration, and then click **Rename**.
3. Type a new name for the configuration, and then press Enter.

Copying a workspace configuration

Copying a configuration creates a copy of the configuration. The copy is saved in the same configuration folder as the original configuration. The copy name is prefixed with Copy_of followed by the original configuration name (for example, Copy_of_Common_Parameters).
To copy a workspace configuration

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.
2. In the Configs workspace, right-click the configuration that you want to copy, and click **Copy**.

Deleting a workspace configuration

You can delete workspace configurations.

To delete a workspace configuration

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.
2. In the Configs workspace, right-click the configuration that you want to delete, and click **Delete**.

Creating a configuration folder

You use folders to organize the configurations that you apply to agents. You might use configuration folders to store configurations of like types (for example, a folder for common configurations, another folder for prevention configurations). There is no limit to the number of configuration folders that you can create. You can create nested configuration folders within other folders.

Create configuration folders so that you can edit the configurations efficiently. Name configuration folders so that you can easily identify which configurations to assign to the folders.

To create a configuration folder

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.
2. On the Configs page, in the Configs tree, select the default Configs folder or another folder, and then right-click **New Folder**.

   A new configuration folder is created with the name **New Folder**.
3. Rename the configuration folder, and then press the **Enter** key.

Moving a workspace configuration to a folder

You move configurations to folders using the following methods:

- Drag-and-drop operation
You can move a configuration from one folder to another folder in a drag-and-drop operation. In the Workspace pane, select a configuration, and then drag it to the desired folder in the Configs tree.

- Move To command
  You can move a configuration from one folder to another folder using the Move To command. In the Workspace pane, select a configuration, and then right-click **Move To**. In the Move Folder dialog, select the folder to receive the configuration, and then click **Move To**.

**Applying and reapplying workspace configurations**

You use the Apply Config command to apply a workspace configuration to agents and configuration groups that do not currently use the configuration.

You use the Reapply Config command to reapply a workspace configuration to agents and configuration groups that currently use the configuration. The Reapply Configuration command is useful when you need to reapply a workspace configuration that was modified.

**Applying a workspace configuration to an agent or group**

When applying a configuration, you are prompted to select the agents and configuration groups that will use the configuration.

**To apply a configuration to an agent or group**

1. In the management console, click **Configs > Prevention** or **Configs > Detection**.

2. On the Configs page, right-click the configuration that you want to apply, and then click **Apply**.

3. In the **Apply Configuration** dialog box, select the agents and configuration groups to which you want to apply the selected configuration, and then click **Apply**.

   To select multiple agents and groups, hold down the Ctrl key while making your selection.

4. In the management console, click **Refresh** to update the management console page.

Refreshing the page lets you confirm that the agents successfully processed the configuration changes.
Reapplying a workspace configuration to an agent or group

When reapplying a configuration, you are presented with a list of agents and configuration groups that currently use the configuration. You can reapply the configuration to some or all of those agents and groups.

To reapply a configuration to an agent or group

1. In the management console, click Configs > Prevention or Configs > Detection.
2. On the Configs page, right-click the configuration that you want to reapply, and then click Reapply.
3. In the Reapply Configuration dialog box, select the agents and configuration groups to which you want to reapply the selected configuration, and then click Reapply.

To select multiple agents and groups, hold down the Ctrl key while making your selection.

4. In the management console, click Refresh to update the management console page.

Refreshing the page lets you confirm that the agents successfully processed the configuration changes.

Importing configurations

You can import configurations that you or another DCS:SA administrator exported.

To import configurations

1. In the management console, click Configs > Prevention or Configs > Detection.
2. On the Configs page, in the Configs tree, right-click the folder to which you want to import the configurations, and then click Import.
3. In the Import dialog box, browse to the configuration .zip file, and then click Import.

In the Import dialog box, each successfully imported configuration is marked with a green check mark.

4. In the Import dialog box, click Close.
Exporting configurations

You can export configurations to .zip files. Exporting configurations is useful for sharing your configurations with other DCS:SA administrators.

To export configurations

1 In the management console, click **Configs > Prevention** or **Configs > Detection**.

2 On the Configs page, right-click the configurations that you want to export, and then click **Export**.

   To select multiple configurations, hold down the Ctrl key while selecting the configurations.

3 In the **Export** dialog box, browse to the folder where you want to export the configurations.

4 In the **Export** dialog box, in the File Name box, type a name for the export .zip file, and then click **Export**.

   The selected configurations are exported to the .zip file, using the file name that you specified. In the Export dialog, each successfully exported configuration is marked with a green check mark.

5 In the **Export** dialog box, click **Close**.
Viewing events

This chapter includes the following topics:

- About events
- About event severity levels
- About the System State event flag
- Viewing the Monitors page
- Viewing event details on the console
- Setting the Monitors preferences
- Verifying the operation of an agent computer
- Searching events
- Grouping events in the console by event type
- Acknowledging an event
- Resolving events
- Suppressing events on the console
- Selecting a strategy for a selected group of events
- Updating the configuration rules for suppression strategies
- About real-time monitors
- Remediating bulk events
- Exporting events
- Purging events
About events

Events are informative, notable, and critical activities that concern the DCS:SA agent and Symantec Data Center Security: Server. The agent logs events to the management server, and the Symantec Data Center Security: Server lets you view summaries and details of those events.

An agent's log rules determine which events are sent to the management server.

You can use the Home page in the Symantec Data Center Security: Server to obtain an overview of events that are being generated in your network.

You can use the DCS:SA agent event viewer to display recent events that were reported by a DCS:SA agent.


About event sources

Symantec Data Center Security: Server Advanced events originate from the following sources:

<table>
<thead>
<tr>
<th>Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>The agent transmits events to the management server. Agent-transmitted events are loaded into the SDCSSEVENT table by default. Agent-transmitted events include events reported by DCS:SA native agents and virtual agents.</td>
</tr>
<tr>
<td>Bulk loader utility</td>
<td>The bulk loader utility loads events into the ANALYSIS_EVENT table by default. No other mechanism exists to load events into this table.</td>
</tr>
<tr>
<td>Management server</td>
<td>Server operations generate server-related events. Server-related events are only loaded into the SDCSSEVENT table.</td>
</tr>
</tbody>
</table>

About event categories

The Monitors page groups events by the following categories:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Events</td>
<td>All prevention and detection events.</td>
</tr>
<tr>
<td>Prevention</td>
<td>An agent's prevention policy generates prevention events when applications access computer and network resources that violate the policy's behavior control.</td>
</tr>
<tr>
<td>Detection</td>
<td>An agent's detection policy generates detection events when monitored files or registry keys change, or when system or application logs generate events that match the policy's criteria.</td>
</tr>
<tr>
<td>Malware Protection</td>
<td>A security virtual appliance's malware protection policy generates events for on-demand scan, scheduled scan, threat detection, content updates, or antivirus services.</td>
</tr>
<tr>
<td>Management</td>
<td>An agent records management events that are related to the agent's configuration and communication status.</td>
</tr>
<tr>
<td>Profile</td>
<td>An agent's prevention policy generates profile events when a process is profiled.</td>
</tr>
<tr>
<td>File Catalog</td>
<td>An agent records file catalog events that acknowledge the following activities:</td>
</tr>
<tr>
<td></td>
<td>- Successful event log rollover</td>
</tr>
<tr>
<td></td>
<td>- Successful storage of log files in the agent repository in the management server during bulk log transfer</td>
</tr>
<tr>
<td>Analysis</td>
<td>Analysis events comprise the events that were transferred to the management server using bulk log transfer and then loaded into the database. Analysis events are of long-term interest, generally for audit or forensic analysis needs.</td>
</tr>
<tr>
<td>Audit</td>
<td>The management server records audit events whenever changes to the system configuration are made.</td>
</tr>
<tr>
<td></td>
<td>Optionally, the management server can record audit events whenever searches, queries, or reports are executed.</td>
</tr>
</tbody>
</table>

**About event types**

DCS:SA groups events by types.

### Prevention event types

Prevention event types are as follows:

- **Buffer Overflow** | Contains information about applications that execute code that was inserted using buffer overflows. Buffer overflow events apply to agent computers that run Windows operating system.
- **File Access** | Contains information about applications that access files and directories.
- **Mount** | Contains information about applications that mount or unmount file systems.
- **Network Access** | Contains information about applications that access the TCP/IP network.
OS Call  Contains information about applications that make selected operating system calls that are often exploited by attackers.

Process Access  Contains information about the process modification or process access.

Process Set  Contains information about the assignment of a process to a process set.

Process Create  Contains information about the creation of a process.

Process Destroy  Contains information about the termination of a process.

Registry Access  Contains information about applications that access registry keys.

Detection event types

Detection event types are as follows:

Audit Watch  Contains information about audit watch events.

Filewatch  Contains information about filewatch events for Windows and UNIX operating systems.

Generic Log  Contains information about generic log events.

NT Event Log  Contains information about NT event log events.

Prevention Watch  Contains information about prevention watch events.

Registry Watch  Contains information about registry watch events.

Syslog  Contains information about syslog events.

UNIX C2 Log  Contains information about C2 events.

UNIX Activity Log  Contains information about WTMP events.

Management event types

Management event types are as follows:

Agent Status  Status messages from the IPS Service/daemon.
<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>Contains information about communications between the agent and the management server.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Contains information about agent configuration status.</td>
</tr>
<tr>
<td>IDS Error</td>
<td>Contains information about detection errors.</td>
</tr>
<tr>
<td>IDS Status</td>
<td>Contains information about detection status.</td>
</tr>
<tr>
<td>Event File Create</td>
<td>Contains information about a single event file from an agent.</td>
</tr>
<tr>
<td>Event File Receive</td>
<td>Contains information about files transferred to the bulk file repository on the DCS:SA management server.</td>
</tr>
<tr>
<td>Event Storage Error</td>
<td>Contains information about database storage errors.</td>
</tr>
<tr>
<td>Policy Override</td>
<td>Contains information about users overriding policies on agents.</td>
</tr>
<tr>
<td>IPS Status</td>
<td>Status messages from the IPS Driver.</td>
</tr>
</tbody>
</table>

**Profile event types**

Profile event types are as follows:

- **Buffer Overflow**
  - Contains information about applications that execute code that is inserted using buffer overflows.

- **File Access**
  - Contains information about applications that access files and directories.

- **Mount**
  - Contains information about applications that mount or unmount file systems. By default, these events do not appear on the Monitors page.

- **Network Access**
  - Contains information about applications that access the TCP/IP network.

- **OS Call**
  - Contains information about applications that make selected operating system calls that are often exploited by attackers.

- **Process Set**
  - Contains information about the assignment of a process to a process set.

- **Process Create**
  - Contains information about the creation of a process.

- **Process Destroy**
  - Contains information about the termination of a process.

- **Registry Access**
  - Contains information about applications that access registry keys.
File catalog event types
File Catalog events contain information about bulk log files that are stored in the management server repository.

Analysis event types
Analysis events comprise the events that were transferred to the management server using bulk log transfer and then loaded into the server database. Analysis events are of long-term interest, generally for audit or forensic analysis needs.

Audit event types
Audit events contain system audit information.

About event severity levels
Symantec Data Center Security: Server assigns a severity level to each event.
The event severity levels are as follows:

<table>
<thead>
<tr>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Info</td>
<td>Events with a severity of Info contain information about normal system operation.</td>
</tr>
<tr>
<td>Notice</td>
<td>Events with a severity of Notice contain information about normal system operation.</td>
</tr>
<tr>
<td>Warning</td>
<td>Events with a severity of Warning indicate unexpected activity or problems that have already been handled by Symantec Data Center Security: Server. These Warning messages might indicate that a service or application on a target computer is functioning improperly with the applied policy. After investigating the policy violations, you can configure the policy and allow the service or application to access to the specific resources if necessary.</td>
</tr>
<tr>
<td>Major</td>
<td>Events with a severity of Major imply more impact than Warning and less impact than Critical.</td>
</tr>
<tr>
<td>Critical</td>
<td>Events with a severity of Critical indicate activity or problems that might require administrator intervention to correct.</td>
</tr>
</tbody>
</table>

See “About events” on page 190.
About the System State event flag

The System State event flag indicates the state of processing characteristics when the event occurred. For example, the System State flag can indicate the prevention override/disabled state and whether the event was selected for real-time transmission. The System State flag can indicate the kind of event injection and the kind of source agent type.

The System State event flag contains a concatenated list of flags that are appropriate for a given event.

The System State event flags are as follows:

**Event Processing States**
- R: real-time event
- V: virtual event
- I: injected event

**Prevention Policy States**
- P: prevention policy overridden completely
- X: prevention policy overridden except for self-protection
- G: policy globally disabled

**Event Source States**
- T: ITA forwarded
- C: DCS:SA forwarded
- D: collector derived
- L: logwatch policy generated
- F: Config tool generated
- S: IPS Service generated

**Other Event Attributes**
- Z: Solaris non-global zone event
- M: DCS:SA manager virtual agent (this flag only exists in the database, not the CSV file)

**Note:** Not all virtual events are injected events. Not all injected events are virtual events. All virtual and injected events must also specify an event source. The Solaris Zone flag indicates that the event processed came from a non-global zone.

Examples of System State flags are as follows:
- PR: real-time event, prevention policy overridden
- IS: injected IPS Service event
- VT: virtual ITA event
- D: derived event
Viewing the Monitors page

You use the Monitors page in the management console to view events that are sent to the management server. The Monitors page displays event information reported to the management server from your entire agent deployment.

You can do the following activities from the Monitors page:

- View all events or categories of events.
- Use the Event Details command to view detailed information that pertains to a selected event.
  See "Using the Event Details command" on page 201.
- Create and display real-time monitors, for viewing events in real time.
  See "About real-time monitors" on page 207.
- Use the Event Wizard to resolve events.
  See "Using the Event Wizard command" on page 202.
- Export events to comma-separated value (.csv) files.
  See "Exporting events" on page 212.

DCS:SA preserves the Monitors page view for the current session of the management console. This feature lets you traverse between pages while maintaining the view settings for each page, which is useful when troubleshooting events. The next time that you log on to a new session of the management console, the Monitors page view is reset to its default settings.

To determine the number and age of the events that are displayed on the Monitors page and in real-time monitors, you set the Monitors preferences.

See "Setting the Monitors preferences" on page 198.

Note: All system date/time values are handled as Coordinated Universal Time (UTC). Some system date/time values that are shown in the management console are converted to the local time zone. Converted values are shown with the appropriate time zone values.
To view the Monitors page

1. In the management console, click **Monitors**.
2. On the Monitors page, in the **Monitors Types** pane, select an event category for viewing events.
3. To expand or restrict the list of events, in the **Filters** pane, select one of the following filters:

   - **All Events**: Filter that displays all the events.
   - **The last 500 events**: Filter that displays a subset of the last 500 events for a selected monitor type.
     
     For example, if you select the last 500 events and also select the Prevention monitor type, the Monitors page displays the subset of the last 500 events that are prevention events.
   - **The last n hours**: Filter that displays events that occurred in the last n hours.
     
     The number of hours is defined in the console preferences (View > Preferences). By default, this value is set to 2 days.
   - **Within the last hour**: Filter that displays the events that occurred in the last hour.
   - **Past Day**: Filter that displays the events that occurred during the past day.
   - **Within the last week**: Filter that displays the events that occurred within the last week.
   - **Past Month**: Filter that displays the events that occurred in the past month.
   - **Within the past year**: Filter that displays the events that occurred within the past year.

**Viewing event details on the console**

You can view the details of the events that are generated for each agent that has DCS:SA installed.

The event details include the following:

- The name of the agent computer that has DCS:SA installed
- The date when the event occurs
- The type of the event
- The severity of the event
- A brief description of the event

You can export the event report as a CSV file.

To view the event details on the console

1. In the DCS:SA management console, go to **Monitors > Events**.
2. In the left-hand side pane, in the **Monitor Types** section, select the type of event that you want to view.

**Setting the Monitors preferences**

You use the Monitors preferences to set the number and age of events that are shown on the Monitors page.

**Verifying the operation of an agent computer**

You can verify the operation of an agent computer by viewing the events that were sent to the management server.

To verify the operation of an agent computer, search the Monitors page for event messages from the agent computer. Messages with a severity of Warning indicate unexpected activity or problems that were already handled by DCS:SA. If a message has an event type of file access, network access, OS call, or buffer overflow, then a severity of Warning indicates abnormal application behavior that was stopped.

Even if the prevention policy is not enforcing prevention (that is, the disable prevention option is set), improper access to resources by a service or application will generate log messages. With the disable prevention option set, the disposition field in a log message will indicate allow instead of deny, and the event severity will appear on the Monitors page in blue instead of red.

After investigating these warning messages, you may find that DCS:SA prevented an attempt to attack the agent computer or that the events do not reflect a risk condition on the system. In the latter case, you may want to further configure the policy so that it does not produce these events in the future.

**Searching events**

The Monitors page includes a search function that you can use to search a broad or restricted range of events.

When using the search function, you can specify the following options:

- **Source Machine**  The name and IP address of the agent that generated the event.
OS Type
The operating system of the agent computer that generated the event.

Event Category
The event category.

Event Type
The type of event.

Event Severity
The severity of the event.

Event ID
The event id.

A word or phrase in the Description
A word or phrase that is part of the summary information about the event.
You can use an asterisk (*) as a wildcard character for this option.

When did the event occur?
The time frame in which the events occurred. The default setting is Don't remember.

Advanced options
You can use the advanced options to further expand or restrict the event search. Select one or more of the advanced options.

Save Query button
Click Save Query to save the search criteria as a tabular query that you can later run on the Reports page.

You can launch the Event Wizard from search results.

To search events
1 In the management console, click Monitors.
2 Under the Monitors tab, click Events.
3 On the Monitors page, in the Event Tasks pane, click Search Events.
4 In the Event Search dialog box, specify the search criteria.
   The search criteria that you specify must match the events exactly. The only exceptions are resource (advanced options) and a word or phrase in the description. For these options, you can use an asterisk (*) as a wildcard character in the text string.
5 (Optional) To save the search criteria as a query, click Save Query.
   The New Query Wizard dialog box appears. Create a query using the search criteria that you specified.
6 In the Event Search dialog box, click Search.
   Events that match your search criteria are displayed in the Event Search dialog box, in the event pane.
Grouping events in the console by event type

The DCS:SA console lets you view the generated events grouped together in the **All events** pane.

To view event groups

1. In the DCS:SA management console, go to **Monitors > Events**.
2. In the left-hand pane, in the **Group By** section, click **Event Type**.

   In the **All events** pane, you can view events based on the event type. You can collapse or expand the groups by using the arrow.

Acknowledging an event

You can acknowledge the events that you view in the **All Events** pane. When you acknowledge an event, the event notification is removed from the events list.

To acknowledge an event

1. In the DCS:SA management console, go to **Monitors > Events**.
2. Right-click an event or a group of events, and then click **Acknowledge**.
3. In the **Acknowledge Event** dialog box, enter a brief description about the acknowledgement, and then click **Submit**.

Resolving events

You might need to adjust the DCS:SA policies to resolve events that you see on the Monitors page.

The process of resolving events involves the following:

- You must decide whether to allow an event (in the case of prevention policies) or not log an event (in the case of detection policies).
- You must decide which policy modification strategy to use with an event (for example, add to a resource list, make a program privileged).
- You must decide which policy modification actions to perform (for example, enable or disable a policy option, add a value to a parameter list).
- You must decide which policies to modify.

To help you resolve events, DCS:SA provides the following console features:

- Event Details
- Event Agent
Using the Event Details command

You use the Event Details command to view detailed information that pertains to a selected event. The Event Details command displays a separate, resizable window that lets you quickly step through events, one event at a time, as the events are being sent to the management server. The Event Details window is tied to a selected event, so that when the Monitors page changes, the Event Details window also changes.

Please note the following about the Event Details command:

- You can display multiple Event Details windows. For example, you can display one Event Details window to monitor prevention events, and a second Event Details window to monitor detection events.
- You can display Event Details windows alongside other management console windows.
- You can invoke the Event Details command from the Monitors page (including real-time monitors), the Recent Events tab, and the History tab.
- You can copy events from the Event Details window to the Windows clipboard.
- You can invoke the Event Wizard command from the Event Details window.

To use the Event Details command

1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, select an event, and then right-click Event Details.
4. In the Event Details window, click the Next Event and Previous Event icons to scroll events.
5. In the Event Details window, click the blue computer icon to show the agent that reported the selected event.
6. In the Event Details window, click the Copy To Clipboard icon to copy the details of the event that is currently displayed to the Windows clipboard.

Using the Event Agent command

You use the Event Agent command to show the agent that reported a selected event. The Event Agent command displays the properties of the agent that reported the event.
To use the Event Agent command

1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, select an event, and then right-click Event Agent to display the properties of the agent that reported the selected event.

You can also invoke the Event Agent command by clicking the blue computer icon.

4. Click OK.

Using the Event Policy command

You use the Event Policy command to display a read-only version of the policy that caused a selected event. The Event Policy command displays the policy’s current settings, changes made to the base policy, and changes made to the workspace policy.

You can invoke the Event Policy command from the Monitors page and the Recent Events tab.

The Event Policy command is not available for every type of event.

To use the Event Policy command

1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, select an event, and then right-click Event Policy to display a read-only version of the policy settings.

4. Click OK.

Using the Event Wizard command

The Event Wizard offers a guided, interactive dialog that walks you through the policy adjustment process, from choosing a policy modification strategy to modifying a policy.

The Event Wizard walks you through the following choices:

- Which policy modification strategy to use with an event (for example, add to a resource list, make a program privileged)
- Which policy modification actions to perform

The Event Wizard recommends actions to perform. You can disable any or all of the actions.
The actions include the following:

- Enable a policy option
- Disable a policy option
- Add a value to a parameter list
  If a recommended action includes adding values to a parameter list (for example, a file path or network IP address), the Event Wizard lets you edit the values. You can convert an IP address into a subnet, or add wildcard characters to a file path.

- Which policies to modify
  You must browse your policy workspace and select the policies that you want to modify. The Event Wizard modifies workspace policies. It does not modify policies that are applied to agents and groups.

Examples of the options and parameters that the Event Wizard uses to configure policies for an agent computer are as follows:

**Resource lists**
You use resource lists to tailor the control of specific resources and define how they can be accessed by a service or interactive program. You can list file paths, registry paths, network ports, or IP addresses. The resource lists are provided at the global, group, and individual process set levels.

Applies to prevention policies

**Alternate privilege lists**
You use alternate privilege lists to change the privileges given to processes on an agent computer. You can apply alternate privilege lists to a service, interactive program, user, or user group. There are several reasons why you might change the privilege level of a user or program. For example, to give a user or group access to all resources on an agent computer, you would assign full privileges to the user or group. If a program is being denied access to multiple resources, you would increase the privilege level for the program.

Applies to prevention policies

**Basic options**
Basic options are provided at the individual level. These options are specific to the individual service or interactive program for which they are offered. Basic options provide configuration features specific to a service or interactive program. The prevention policies do not provide basic options for every individual program; they are only present when unique controls are necessary for a program.

Applies to prevention policies
Rule enable/disable

Each rule in a detection policy is controlled by its own option. If the option is enabled, the rule is enforced. If the option is disabled, the rule is not enforced.

Applies to detection policies

Exception lists

Some detection policies monitor a large set of files or registry settings. These files or registry settings often have associated exception (ignore) lists, so that you can easily configure monitoring an entire directory, while not monitoring one file in the directory that is noisy.

Applies to detection policies

The Event Wizard walks you through a series of wizard pages. You follow each page by clicking Next or Back.

The Event Wizard highlights the policy which causes an event and uses that policy as the default policy in subsequent invocations of the Event Wizard. If you modify multiple policies, the Event Wizard remembers the policies and selects them by default in subsequent invocations. This policy memory is retained for the current management console login session.

When using the Event Wizard, please note the following:

- You must manually apply the modified policies to agents and groups.
- If the modified policies do not work as intended, you can invoke the Event Wizard again and select another policy modification strategy.
- If you want to revert the policy modifications made by the Event Wizard, you must manually edit the policies.
- The Event Wizard is not available for use with every event. Use of the Event Wizard depends on the information contained in an event.
- You can launch the Event Wizard from the Monitors page (including real-time monitors), Event Details window, and the Recent Events tab.
- You can use the Event Policy command to view the policy that caused a selected event.

To use the Event Wizard command

1. In the management console, click Monitors > Events.
2. In the All events pane, right-click an event or a group of events, and then select Event Wizard.
3. In the Select policies to modify panel, select the policies that you want to modify and then click Next.
4 In the **Choose a modification strategy** panel, select the strategy that best suits your requirements, and then click **Next**.

5 In the **Review the changes** panel, select the action and then click **Finish**.

The actions are prioritized based on Symantec's recommendations, with the preferred actions presented first.

### Displaying text instructions for suppressing event transmission

The Event Wizard provides on-screen, step-by-step text instructions that explain how to suppress event transmission.

**To display text instructions for suppressing event transmission**

1 In the management console, click **Monitors**.

2 Under the **Monitors** tab, click **Events**.

3 In the events pane, select an event, right-click **Event Wizard**, and then select **How to suppress event transmission**.

To copy the on-screen text instructions to the Windows clipboard, select all the text in the **Action Details** pane, and then press Ctrl+C. You can paste the contents of the clipboard into a text document.

### Suppressing events on the console

There may be certain events, on which you do not want to take any immediate action, but log them in the database for future analysis. You may not want such events to be displayed on the console every time they are reported. In Symantec Data Center Security: Server Advanced 6.0, you can suppress the events that you want to be displayed on the console by using the suppression strategy.

**To suppress events on the console**

1 In the management console, go to **Monitors > Events**.

2 In the **Events** view, select the group of events that you want to remediate, right-click and then click **Event Wizard**.

3 In the **Event Groups** panel of the **Multi Event wizard**, select a grouping attribute.

4 Click **Next**.

5 In the **Events** tab, select the events and then select the **Strategies** tab.

6 In the **Strategies** tab, select **Suppress event transmission** and then select the **Actions** tab.
7. In the Actions tab, click Next.

8. In the Select policies to modify panel, select the policy that you want to modify and then click Next.

9. In the Select a config panel, select a configuration parameter, and then click Next.

10. In the Apply the config changes panel, click Update.

11. In the Submit Changes dialog box, write a brief description about the configuration changes you have made in the policy, and then click Submit.

12. In the Apply the policy changes panel, click Finish.

Selecting a strategy for a selected group of events

DCS:SA lets you specify a strategy for a selected group of events. You can select a strategy by using the Event Wizard.

You can select any of the following strategies:

- **Protected Whitelisting**: Lets you opt for a security posture that denies access to all applications that are not listed.

- **Hardened**: Lets you opt for a security posture that allows behavior control for known applications as defined by Symantec.

- **Basic**: Lets you opt for a security posture that allows basic protection for all applications that are not configured in the policy.

To select a strategy for a selected group of events

1. In the management console, go to Monitors > Events.

2. Select a group of prevention or detection policies, right-click and then select Event Wizard.

3. In the Event Grouping panel, select one of the options to classify the events that you have selected and then click Next.

   The groups are created on the basis of the events that you have selected on the Events page.

4. In the Select policies to modify panel, select the policy that you want to modify and then click Next.

5. Select the agents and then click the Strategy tab to specify the strategy for the events that the agent reported.
6. In the **Events** tab, select an event.
7. In the **Strategy** tab, select a strategy.
8. In the **Actions** tab, review the action details and then click **Next**.
9. In the **Apply the policy changes** panel, click **Update**.
10. In the **Submit Changes** dialog box, enter a description and then click **Submit**.
11. Click **Finish**.

### Updating the configuration rules for suppression strategies

While remediating events, you can use the **Event Wizard** to modify the configuration rules for suppression strategies. You can update the strategies for a single event or a group of events.

#### Updating the configuration rules for suppression strategy

1. From the **Monitors** tab, right-click single or multiple events and then select **Event Wizard**.
2. In the **Review the changes** panel, in the **Action Details** section, select a transmit action and then click **Next**.
3. In the **Select a config** panel, select a configuration parameter and then click **Next**.
4. In the **Apply the config changes** panel, in the **Status** section, click **Update**.

### About real-time monitors

You use real-time monitors to view events as they are sent in real time to the management server. Real-time monitors are useful for viewing recent events that you might have missed, and to aid in troubleshooting.

When using real-time monitors, please note the following:

- Newest events are listed first.
- You can create and view multiple real-time monitors. Shown as a separate, resizable window, each real-time monitor has its own filter rules and preferences. The All Events monitor, which displays all events, is the default real-time monitor.
- You can adjust policies for events in real-time monitors.
- You can use the Event Details command with real-time monitors.
The following commands are available for use with real-time monitors:

- Open Monitor
- New Monitor
- Copy Monitor
- Import Monitor
- Export Monitor
- Refresh
- Delete Monitor
- Rename Monitor
- Properties

The real-time monitors that you create can be accessed by you and other users who share your management console login account (for example, the default symadmin account). If you do not want other users to access your real-time monitors, then log on to the management console using an account that you use exclusively, and create your real-time monitors.

Viewing a real-time monitor

You can open multiple real-time monitors simultaneously.

To view a real-time monitor

1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, in the Real-Time Monitors pane, select a monitor, and then right-click Open Monitor.

Creating a real-time monitor

You can create multiple real-time monitors. Each real-time monitor has its own filter rules and preferences.

To create a real-time monitor

1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, in the Real-Time Monitors pane, click New Monitor.
4. In the New Real-Time Monitor dialog, on the General tab, type a name and description for the monitor.
5. In the **Filter Rules** tab, select **Include** or **Exclude** as the default action.

6. Click **OK**.

**Adding a filter rule**

A filter comprises rules that describe event criteria. When the filter rules match an event in a real-time monitor, the event is either included in or excluded from the real-time monitor. The rules in a filter are processed in the order in which they appear. Events must match all filter rules.

Each filter rule comprises `<field, operator, value>`.

When configuring filter rules, please note the following:

- Examples of valid fields include event type, event severity, event date, disposition, event priority, process, user name, remote IP.

- Examples of valid operators include equals, not equals, in, not in, contains, not contains, greater than, less than. Some operators support the use of wildcard characters in a value. Valid wildcard characters are asterisk (*), which represents zero or more consecutive characters, and question mark (?), which represents exactly one character.

- Valid values vary, depending on the field. Some fields are limited to a pre-defined list, while other fields allow free-form typing.

**To add a filter rule**

1. On the Monitors page, select a real-time monitor, and then right-click **Properties**.

2. In the monitor properties dialog box, on the Filter Rules tab, click the **Add Rule** icon.

3. In the **Filter Rule Editor** dialog box, select **Include** or **Exclude**.

4. In the **Filter Rule Editor** dialog box, select `<field, operator, value>`, and then click **Add**.

   Repeat this step to add additional filter rules.

5. To edit an existing filter rule, edit `<field, operator, value>`, and then click **Update**.

6. Click **OK**.

7. In the monitor properties dialog box, select the **Default Action for Unmatched Events** (Include or Exclude).

8. Click **OK**.
Searching events

You search events in real-time monitors just as you would search events on the Monitors page.

To search events
1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, select a real-time monitor, and then right-click Open Monitor.
4. In the Real-Time Event Monitor dialog box, click the Search Events icon.

Removing an event from a real-time monitor

Events that you remove from real-time monitors are still visible on the Monitors page.

To remove an event from a real-time monitor
1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, select a real-time monitor, and then right-click Open Monitor.
4. In the Real-Time Event Monitor dialog box, select an event, and then right-click Remove.

Importing a real-time monitor

You can import real-time monitors that you or another DCS:SA administrator exported. Imported real-time monitors are owned by the user who imported them.

To import a real-time monitor
1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
   Right-click in the white space.
4. In the Import dialog box, browse to the real-time monitor .zip file that you want to import.
5. In the Import dialog box, click Import.
Exporting a real-time monitor

You can export real-time monitors that you own. The monitors are exported to .zip files.

To export a real-time monitor
1. In the management console, click Monitors.
2. Under the Monitors tab, click Events.
3. On the Monitors page, in the Real-Time Monitors pane, select a monitor, and then right-click Export Monitor.
4. In the Export To dialog box, specify the following information:
   - Look In: Select the location where you want to store the exported file.
   - File Name: Accept the default file name or type a new file name. By default, a real-time monitor is exported to a .zip file named [monitor_name].zip, where [monitor_name] is the name of the real-time monitor being exported.
   - Files of Type: Select Zip files.
5. In the Export To dialog box, click Export.

Remediating bulk events

Symantec Data Center Security: Server Advanced 6.0 adds the capability to remediate bulk events from the management console. Bulk remediation makes the policy tuning actions faster and easier. You can select a set of events and run the event wizard on it. You can perform bulk remediation from the Events view and from the Alerts view of the management console.

To remediate bulk events from the Events view
1. In the management console, go to Monitors > Events.
2. In the Events view, select the group of events that you want to remediate, right-click and then click Event Wizard.
3. In the Event Grouping panel of the Multi Event wizard, select a grouping attribute.
   The groups are created on the basis of the events that you have selected on the Events page.
4 In the Select policies to modify panel, select the policy that you want to modify and then click Next.

5 Select the agents and then click the Strategy tab to specify the strategy for the events that the agent reported.

6 In the Events tab, select an event.

7 In the Strategies tab, select one of the available strategies and then select the Actions tab.

8 In the Actions tab, uncheck Perform This Action if you want to disable the already specified action and then click Next.

9 In the Apply the policy changes panel, click Update.

10 In the Submit Changes dialog box, write a brief description about the changes you have made in the policy, and then click Submit.

11 In the Apply the policy changes panel, click Finish.

Exporting events

DCS:S offers the option to export events to a CSV file. You can view the comma-separated value (CSV) file by using a text editor or a spreadsheet program.

To export events

1 Navigate to Monitors > Events.

2 On the All Events page, select the events that you want to export, and then click the Export icon.

To export multiple events, hold down the Shift or Ctrl key while you select the events. To export the current page or all pages, you need not select the events.

3 In the event-export dialog, specify the following information:

   Open with
   Save File
   Do this automatically for files like this from now on

4 Click OK.

See “About events” on page 190.
Purging events

You can specify how long to retain real-time, profile, and analysis events in the DCS:S database.

To purge events

1. Click Settings.

2. In the System page, under the Event Management section, use the following options to configure the purge settings:

   - **Purge Real-Time Events older than <number of> day(s) (1 to 999999)**
     - Check to purge the real-time events from the database upon reaching the specified threshold.
     - The default value is 365 days.

   - **Purge Profile Events older than <number of> day(s) (1 to 999999)**
     - Check to purge the profile events from the database upon reaching the specified threshold.
     - The default value is 60 days.

   - **Purge Analysis Events older than <number of> day(s) (1 to 999999)**
     - Check to purge the analysis events from the database upon reaching the specified threshold.
     - The default value is 60 days.

**Note:** When a guest virtual machine is deleted from your VMware infrastructure, DCS:S deletes all information about that guest virtual machine including the command history for the guest virtual machine after you refresh the VMware Inventory.

See “About events” on page 190.
Managing alerts

This chapter includes the following topics:

- About alerts
- Viewing the Alerts page
- Configuring alert settings
- Creating an alert
- Creating an alert configuration
- Enabling or disabling an alert
- About copying alerts
- Importing an alert
- Exporting an alert
- Deleting an alert
- Purging alerts

About alerts

You use alerts to send events of interest to email messages, SNMP traps, and text files.

The Alert module polls the DCS:S database for events that match an alert filter. When a match is found, the Alert module generates and sends email messages, SNMP traps, and text files that are associated with the alert.
About email aggregation

Email aggregation combines all email messages that are sent to an email address, over a specified aggregation time interval, into a single email message.

There are two criteria for aggregation: time interval and maximum email message size. Email aggregation prevents flooding email addresses with too many messages or with messages that exceed size limitations. (Some email accounts may reject email messages based on message size.)

The aggregation time interval starts when the Alert module is first started or immediately after sending emails for alerts from the last time interval. Once the specified number of minutes has elapsed, an email message is sent to the email address with all the alerts over that time interval.

Email alerts aggregation uses the following rules:

- First-level aggregation:
  Combine similar repetitive alerts, over a specified time interval, into a single alert that includes aggregation start time, aggregation end time, and the number of events aggregated along with event information.

- Second-level aggregation:
  Aggregation occurs at the end of an aggregation time interval where multiple aggregated alerts and individual alerts are combined into a single email message. Alerts are written into the body of the email message, sorted by time of occurrence. The first alert that occurs is written at the top of email message body. The last alert to occur is written at the bottom of the email message body. For aggregated alerts, time of occurrence is the time of occurrence of the first event.

In any given aggregation time interval, only one email message is sent to one email address, unless the size of the email body exceeds the maximum specified size. In this case, the data is split into multiple email messages.

About SNMP traps

The Alert module polls the management server database for new events at every user-specified event polling interval. An SNMP trap is generated and dispatched over the network for each event that matches a user-specified alert filter. The Alert module generates one trap for each alert.

The Alert module sends the following types of SNMP traps:

- None: No SNMP trap is sent.
Basic
A basic trap contains the alert name, policy name, rule name, agent computer name and IP address, and event type.

General
A general trap contains the alert name, policy name, rule name, event date, agent computer name and IP address, user name, event severity, event priority, event disposition, event type, event count, event operation, OS type, process name, local IP address, local port number, remote IP address, remote port number, product version, target information, and description.

About alert text files
An alert text file contains events of interest; the alert text file can contain text strings and event fields. The alert text file is created when an alert captures an event of interest; subsequent events are appended to the file.

The DCS:SA detection policy Global_Watch_Policy monitors alert text files. When an event in an alert text file matches the criteria specified in the policy, the policy sends the event to the java console.

About troubleshooting alert problems
A separate log file is used to record any problems that occur when sending SNMP traps and email alerts. You can use this file to help debug alert problems.

By default, the alert log file is stored in the following directory:
C:\Program Files\Symantec\Data Center Security Server\Server\Tomcat\logs\sis-alert.log

The question mark (?) in the log file name is the sequence number. When the management server rotates the log file, the current log file is closed and nothing more is written to it. A new log file is opened with the same base file name, but with the next highest sequence number added to the file name. The active log file uses sequence number 0 (for example, sis-alert.0.log). Inactive (rotated) log files use sequence numbers 1 through n.

Viewing the Alerts page
You use the Alerts page in the DCS:S to create and store the alerts that you send to users when specific events are observed.

You can do the following activities from the Alerts page:
• Configure alert settings.
• Create, edit, copy, delete, import, and export alerts.
- Specify alert filters, thresholds, SNMP traps, alert text files, and email addresses.
- Enable and disable alerts.

**To view the Alerts page**

1. Navigate to **Monitors > Alerts** in UMC.
2. In the **Alerts Configurations** page, double-click an alert to view your settings.
3. (Optional) To expand or collapse the panes in the Alerts page, click the size arrows.

See “About alerts” on page 214.

### Configuring alert settings

The Alert Module uses alert settings to get polling intervals and email settings.

**To configure alert settings**

1. Click **Settings**.
2. In the **System** page, navigate to **Alert Management** section.
3. In the **Alert Management** section, specify the following alert settings:

   - **Purge alerts older than**
     - The alerts will be purged for the number of days specified.
     - Default value is 30 days.

   - **Configuration Polling Interval**
     - The frequency, in minutes, at which the Alert module polls for changes to the alert settings.
     - Default value is 5 minutes.

   - **Event Polling Interval**
     - The frequency, in minutes, at which the Alert module polls the DCS:S database for events.
     - The event polling intervals, in minutes.
     - Default value is 5.

   - **email aggregation, Interval (event polling)**
     - Select this check box to enable email aggregation, and then specify the Aggregation Interval.
     - Default value is 2.

   - **Aggregation Interval**
     - If email aggregation is enabled, aggregate emails are sent based on the frequency that you specify.

   - **Maximum email size**
     - The maximum email message size, in KB.
     - Default value is 1024.
4 Click **Save** (save the current setting changes) or **Revert** (revert to the last settings that were saved).

5 Click **Refresh** to apply the alert updates.

See “About alerts” on page 214.

Creating an alert

Alerts notify users when specific events are observed by DCS:S.

Alerts comprise of the following components:

- Alert filters
- Email address templates
- SNMP traps
- Alert text files

To create an alert

1. Navigate to **Monitors > Alerts** in UMC.
2. On the Alerts page, in the toolbar, click **Add** icon.
3. In the **New Alert** dialog box, on the **General** tab, specify the following alert information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the alert.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the alert.</td>
</tr>
</tbody>
</table>
   | Show this alert on my Dashboard | Select this check box to display this alert on my Dashboard.  
   |                              | The alert is enabled by default. You can enable and disable an alert after you create it. |

4. Edit the alert to specify filters, email address templates, SNMP traps, and text file.

Creating an alert filter

You use alert filters to specify which events you want DCS:S to observe.

When configuring alert filters, please note the following:

- Each filter rule comprises `<field, operator, value>`.
- Examples of valid fields include event type, event severity, event disposition, OS type, local IP address, remote IP address, host name.
Examples of valid operators include equals, not equals, in, not in, contains, not contains, greater than, less than. Some operators support the use of wildcard characters in a value. Valid wildcard characters are asterisk (*), which represents zero or more consecutive characters, and question mark (?), which represents exactly one character.

Valid values vary, depending on the field. Some fields are limited to a pre-defined list, while other fields allow free-form typing.

The Preview Events button on the Filters tab lets you preview recent events that match the alert filters.

To create an alert filter

1. Navigate to Monitors > Alerts in UMC.
2. Under the Monitors tab, click Alerts.
3. In the Alert Configurations pane, click on an alert for which you want to create a filter.
4. In the Edit Alert page, under Filters section, select <field, operator, value>, and then click Add.
5. Repeat step 4 to add additional rules.
6. To edit an existing filter rule, edit <field, operator, value>, and then click Update.
7. To preview filtered events, click Preview Events.
8. Click Save.

Specifying an email address template

An email address template contains the email addresses that you want to receive the alert.

When including event date fields in the subject and body of an email message, you can select UTC or local agent date/time.

To specify an email address template

1. Navigate to Monitors > Alerts in UMC.
2. Under the Monitors tab, click Alerts.
3. In the Alert Configurations pane, click on an alert.
4. In the Edit Alert page, under the Email section, click Add.
5. In the Email Template dialog box, specify the following information:
**To**
In a comma-separated list, type the email addresses that you want to receive the alert.

**Subject**
Specify the subject of the email:
- Type the text that you want to include in the subject line of the email.
- Select the event fields that you want to include in the subject line.

**Body**
Specify the email message:
- Type the message that you want to include in the email body.
- Select the event fields that you want to include. Select Insert All to insert all of the available event fields, with each field shown on a separate line.

6 Click **Save**.
7 In the **Emails** section, click **Enable** to enable the email address template.

All email addresses contained in the template will receive the alert. If you do not want to send the alert at this time, check **Disable**.

8 Click **Save**.

**Specifying an SNMP trap**
You configure the following when specifying an SNMP trap:
- Type of SNMP trap to send
- Server to which the SNMP trap is sent
- Port numbers used by the SNMP server

**To specify an SNMP trap**
1 Navigate to **Monitors > Alerts** in UMC.
2 In the **Alert Configurations** pane, click an alert to which you want to specify an SNMP trap.
3 In the alert dialog box, on the SNMP tab, specify the following information:

  **Server**
  Type the SNMP server address.

  **Server Port**
  Type the server port number used by the DCS:S when it connects to your SNMP server.
  Default: 162
Local Port  Type the local port number used by the DCS:S when it connects to your SNMP server. Optional.
Default: 161

Community  Type the SNMP community name used when sending SNMP traps.
Default: Public

Trap level  Select the type of SNMP trap that you want to generate when an alert is triggered.
Select one of the following SNMP trap types:
- None
- Basic
- General
See “About SNMP traps” on page 215.

4  Click Save.

Specifying an alert text file

You can set up an alert text file to save events of interest. The alert text file can contain text strings and event fields. The file is created when the alert captures an event; subsequent records are appended to the file.

An alert text file is stored on the DCS:S computer. The default alerts directory is as follows:

C:\Program Files\Symantec\Data Center Security Server\Server\alerts\n
The DCS:SA detection policy Global_Watch_Policy monitors alert text files. When an event in an alert text file matches the criteria specified in the policy, the policy sends the event to the java console.


To specify an alert text file

1  Navigate to Monitors > Alerts in UMC.

2  In the Alert Configurations pane, click on an alert.
3 In the Edit Alert page, under the **File** section, specify the following information:

- **Name**: Type the name of the alert text file. The file name may not contain any backward slashes.
- **Append Text**: Type the text to save in the alert text file. The text can include event fields, selected form the menu.

4 Click **Save**.

See “About alerts” on page 214.

### Creating an alert configuration

DCS:S lets you configure notification alerts for events. For example, you want a notification to be displayed on the console when 100 file access events are reported within a timeframe of 5 minutes on an agent. You can configure an alert by using the **Add New Alert** page.

**To create an alert configuration**

1. Navigate to **Monitor > Alerts** in UMC.
2. In the **Alert Configurations** page, click **Add** icon to launch the **Add New Alert** page.
3. In the **Add New Alert** page, do the following in each section and then click **Save**.

<table>
<thead>
<tr>
<th>Section</th>
<th>Action required</th>
</tr>
</thead>
</table>
| **General** | ■ **Name** - Enter a name for the alert that you want to create.  
■ **Description** - Enter a brief description about the alert that you want to create. This is an optional step.  
■ **Show this alert on my Dashboard** - Check to enable the alert to appear on your dashboard. |
| **Filters** | ■ Select the parameters of the rule and then click **Add**.  
■ Click **Preview Events** to view the events that match the filter that you are adding to the new alert. |
Section | Action required
--- | ---
Threshold | ■ **Minimum events** - Enter the number of events that should trigger an alert notification. For example, 100 file access events within `<number of>` minutes should trigger an alert notification.
■ **Timeframe** - Enter the time in minutes that should be the threshold for the alert notification. For example, `<X number of>` file access events within a time window of 5 minutes should trigger an alert notification.
■ **Select attributes to group events** - Select an attribute.
SNMP | ■ **Server Name** - Enter the server name
■ **Community** - Enter a value.
■ **Trap level** - Select a level for the alert from the drop-down list.
File | ■ **Name** - Enter a name for the alert configuration file that you want to create.
■ **Append Text** - From the drop down list, select the event details that you want to add in the alert configuration file. When you enter the first few characters, the associated values appear in the drop-down.
■ **Add Summary Text** - Select this option if you want to add the default summary into the Append Text field.
### Enabling or disabling an alert

Enabled alerts send email messages and SNMP traps. Disabled alerts do not send email messages and SNMP traps.

**To enable or disable an alert**

1. Navigate to **Monitors > Alerts** in UMC.
2. In the **Alert Configurations** pane, select an alert and do one of the following:
   - To enable an alert, click **Enabled**.
   - To disable an alert, click **Disable**.

See “About alerts” on page 214.

### About copying alerts

The DCS:S Copy Alerts function lets you create copies of alerts. For example, if there are existing alerts with complex filters and you want to create another alert with similar filters and some additional filters, you can copy an existing alert and add the required filter to it instead of creating an alert from the start.
The copied alert appears in the format **Copy of Alert name**. For example, a copied alert for an existing alert named ALERT1 would appear as Copy of ALERT1.

### Creating copies of alert

**To create copies of alert**

1. Navigate to **Monitor > Alerts** in UMC.
2. In the **Alerts Configuration** pane, select an alert, and click **Copy** icon.

See “About alerts” on page 214.

### Importing an alert

You can import an alert in DCS:S. The alert which you want to import can be an alert previously exported from another DCS:S system.

The DCS:S imports the alerts to the alerts page.

**To import alerts**

1. Navigate to **Monitor > Alerts** in UMC.
2. To import an alert, click **Import**.
   
   The alert that you import must be a .zip file.
3. In the **Import** dialog box, browse to the alert zip file that you want to import.
4. Click **Import** to import the alert zip file.

See “About alerts” on page 214.

### Exporting an alert

You can export an alert from DCS:S.

Exported alerts are saved in .zip files.

**To export policies**

1. Navigate to **Monitor > Alerts** in UMC.
2. On the Alerts page, select the alerts which you want to export, and then click **Export**.
   
   To select multiple policies, hold down the Ctrl key while selecting the files.
In the Export dialog box, browse to the folder where you want to export the alerts.

In the Export dialog box, in the File Name box, type a name for the export file, and then click Export.

The selected alerts are exported to a .zip file, using the file name that you specified.

See “About alerts” on page 214.

Deleting an alert

You can delete alerts that you no longer need.

To delete an alert

1. Navigate to Monitor > Alerts in UMC.
2. In the Alert Configurations pane, select an alert, and then click Delete icon.
3. In the Confirm Deletion dialog box, click Yes to delete the alert.

See “About alerts” on page 214.

Purging alerts

You can specify how long to retain the alert notifications in the DCS:S database.

To purge alert notifications

1. Navigate to Admin > Settings in UMC.
2. In the System page, under the Alert Management section, check Purge Alerts older than <number of days>.

   The default value is 30 days.

   A batch of 1000 alert notifications can be purged at the same time.

See “About alerts” on page 214.
Managing queries and reports

This chapter includes the following topics:

- Viewing the Reports page
- About the Symantec queries and reports
- Managing queries
- Managing reports
- Publishing a query or report
- About the command-line query tool
- Using folders
- Copying a query or report
- Renaming a query or report
- Exporting queries and reports
- Importing queries and reports
- Deleting a query or report

Viewing the Reports page

You use the Reports page in the Symantec Data Center Security: Server java console to create and run Symantec Data Center Security: Server queries and reports.

You can do the following activities from the Reports page:
- Run the Symantec predefined queries and reports
- Create and run custom queries and reports
- Publish the results from queries and reports
- Import and export queries and reports
- Organize queries and reports in folders

To view the Reports page

1. In the **Symantec Data Center Security: Server** java console, click **Reports**.
2. Under the **Reports** tab, click **Reports**.
3. On the Reports page, in the Reports pane, double-click the **Symantec** folder to list the Symantec reports.
4. On the Reports page, double-click a folder to expand or collapse the panes on the Reports page.

To view the Queries page

1. In the **Symantec Data Center Security: Server** java console, click **Reports**.
2. Under the **Reports** tab, click **Queries**.
3. On the Queries page, in the Queries pane, click the **Symantec** folder to list the Symantec queries.

See “About the Symantec queries and reports” on page 228.

### About the Symantec queries and reports

Symantec Data Center Security: Server includes over 75 predefined queries and reports that provide an overall view of your deployed environment, and prevention, detection, and management activity.

### About the Symantec queries

The Symantec queries can help you identify groups with policies that provide no protection or only partial protection. The queries can help you identify agents that are disconnected from the network for a period of time or that are experiencing network connectivity issues.

The Symantec queries are grouped by the following categories:
Agents
Agent queries provide information about the following:
- Agent details, such as host name, IP address, agent version, asset network path, and OS version
- Agent counts based on OS type and version
- Offline agents that are not communicating with the management server
- Agents with no prevention policies or with overridden policies
- Counts of registered agents for each network path
- Duplicate agents

Events
Event queries provide information about agent, prevention, detection, and management events, including information about the following:
- Agent event counts for all agents
- Agent event counts by day, week, month
- Event counts grouped by disposition, event type, OS network
- Event severities
- Event types

Homepage
Home page queries provide information about agent and event statistics for the console views, including information about the following:
- Agents with errors
- Agents that are offline
- Agents with configurations pending
- Agents with policies pending

Policies
Policy queries provide information about policy attributes. Policy queries include a glossary of all process sets and operating systems.

Security
Security queries provide information about the following:
- Audit detail records by date/time
- Audit detail records for failed logins
- Users, roles, last login dates

Status
Status queries provide information about the following:
- Event statistics
- DCS:SA objects by name and type
- System statistics
- Workload

The Symantec queries are stored in the Symantec folder. The folder name includes the date that Symantec released the queries.

You can use the Symantec queries as the basis for custom query development.
To view a description of a Symantec query, select the query, and then right-click Properties.

About the Symantec reports

The Symantec reports include the following samples, which illustrate how the report feature works:

■ The Last Week Event Charts report displays statistics about the previous week's events. The report uses the following Symantec event queries:
  ■ Event Counts By Day (weekly)
  ■ Top 10 Processes (weekly)
  ■ Top 10 Event Types (weekly)
  ■ Event Severities (weekly)

■ The Recent Event Summary is a two-page report that summarizes the number of events and corresponding event types. Page one shows the data for the last month; page two shows the data for the last week. The report uses the following Symantec event queries:
  ■ Event Counts by Day (weekly, monthly)
  ■ Top 10 Event Types (weekly, monthly)

The Symantec reports are stored in the Symantec folder. The folder name includes the date that Symantec released the reports.

To view a description of a Symantec report, select the report, and then right-click Properties.

See “Publishing a query or report” on page 244.

Managing queries

A query is a request for information from the Symantec Data Center Security: Server Advanced management server database.

Running a query

The results from running a query appear in a tab in the Report Results pane. Each time you run a query, another tab appears.
To run a query

1. In the Symantec Data Center Security java console, click Reports.
2. Under the Report tab, click Queries.
3. On the Queries page, in the Queries pane, select a query, and then right-click Run Query.
4. If the query prompts for input parameters, specify the parameter values, and then click Run query.
5. (Optional) Publish the results from running the query.
   See “Publishing a query or report” on page 244.
6. When you no longer need the query results, in the Report Results pane, click the query tab, and then click the green X icon to close the query results.
   To recover the query results, rerun the query.

Exporting query results to multiple file formats

You can export query results to a CSV, HTML, or PDF file.

To export query results to multiple file formats

1. Run the query.
2. In the Report Results pane, click the query results tab to make it the active tab.
3. Click the Export Results icon.
4. In the Export To dialog box, specify the following information:
   - **Look In**: Select the location where you want to store the file.
   - **Export range**: Select the export range.
     - For tabular queries, specify the export range (All pages, Current page, Selected rows).
     - For queries with images, specify the export range (All pages, Current page).
   - **File Name**: Type the name of the file you want to export.
   - **Files of Type**: Select the file format such as CSV, HTML, or PDF.
     **Note**: You can export the query output with images to a JPEG, HTML, or PDF file.
5. Click Export.
6 For the HTML and PDF file formats, type **Export Title** in the **Export** dialog box.

   The export title appears on the top-left corner of the query file that you export.

7 Click **OK**.

Creating a query

You create a query using the New Query Wizard.

The New Query Wizard prompts you to specify the following:

- Query chart type, query name, and data source
- Output columns
- Optional filters
- Optional input parameters

You follow each wizard page by clicking Next. To change a query selection, click Back to return to a previous wizard page.

To create a query

1 In the **Symantec Data Center Security** java console, click **Reports**.

2 Under the **Reports** tab, click **Queries**.

3 On the Queries page, in the Queries pane, select the folder in which you want to store the query, and then right-click **New Query**.

4 In the **New Query Wizard** dialog box, specify the chart type, query name, and data source, and then click **Next**.

   See “Selecting the general query parameters” on page 233.

5 In the **New Query Wizard** dialog box, select the output columns that you want to appear in the query, and then click **Next**.

   See “Selecting the query output columns” on page 234.

6 (Optional) In the **New Query Wizard** dialog box, add filters to expand or restrict the data source, and then click **Next**.

   See “Selecting the query filters” on page 235.

7 (Optional) In the **New Query Wizard** dialog box, create the query input parameters.

   See “Creating query input parameters” on page 236.
8 In the **New Query Wizard** dialog box, preview the results of the query, and then click **Finish** to save the query.

The query is saved in the folder that you selected. The icon next to the query name indicates the chart type that the query uses to display the query results.

9 Run the query to verify that the query works as needed.

### Selecting the general query parameters

General query parameters include the following:

<table>
<thead>
<tr>
<th>Chart type</th>
<th>Select from the following query chart types:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Table</td>
</tr>
<tr>
<td></td>
<td>■ Line graph</td>
</tr>
<tr>
<td></td>
<td>■ Area graph</td>
</tr>
<tr>
<td></td>
<td>■ Stacked area graph</td>
</tr>
<tr>
<td></td>
<td>■ Horizontal bar</td>
</tr>
<tr>
<td></td>
<td>■ Vertical bar</td>
</tr>
<tr>
<td></td>
<td>■ Horizontal stacked bar</td>
</tr>
<tr>
<td></td>
<td>■ Vertical stacked bar</td>
</tr>
<tr>
<td></td>
<td>■ Pie</td>
</tr>
</tbody>
</table>

The Preview feature illustrates each chart type.

<table>
<thead>
<tr>
<th>Query Name</th>
<th>Type a name for the query.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Select a data source.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When you run a query, the results are based on one of the following data sources:</td>
</tr>
<tr>
<td></td>
<td>■ Assets (agents)</td>
</tr>
<tr>
<td></td>
<td>■ Policies</td>
</tr>
<tr>
<td></td>
<td>■ All real-time events</td>
</tr>
<tr>
<td></td>
<td>■ Profile events</td>
</tr>
<tr>
<td></td>
<td>■ Analysis events</td>
</tr>
<tr>
<td></td>
<td>■ Console audit events</td>
</tr>
<tr>
<td></td>
<td>■ Catalog files</td>
</tr>
<tr>
<td></td>
<td>■ Assets and objects</td>
</tr>
</tbody>
</table>

| Advanced Query | Select this check box if you prefer to build the query SQL statement yourself. The next page in the wizard prompts you to enter the SQL statement. Only users who are assigned the Administrators role may select the Advanced Query box. |
|----------------|-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------
Fast Query Mode

Select this check box to build the query so that it runs in fast (no-lock) mode.

Fast mode does not guarantee consistent results.

## Selecting the query output columns

You select the output columns that you want to appear in your query.

The query output columns are as follows:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only get the top [100] results</td>
<td>This check box limits the total number of rows (records) that appear in a query. Select the check box, and then enter the number of rows. For example, suppose you create a query that displays all the events generated by an agent. The query could potentially yield thousands of events, but you only want to show the first 500 events. You would select the Only get the top [100] results check box, and then enter 500.</td>
</tr>
<tr>
<td>Distinct results</td>
<td>Select this check box to eliminate duplicate output rows.</td>
</tr>
<tr>
<td>Show [1000] results per page</td>
<td>Type the number of output rows that you want to display per page. Applies to queries that use the table chart type.</td>
</tr>
<tr>
<td>Column</td>
<td>Select a column that you want to appear in the query results.</td>
</tr>
<tr>
<td>Aggregate Function</td>
<td>Select the aggregate function. The aggregate function performs a calculation on a set of values and returns a single value shown as a column in the query results. Select one of the following options:</td>
</tr>
<tr>
<td>- Count</td>
<td>Returns the number of items in a group.</td>
</tr>
<tr>
<td>- Count Distinct</td>
<td>Returns the number of distinct items in a group.</td>
</tr>
<tr>
<td>- Sum</td>
<td>Returns the sum of all the values (or only the distinct values).</td>
</tr>
<tr>
<td>- Min</td>
<td>Returns the minimum value.</td>
</tr>
<tr>
<td>- Max</td>
<td>Returns the maximum value.</td>
</tr>
<tr>
<td>- Average</td>
<td>Returns the average of the values in a group.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Type the column heading text. By default, Display Name uses the Column name.</td>
</tr>
<tr>
<td>Display Width</td>
<td>Type the column width.</td>
</tr>
<tr>
<td>Move Up</td>
<td>To order a selected column, click Move Up and Move Down until the column is in the desired order.</td>
</tr>
<tr>
<td>Move Down</td>
<td></td>
</tr>
<tr>
<td>Remove</td>
<td>To remove a selected column, click Remove.</td>
</tr>
</tbody>
</table>
Add: To add a column to the query results, specify the column options, and then click Add to add the column to the column list.

Update: To save changes to a selected column, click Update.

Add All: To include all columns in the query results, click Add All.

Column list: This pane lists all the columns that appear in the query results.

Selecting the query filters

You use query filters to expand or restrict the data source. Each filter rule comprises <field, operator, value>.

For each filter rule, you specify the following:

Field: Select the field.

Examples of valid fields include event type, event date, event severity, event disposition, OS type, agent version, host name.

Required

Operator: Select the operator for the field.

Examples of valid operators include equals, not equals, in, not in, contains, not contains, greater than, less than. Some operators support the use of wildcard characters in a value. Valid wildcard characters are asterisk (*), which represents zero or more consecutive characters, and question mark (?), which represents exactly one character.

Required

Value: Specify the default value for the input parameter.

Valid values vary, depending on the field. Some fields are limited to a pre-defined list, while other fields allow free-form typing.

Optional

Group By: Select this check box to group the output columns.

Optional

Order By: Select this check box to sort an output column in ascending order or descending order.

Optional
To select the query filters

1. In the New Query Wizard dialog box, on the Configure the Filters page, select <field, operator, value>.
2. (Optional) Select the Group By check box to group the output columns.
3. (Optional) Select the Order By check box to sort an output column in ascending order or descending order.
4. Click Add.
5. Repeat steps 1-4 to add additional filter rules.
6. To edit an existing filter rule, edit <field, operator, value>, and then click Update.

Creating query input parameters

You can build a basic query with input parameters. When run, the query prompts for the parameter values.

For each input parameter, you specify the following:

- **Column** Select the input parameter.
  - Required
- **Operator** Select the operator for the input parameter.
  - The Between and Not Between operators are not available for input parameters. To allow a range specification, create separate parameters for the lower and upper bounds.
  - Required
- **Default Value** Specify the default value for the input parameter.
  - Optional
- **Require a non-empty value at runtime** Select this check box to force the query user to specify a value for the input parameter.
  - Optional
- **Display Name** Specify a custom display name for the input parameter. The display name appears when the query is run.
  - Optional
- **Description** Specify a description of the input parameter.
  - The description appears when the query is run. The description helps the user understand how to use the input parameter.
  - Optional
When building queries with input parameters, please note the following:

- Each input parameter comprises <column, operator> or <column, operator, default value>.
- Query users can save a specific instance of a query, which they can run repeatedly. If a query is refreshed (re-run) without being closed, the query uses the same input values.
- Query users can save a query with or without input parameters. When saving a query without input parameters, users must set fixed values for the input parameters.
- Queries with input parameters can be included in reports, and imported and exported.
- When a query with input parameters is published, the query user is prompted for values when the query is run. The query user is not prompted for the values when the published results are used.

The following instructions demonstrate how to create an input parameter to prompt for operating system. The default value is Windows, and users must select a value from a defined list. A non-empty value is required.

To create query input parameters

1. In the New Query Wizard dialog box, on the Configure the Parameters page, in the Column box, select OS Type.
2. In the New Query Wizard dialog box, on the Configure the Parameters page, in the Operator box, select Equals.
3. In the New Query Wizard dialog box, on the Configure the Parameters page, in the Default Value box, select Windows.
4. Select the check box to require a non-empty value at runtime.
5. In the Display Name box, type Operating System.
6. Click Add.

7. In the New Query Wizard dialog box, on the Configure the Parameters page, in the Column box, select OS Type.
8. In the New Query Wizard dialog box, on the Configure the Parameters page, in the Operator box, select In.
9. Select the check box to require a non-empty value at runtime.
10. In the Display Name box, type Operating System.
11. Click Add.
Creating a query to count the number of event types

The following query is provided as a tutorial in creating a query. The query counts the number events types. The query results are shown in a pie chart.

To create a query to count the number of event types

1. In the Symantec Data Center Security java console, click Reports.
2. Under the Reports tab, click Queries.
3. On the Queries page, in the Queries pane, select the folder in which you want to store the query, and then right-click New Query.
4. In the New Query Wizard dialog box, select Pie as the chart type, type Event types for the query name, select All Events as the data source, and then click Next.
5. In the New Query Wizard dialog box, specify the query output for the event types, and then click Add.
   - Column: Select Event Type.
   - Aggregate Function: Select Max.
   - Display Name: Type Event Type.
   - Display Width: Type 10.
6. In the New Query Wizard dialog box, specify the query output for the event type counts, and then click Add.
   - Column: Select Event Type.
   - Aggregate Function: Select Count.
   - Display Name: Type Event Counts.
   - Display Width: Type 10.
7. Click Next.
8 In the **New Query Wizard** dialog box, group the event types, and then click **Add**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Select Event Type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group By</td>
<td>Select the Group By check box.</td>
</tr>
</tbody>
</table>

9 Click **Next**.

10 Preview the query, and then click **Finish** to save the query.

**Creating a query to display event types and event severities**

The following query is provided as a tutorial in creating a query. The query lists event types and event severities. The query results are shown in a table.

To create a query to display event types and event severities

1 In the **Symantec Data Center Security** java console, click **Reports**.

2 Under the **Reports** tab, click **Queries**.

3 On the Queries page, in the Queries pane, select the folder in which to store the query, and then right-click **New Query**.

4 In the **New Query Wizard** dialog box, select **Table** as the chart type, type Event types and severity for the query name, select All Events as the data source, and then click **Next**.

5 Set up the event type column, and then click **Add**.

<table>
<thead>
<tr>
<th>Distinct results</th>
<th>Select the Distinct results check box to eliminate duplicate output rows.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Select Event Type.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Type Event Type.</td>
</tr>
<tr>
<td>Display Width</td>
<td>Type 20.</td>
</tr>
</tbody>
</table>

6 Set up the event severity column, and then click **Add**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Select Event Severity.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Type Event Severity.</td>
</tr>
<tr>
<td>Display Width</td>
<td>Type 20.</td>
</tr>
</tbody>
</table>
7 Click **Next**.
8 Click **Next**, to skip the filter.
9 Preview the query, and then click **Finish** to save the query.

### Editing a query

After you create a query using the New Query Wizard, you can go back and edit the query using the same wizard.

**To edit a query**

1. In the **Symantec Data Center Security** java console, click **Reports**.
2. Under the **Reports** tab, click **Queries**.
3. On the Reports page, in the Queries pane, select a query, and then right-click **Edit Query**.
4. In the **New Query Wizard** dialog box, modify the query using the New Query Wizard.
5. On the Reports page, in the Queries pane, select the query, and then right-click **Properties**.
6. In the query properties dialog, revise the revision number and query description, and then click **OK** to save your changes.

### Editing the Symantec queries

You can use the Symantec queries as the basis for custom query development. When editing a Symantec query, you should do the following:

- Make a copy of the Symantec query.
- Save the copy in your own folder.
- Edit the copy.

Some Symantec queries are edited using the New Query Wizard. Other Symantec queries can only be edited by modifying the SQL statement.

See “Publishing a query or report” on page 244.

### Managing reports

A report comprises one or more queries that are configured as a group and viewed in a single display.
Running a report

The results from running a report appear in a tab in the Report Results pane. Each time you run a report, another tab appears.

You use the report tool bar to save and print reports, adjust your view of a report, navigate the pages in a report, and add and delete report pages.

To run a report

1. In the Symantec Data Center Security java console, click Reports.
2. Under the Reports tab, click Reports.
3. On the Reports page, in the Reports pane, select a report, and then right-click Run Report.
   The report results are shown in the Report Results pane.
4. When you no longer need the report results, in the Report Results pane, click the report tab, and then click Close to close the report results.
   To recover the report results, rerun the report.

Creating a report


You can customize a report's appearance by including a title, header and footer, and your company's logo.

Reports support a maximum graphic size of 150x100 pixels.

To create a report

1. In the Symantec Data Center Security java console, click Reports.
2. Under the Reports tab, click Reports.
3. On the Reports page, in the Reports pane, select the folder in which you want to store the report, and then right-click New Report.
4. In the New Report Wizard dialog box, specify the report layout, name, and page size.
Report Layout  
Select one of the following report layouts:

- One Query—Each report page shows one query centered on the page.
- Two Horizontal Queries—Each report page shows two queries placed side by side.
- Two Vertical Queries—Each report page shows two queries placed one on top of the other.
- Four Queries—Each report page shows two vertical columns, with two queries in each column.

Report Name  
The name of the report.

PageSize  
Select a page size:

- Portrait—The report is created using a vertical page orientation.
- Landscape—The report is created using a horizontal page orientation.

5  Click Finish.

6  Edit the report to insert queries and customize the report appearance.

Editing a report

You can edit a report by doing the following:

- Insert queries in the report
- Change the report title
- Change the report's header and footer text
- Insert your company's logo
- Add and delete pages

To edit a report

1  In the Symantec Data Center Security java console, click Reports.

2  Under the Reports tab, click Reports.
3 In the **Reports** pane, select a report, and then right-click **Edit Report**.

The report is shown in the Report Results pane.

Use the following toolbar icons to adjust the report view and size, add and delete pages, save, and print:

- **Actual Size, Fit Page, Fit Width**, **Zoom In, Zoom Out, Zoom Ratio**
  - Use the icons to adjust your view of the report.

- **First Page, Previous Page, Next Page, Last Page, Go To Page**
  - Use these icons to navigate the report.

- **Add a page to the report**
  - Use these icons to add and delete report pages.

- **Delete current page from the report**
  - Use these icons to add and delete report pages.

- **Save to Disk**
  - Use the Save to Disk icon to save the report changes.

- **Print**
  - Use the Print icon to print the report.

4 To insert a query in the report, left-click the report and select **Insert Query**. Select a query from the list, and then click **Add**.

5 To customize the report title and header/footer text, select the placeholder for the title, header, or footer text, type the text that you want to insert, and then click **OK**.

6 To add your company's logo to the report, click the colored logo placeholder, browse to the directory that contains the logo, select the logo file, and then click **Open**.

7 To add a page to the report, click the **Add a page to the report** icon.

8 To delete a page from the report, click the **Delete current page from the report** (red X) icon.

9 To save the report changes, click the **Save to Disk** icon.

10 Run the report to verify the contents and appearance.

See “Publishing a query or report” on page 244.
Publishing a query or report

Publishing a query or report saves a snapshot of the graphic and/or tabular results from running a query or report.

When publishing a query or report, you should note the following:

- A published query or report is saved in a user-selected folder in the Published Results pane.
- The date and time that a query or report was published is included in the file name. For example:
  Last Week Threat Detection Report (Wed, Dec 18, 2013)
- You can view the published results for a query or report.
- You cannot change the contents of a published query or report. If you need to change the contents of a published query or report, you must edit the query or report, rerun it, and then publish the new results.
- Publishing a tabular query saves the first 10,000 rows of data.
- You can export published queries and reports to .zip files.
- You can export published reports as .html files.

To publish a query or report

1. In the Symantec Data Center: Server java console, click Reports.
2. Under the Reports tab, click Reports or Queries.
3. On the Reports or Queries page, select a query or report, and then right-click Publish Query or Publish Report.
4. In the Publish Query Wizard dialog box or Publish Report Wizard dialog box, select a folder in which to store the published query or report, and then click Finish.
   The published query or report is saved in the Published Results pane, in the folder that you selected.
5. To view a published query, select the query in the Published Results under Reports tab, and then right-click Run Query.
6. To view a published report, select the report in the Published Results under Reports tab, and then right-click View Published Report.

Exporting a published report

You can export a report in HTML format.
Exporting a published report creates a .html file that contains a snapshot of the graphic and/or tabular results from a report.

The published date and time is included in the .html file name as follows. For example:

Recent_Threat_Detection_Summary.html (Wed, Dec 18, 2013)


While exporting a report to HTML, a folder that contains the graphic images for the .html file is created in the same folder with the .html file.

The folder name uses the name of the .html file and the text .html_files. For example:


To export a published report

1. In the Symantec Data Center Security: Server java console, click **Reports**.
2. Under the **Reports** tab, click **Published Results**.
3. On the Reports page, in the **Published Results** pane, select a published report, and then click **Export**.
4. In the **Export to** dialog box, in the **Look In** box, browse to the location where you want to store the file.
5. In the **File Name** box, type a file name for the file.
6. In the **Files of Type** box, select the format as .HTML.
7. Click **Export** to export the report in the format selected in the **Files of Type** box.

See "Managing reports" on page 240.

---

### About the command-line query tool

The management console supports command-shell execution of previously defined DCS:SA queries and reports.

The following features are supported:

- Execution of basic and advanced queries
- Support for queries with input parameters
- Support for output in PDF, HTML, CSV, and JPEG format
- Support for publishing (to a Published Results folder for later use in the management console) or exporting (to a file on disk)
When using the command-line query tool, you must specify your DCS:SA login credentials. The command-line query tool authenticates your login credentials, and sets the operational context to obey all defined role-based access controls.

Your DCS:SA account must belong to the Query Tool Users role.

Running the command-line query tool

The command for running the command-line query tool is as follows:

```
sdcssquery.bat -u <username> -p <password> -q <inifile> -s <servername>
```

where:

- `<username>`: Your DCS:SA username. Required
- `<password>`: Your DCS:SA password. Required
- `<inifile>`: The name of the query configuration .ini file.
  
  You pass arguments to the command-line query tool using a query configuration .ini file. The configuration .ini file defines the query or report to run, the action to be taken (publish or export), and the runtime input parameters.
  
  The following sample file contains instructions for setting up a query configuration .ini file:
  
  ```ini
  [Export]
  server = "C:\Program Files\Symantec\Data Center Security Server\Console\query_template.ini"
  ```
  
  Required
- `<servername>`: The server name.
  
  Use this argument to set the server name if multiple servers were defined. The server name is displayed in the Server box on the DCS:SA management console login screen.
  
  Optional
To run the command-line query tool

1 Log on to the computer that runs the management console.
2 At a command prompt, navigate to the following directory:

   C:\Program Files\Symantec\Data Center Security Server\Console

3 At a command prompt, type and run the following (required arguments are shown):

   sdcssquery.bat -u <username> -p <password> -q <inifile>

Distributing query and report output

You can implement your own scheduling and report distribution capability. You can construct command scripts that are scheduled for periodic execution using the Windows Task scheduler, and distribute query and report output to interested parties using operating system tools or third-party packages.

Using folders

You use folders to organize your queries and reports. For example, you might use one folder to store your custom queries and another folder to store your published reports.

The default query folder is named Queries. The default report folder is named Reports.

Creating a folder

There is no limit to the number of folders that you can create. You can create nested folders within other folders.

Create folders so that you can organize your queries and reports efficiently. Name folders so that you can easily identify which queries and reports to assign to the folders.

To create a folder

1 In the management console, click Reports.
2 Under the Reports tab, click Queries or Reports.
3 In the Queries pane or the Reports pane, navigate to the folder under which you want to create the new folder.
4 Select the folder, and then right-click **New Folder**.

A new folder is created with the name New Folder.

5 Rename the folder, and then press the **Enter**.

**Moving a query or report to a folder**

You can move queries among the folders in the Queries pane. You can move reports among the folders in the Reports pane.

To move a query or report to a folder

1 In the management console, click **Reports**.

2 Under the **Reports** tab, click **Queries** or **Reports**.

3 In the **Queries** pane or the **Reports** pane, select the query or report that you want to move, and then right-click **Move To**.

You can also move a query folder to another query folder.

You can also move a report folder to another report folder.

4 In the **Move Query** dialog box, select the folder where you want to move the query or report.

To browse the folders in the Queries or Reports tree, double-click a folder.

5 Click **Move To** to move the query or report to the selected folder.

**Deleting a query or report folder**

You can delete a query folder or a report folder. The folder that you want to delete must be empty.

To delete a query or report folder

1 In the management console, click **Reports**.

2 To delete a query folder: Under Queries, in the Queries pane, select a folder, and then right-click **Delete**.

3 To delete a report folder: Under Reports, in the Reports pane, select a folder, and then right-click **Delete**.

**Copying a query or report**

You can make a copy of a query or report. You can save the copy as a backup copy, or customize the copy to create a new query or report. The copy is named
Copy_of followed by the name of the original query or report (for example, Copy_Policy Detail).

To copy a query or report
1. In the management console, click Reports.
2. Under the Reports tab, click Queries or Reports.
3. In the Queries pane or the Reports pane, select the query or report that you want to copy, and then right-click Copy Query or Copy Report.
4. Rename the copy, and then press Enter.

Renaming a query or report

You can rename a query or report.

To rename a query or report
1. In the management console, click Reports.
2. Under the Reports tab, click Queries or Reports.
3. In the Queries pane or the Reports pane, select the query or report that you want to rename, and then right-click Rename Query or Rename Report.
4. Enter a new name, and then press Enter.

Exporting queries and reports

Symantec Data Center Security: Server Advanced exports queries and reports to .zip files. You can share the exported queries and reports with other DCS:SA administrators.

Exporting a query

You can export a query or a query folder. Queries can be exported from the Queries pane or the Published Results pane.

To export a query
1. In the management console, click Reports.
2. Under the Reports tab, click Queries.
3. On the Reports page, navigate to and select a query or query folder.
4. To export a query, in the Queries pane, right-click Export Query.
5 To export a published query, in the **Published Results** pane, right-click **Export Published Results**.

6 In the **Export** dialog box, in the **Look In** box, browse to the location where you want to store the .zip file.

7 In the **Export** dialog box, in the **File Name** box, type a file name for the .zip file.

   Click **Export**.

   The selected query or query folder is exported to a .zip file using the file name that you specified. In the Exporting dialog box, each successfully exported query is marked with a green check mark.

8 Click **Close**.

### Exporting a report

You can export a report or a report folder. Reports can be exported from the Reports pane or the Published Results pane.

**To export a report**

1 In the management console, click **Reports**.

2 Under the **Reports** tab, click **Reports**.

3 On the Reports page, navigate to and select a report or report folder.

4 To export a report, in the **Reports** pane, right-click **Export Report**.

5 To export a published report, in the **Published Results** pane, right-click **Export Published Results**.

6 In the **Export** dialog box, in the **Look In** box, browse to the location where you want to save the .zip file.

7 In the **Export** dialog box, in the **File Name** box, type a file name for the .zip file.

8 Click **Export**.

   The selected report or report folder is exported to a .zip file using the file name that you specified. In the Exporting dialog box, each successfully exported report is marked with a green check mark.

9 Click **Close**.
Importing queries and reports

DCS:SA imports queries and reports from .zip files. You can import queries and reports that you obtained from other DCS:SA administrators.

Importing a query

The management console extracts the query from the .zip file. Queries can be imported to the Queries pane or the Published Results pane.

The imported queries are available in the selected folder in the Queries pane.

To import a query

1. In the management console, click Reports.
2. Under the Reports tab, click Queries.
3. On the Reports page, navigate to and select a folder to receive the imported queries.
4. To import a query, in the Queries pane, right-click Import Query.
5. To import a published query, in the Published Results pane, right-click Import Published Results.
6. In the Import dialog box, in the Look In box, browse to the directory where the .zip file is located, and then select the file.
7. Click Import.
   In the Importing dialog box, each successfully imported query is marked with a green check mark.
8. Click Close.

Importing a report

The management console extracts the report from the .zip file for you. Reports can be imported to the Reports pane or the Published Results pane.

The imported reports are available in the selected folder in the Reports pane.

To import a report

1. In the management console, click Reports.
2. Under the Reports tab, click Reports.
3. On the Reports page, navigate to and select a folder to receive the imported reports.
4. To import a report, in the Reports pane, right-click Import Report.
5 To import a published report, in the Published Results pane, right-click Import Published Results.

6 In the Import dialog box, in the Look In box, browse to the directory where the .zip file is located, and then select the file.

7 Click Import.

   In the Importing dialog box, each successfully imported report is marked with a green check mark.

8 Click Close.

Deleting a query or report

You can delete queries and reports that you no longer need.

To delete a query or report

1 In the management console, click Reports > Queries or Reports > Reports.

2 To delete a query: Under Queries, In the Queries pane, right-click a query, and then click Delete Query.

3 To delete a report: Under Reports, In the Reports pane, right-click a report, and then click Delete Report.

4 In the Confirm Deletion dialog, click Yes to delete the query or report.
This chapter includes the following topics:

- Viewing the Admin page
- Creating a user account
- Assigning roles to a user account
- Removing roles assigned to a user account
- Creating a custom role
- Assigning user accounts to a role
- Removing user accounts assigned to a role
- Assigning access permissions to roles
- Allowing a role to edit the Security tab
- Resetting a password
- Deleting a user account
- Deleting a role
- Viewing or modifying system settings
- Adding Active Directory servers
- Viewing and exporting server configuration data
- Managing the Tomcat server and Web applications
Viewing the Admin page

You use the Admin page in the management console to perform the following administrative tasks:

- Manage user accounts for the DCS:SA management console.
- View system settings for management server health.
- View and edit audit settings, event management settings, and virtual agent settings.
- Manage the Tomcat server and Web applications.
- Change the management server's host name, server name, console port, and admin port.

**Note:** To perform these administrative functions, you must log on to the management console as a user who is assigned to the built-in Administrators role.

To view the Admin page

- In the management console, click **Admin**.

Creating a user account

User accounts provide secure access to the DCS:SA management console.

You can create a user account that can be authenticated locally or by using Active Directory.

When you create a user account, you must assign one or more roles to the account. The roles that you assign determine what functions the user can perform in the management console.

The DCS:SA built-in roles are as follows:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Users with the Administrators role can log on to the management console and have complete, unrestricted access to all available features and tasks. Administrators can add users and make other system-wide changes. Administrators can access all agent groups on the Assets page, and all queries and reports on the Reports page. The default account (symadmin) that was created during DCS:SA installation is assigned the Administrators role.</td>
</tr>
<tr>
<td>Authors</td>
<td>Users with the Authors role can log on to the authoring environment and author policies.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Guests</strong></td>
<td>Users with the Guests role can log on to the management console but cannot make any policy changes. Guests can access all agent groups on the Assets page. You can create custom guest roles, each with its own name and folder permissions on the Assets page.</td>
</tr>
<tr>
<td><strong>Managers</strong></td>
<td>Users with the Managers role can log on to the management console and make changes to agents and policies, such as modifying agent and group policy and configuration settings, and creating and modifying policies. Managers may optionally access queries and reports on the Reports page. Managers cannot perform any security-related activities, except for changing their account password. Managers can access all agent groups on the Assets page.</td>
</tr>
<tr>
<td><strong>Query Tool Users</strong></td>
<td>Users with the Query Tool Users role can run the command-line query tool. The account must have access to the queries, reports, and results folders. This access can come from the Query Tool Users role or an additional Managers/Guests role. The Query Tool Users role gives users permission to run the command-line query tool. It does not give users permission to log on to the management console.</td>
</tr>
</tbody>
</table>

In addition to the DCS:SA built-in roles, you can assign custom roles to a user. See "Creating a custom role" on page 258.

**To create a user account**

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Users**.
3. In the toolbar, click **Create a new User** icon.
4 In the **New User** dialog box, on the **General** tab, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User name</strong></td>
<td>The account user name. The user name is used to log on to the management console.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A description of the user or the purpose of the account.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The account password. The password is used to log on to the management console. The password must be at least eight characters, and contain a mix of letters and at least two numbers or special characters.</td>
</tr>
<tr>
<td><strong>Confirm Password</strong></td>
<td>Type the password again to confirm it.</td>
</tr>
</tbody>
</table>

5 In the **New User** dialog box, on the **Member Of** tab, click **Add**.

6 In the **Add Roles** dialog box, select a role, and then click **Add**.

   To select multiple roles, hold down the Ctrl key while selecting the roles.

7 In the **New User** dialog box, click **OK**.

   The user account is created with the user name, password, and roles that you specified.

### Editing account information

You should provide contact name, addresses, and phone numbers for each account.

**To edit account information**

1 In the management console, click **Admin**.

2 Under the **Admin** tab, click **Users**.

3 On the **Users** page, select a user account, and then right-click **Properties**.
4 In the user account dialog box, on the **Contact** tab, specify the following information:

- **Contact name**: The name of the contact person for the user. The contact person can be a department administrator, the user’s supervisor, etc.
- **Telephone number(s)**: The user’s office and cell phone numbers.
- **Email address**: The user’s email address.
- **Alert email address**: The email address of contacts who should receive an email alert when an event occurs.
- **Address**: The user’s office mailing address.
- **Manager name**: The name of the user’s immediate supervisor.
- **Business**: The company name or organization.
- **Preferred language**: The user’s preferred language.

5 Click **OK**.

### Assigning roles to a user account

You can assign roles to an existing user account.

**To assign roles to a user account**

1 In the management console, click **Admin**.
2 Under the **Admin** tab, click **Users**.
3 On the **Users** page, select a user account, and then right-click **Properties**.
4 In the user account dialog box, on the **Member Of** tab, click **Add**.
5 In the **Add Roles** dialog box, select the roles, and then click **Add**.

To select multiple roles, hold down the Ctrl key while selecting the roles.

6 Click **OK**.
Removing roles assigned to a user account

You can remove roles that were assigned to a user account.

To remove roles assigned to a user account

1. In the management console, click Admin.
2. Under the Admin tab, click Users.
3. On the Users page, select a user account, and then right-click Properties.
4. In the user account dialog box, on the Member Of tab, select the roles that you want to remove, and then click Remove.
   
   To select multiple roles, hold down the Ctrl key while selecting the roles.
5. Click OK.

Creating a custom role

You can create custom roles that have access to the following objects:

- Agent groups
- Policy groups
- Configuration groups
- Queries/reports

For each role you create, you must specify the following:

- Name and description of the role
- User accounts that are assigned to the role
- Objects that the role is allowed to access

You can also create custom guest roles, each with its own role name and permissions. Users with custom guest roles can log on to the management console, but cannot make any policy changes.

See "Examples of creating custom roles" on page 259.

To create a custom role

1. In the management console, click Admin.
2. Under the Admin tab, click Roles.
4. In the New Role dialog box, type a name and description of the new role.
5. If you are creating a custom guest role, check Guest role.
6 In the **New Role** dialog box, click **Add**.
7 In the **Add Users** dialog box, select the user accounts, and then click **Add**.
   To select multiple user accounts, hold down the Ctrl key while selecting the accounts.
8 Click **OK**.
9 In the management console, click **Assets**, and then edit the Security tab for each agent group that the role is allowed to access.
   Assign access to the default group, then assign access to specific groups in the tree.
10 In the management console, click **Reports**, and then edit the Security tab for each query/report folder that the role is allowed to access.
   You can assign access to all folders or specific folders in a tree.

**Examples of creating custom roles**

The following examples illustrate how to create custom roles.

**Create a Prevention Manager role**

You want to create a new role called Prevention Manager. The Prevention Manager will oversee all agents that support prevention features. You want to allow the Prevention Manager to access all agent groups in the Prevention view. You do not want to allow the Prevention Manager to access any agent groups in the Master View or the Detection view.

See Table 9-1 describes your current agent group structure.

<table>
<thead>
<tr>
<th>View</th>
<th>Default agent group</th>
<th>Sub-groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td>Network</td>
<td>You have not created any groups in the Network group tree.</td>
</tr>
<tr>
<td>Prevention</td>
<td>Policy</td>
<td>You have two groups in the Policy group tree:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ East Coast Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ West Coast Agents</td>
</tr>
</tbody>
</table>
### Create Role Example: Agent group structure (continued)

<table>
<thead>
<tr>
<th>View</th>
<th>Default agent group</th>
<th>Sub-groups</th>
</tr>
</thead>
</table>
| Configuration| You have two groups in the Configuration group tree: | ■ East Coast Agents  
                      ■ West Coast Agents |
| Detection    | Policy              | You have two groups in the Policy group tree:    | ■ Division A Agents  
                      ■ Division B Agents |
| Configuration| You have two groups in the Configuration group tree: | ■ Division A Agents  
                      ■ division B Agents |

In the Prevention view, the default Policy group has two groups in its tree: East Coast Agents and West Coast Agents. You want to allow the Prevention Manager to access the default Policy group and all the groups in its tree.

**To create the Prevention Manager role**

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Roles**.
3. On the **Roles** page, click **New Role** icon.
4. In the **New Role** dialog box, type **Prevention Manager** for the role name and **Oversees all prevention agents** for the description.
5. Assign user accounts to the Prevention Manager role.
6. Click **OK** to save the Prevention Manager role.
7. In the management console, click **Assets**.
8. Allow the Prevention Manager role to access the default Policy group.

   In the Asset Policies pane, select the default Policy group, and then right-click **Properties**. On the Security tab, select Prevention Manager, and then click **OK**.
9 Allow the Prevention Manager role to access the East Coast Agents group.
   In the Asset Policies pane, select the East Coast Agents group, and then right-click **Properties**. On the Security tab, select Prevention Manager, and then click **OK**.

10 Allow the Prevention Manager role to access the West Coast Agents group.
   In the Asset Policies pane, select the West Coast Agents group, and then right-click **Properties**. On the Security tab, select Prevention Manager, and then click **OK**.

**Create an Assistant Manager role**

You want to create a new role called Assistant Manager. The Assistant Manager will monitor all agents that have registered with the management server. You want to allow the Assistant Manager to access all agent groups in the Master view. You do not want to allow the Assistant Manager to access any agent groups in the Prevention View or the Detection view.

In the Master view, all agents reside in the default Network group.

**To create the Assistant Manager role**

1 In the management console, click **Admin**.
2 Under the **Admin** tab, click **Roles**.
3 On the **Roles** page, click **New Role** icon.
4 In the **New Role** dialog box, type **Assistant Manager** for the role name and **Monitors all agents that have registered with the management server** for the description.
5 Assign user accounts to the Assistant Manager role.
6 Click **OK** to save the Assistant Manager role.
7 In the management console, click **Assets**.
8 Allow the Assistant Manager role to access all agent groups in the Master view.
   In the Network Assets pane, select the Network group, and then right-click **Properties**. On the Security tab, select Assistant Manager, and then click **OK**.

**Assigning user accounts to a role**

You can assign user accounts to an existing role.
To assign user accounts to a role

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Roles**.
3. On the **Roles** page, select a role, and then right-click **Properties**.
4. In the **Role** dialog box, on the **General** tab, click **Add**.
5. In the **Add User(s)** dialog box, select the user accounts for the role, and then click **Add**.
   
   To select multiple user accounts, hold down the Ctrl key while selecting the accounts.
6. Click **OK**.

Removing user accounts assigned to a role

You can remove user accounts that were assigned to a role.

To remove user accounts assigned to a role

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Roles**.
3. On the **Roles** page, select a role, and then right-click **Properties**.
4. In the **Role** dialog box, on the **General** tab, select the user accounts that you want to remove, and then click **Remove**.
   
   To select multiple user accounts, hold down the Ctrl key while selecting the accounts.
5. Click **OK**.

Assigning access permissions to roles

You can allow roles to access to the following management console objects:

- Agent groups
- Policy groups
- Configuration groups
- Queries/reports
Note: By default, the built-in Administrators role has complete, unrestricted access to all available DCS:SA features and tasks, including access to all agent groups. Because you need at least one role with unrestricted access, it is recommended that you do not modify the built-in Administrators role.

To assign access permissions to roles

1. In the management console, click Assets.
2. Under the Assets tab, click Detection.
3. In the Asset Policies pane, select the agent group to which you want to allow access, and then right-click Properties.
4. In the properties dialog box, on the Security tab, select the Allowed check box for each role that can access the agent group.
5. Click OK to save your changes.
6. Repeat steps 3-5 to assign access for another agent group.
7. On the Reports page, select the query or report folder to which you want to allow access, and then right-click Properties.
8. In the properties dialog, on the Security tab, select the Allowed check box for each role that can access the query or report folder.
9. Click OK.
10. Repeat steps 7-9 to assign access for another query or report folder.

Allowing a role to edit the Security tab

By default, the built-in Administrators role is allowed to edit the Security tab for each DCS:SA agent group. You can extend this privilege to other non-guest roles.

To allow a role to edit the Security tab

1. In the management console, click Admin.
2. Under the Admin tab, click Roles.
3. On the Roles page, select a role, and then right-click Properties.
4. In the Role dialog box, on the Security tab, click Allow this role to edit the Security tab on its group.
5. Click OK.
Resetting a password

You can reset the password for a user account. The new password is effective immediately.

**To reset a password**

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Users**.
3. On the **Users** page, select a user account, and then right-click **Set Password**.
4. In the Set Password dialog, type the new password, then type it again to confirm.
5. Click **Set**.

Deleting a user account

If you no longer want a user to have access to the management console, you can delete the user's account.

**Note:** You cannot delete the built-in symadmin user account.

**To delete a user account**

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Users**.
3. On the **Users** page, select the user account, and then right-click **Delete User**.
4. In the **Confirm Deletion** dialog box, click **Yes** to delete the user account.

Deleting a role

You can delete roles that you no longer use.

Before you delete a role, make sure the role is not assigned to a user account.

**Note:** You cannot delete the built-in Administrators role.

**To delete a role**

1. In the management console, click **Admin**.
2. Under the **Admin** tab, click **Roles**.
3. On the Roles page, select the role, and then right-click Delete Role.
4. In the Confirm Deletion dialog box, click Yes to delete the role.

Viewing or modifying system settings

System settings comprise the following:

- Management server health
- General settings tab
  - Audit settings
  - Event Management settings
  - Login Notice setting
- Agent settings tab
  - Virtual Agent settings
  - Agent Health setting
  - Duplicate Agent Registration

To view or modify system settings
1. In the management console, click Admin.
2. Under Admin tab, click Settings.
3. In the left-hand pane, click System Settings.
4. View or modify the system settings.
5. Click Save.

About the management server health

The health of the connection between the DCS:SA management server and the database is indicated by the following:

- A green circle icon indicating that the management server is running, or a red circle icon indicating that a management server or database error occurred.
- The management server version
- The date and time the connection between the management server and the database was last checked
About the Audit settings

The DCS:SA management server records audit events whenever changes to the system configuration are made.

By default, the management server records audit events for the following user activity:

- Creating data
- Saving data
- Deleting data
- Logging on to the management console
- Logging off the management console

Optionally, you can instruct the management server to record audit events for the following additional user activity:

- Execution of queries or reports
- Execution of searches from the Monitors page

The execution of searches, queries, and reports is disabled by default.

You can view all audit events from the Monitors page.

About the Login Notice setting

You can specify a message to display whenever a user logs on to the management console. The user must acknowledge the message by clicking OK (continue logging on) or Cancel (exit the management console).

About the Event Management settings

Event Management settings specify how long to retain the following types of events:

- Real-time events: Events that are transmitted to the management server, based on an agent's log rules.
- Profile events: Events that are generated when an agent profiles a program or service.
- Analysis events: Events that are transmitted to the management server using bulk log transfer, and then loaded into the DCS:SA database using the bulk loader utility. Analysis events are of long-term interest, generally for audit or forensic analysis needs.

Events older than the age that you specify are purged from the DCS:SA database.
By default, event management settings are configured not to purge any events.

The event management settings are as follows:

**Purge Real-Time Events older than [n] days**
Select this check box to purge real-time events, and then type the age of the events, in days.
When this check box is selected, the default event age is 365 days.

**Purge Profile Events older than [n] days**
Select this check box to purge old profile events, and then type the age of the events, in days.
When this check box is selected, the default event age is 60 days.

**Purge Analysis Events older than [n] days**
Select this check box to purge old analysis events, and then type the age of the events, in days.
When this check box is selected, the default event age is 60 days.

### About the Virtual Agent settings

Virtual Agent settings control the storage of virtual events and the dynamic registration of virtual agents.

If your DCS:SA agent deployment indirectly detects off-platform event data and associates the data with agents in the management console, you will need to configure Virtual Agent settings.

The Virtual Agent settings are as follows:

**Allow virtual agents to register automatically**
When selected, this setting allows both dynamic and manual registration of virtual agents.
When the setting is not selected, only manual registration is allowed.
Default: On

**Allow virtual events to be stored in real time**
When selected, this setting allows virtual events to be stored in real time with regular DCS:SA events. Log rules for the agents that collect virtual events must be configured for virtual events.
When this setting is not selected, virtual events are bulk-logged. Bulk logging must be enabled on the agents that collect virtual events. The agent log rules must be configured for virtual events.
Default: On

### About the Agent Health setting

To prevent network flooding as agents go offline and online, a system-wide flood-control option aggregates status change events into a single event.
The Agent Health setting is as follows:

Aggregate agent health events when more than \([n]\) change at once

The threshold value for the number of agent status change events that cause a single aggregated status change event to be generated instead of a flood of individual agent events.

This setting helps limit the number of meaningless events (and any related alerts) resulting from a network outage that affects a large number of agents at once.

Default: 25

You can configure agent health settings for specific agents.

About the duplicate agent registration settings

You can disable the registration of duplicate agents with the management server. By default, DCS:SA lets you register duplicate agents based on some common attributes such as IP address, agent name, and so on. When DCS:SA recognizes a duplicate agent, it updates the existing agent record in the database with the new agent data and flags the agent for policies and configs.

DCS:SA evaluates the uniqueness of each agent based on the following attributes:

- Primary attributes
  - Agent name
  - Host name
  - IP address

- Secondary attributes
  - Domain name
  - Operating system type

See "Disabling duplicate agent registration" on page 268.

Disabling duplicate agent registration

DCS:SA enables you to prevent registration of duplicate agents.

To disable duplicate agent registration

1. In the management console, click **Prevention View** or **Detection View**.
2. Click **Admin**.
3. Click **System Settings**.
4. Click **Agent settings**.
5 Check **Detect Duplicate Agent Registration**.

6 Check attributes under **Primary Agent Attributes for Duplicate Agent Identification** and **Secondary Agent Attributes for Duplicate Agent Identification**.

   You must select at least one primary attribute.

7 Click **Save**.

   See “About the duplicate agent registration settings” on page 268.

---

**Adding Active Directory servers**

You must log on to DCS:SA console as an administrator to define the Active Directory server information in the server configuration settings. You can define multiple Active Directory servers.

**To add Active Directory servers**

1 In the management console, click **Admin**.

2 Click **Settings**.

3 In the left pane, under **System Settings**, click **Directory Servers**.

4 In the toolbar, click the **Create a new Active Directory server** icon.

5 In the **New Active Directory Server Configuration** dialog box, type the Active Directory server name.

6 In the **Host** box, type the IP address or host name of the server.

   Or

   In the **Domain** box, type the fully qualified domain name of your Active Directory Servers.

7 To use Secure Sockets Layer (SSL) X.509 certificate-based channel encryption, check **Use encrypted communications** and then click **Test**.

   **Note:** The Directory server must be configured to support SSL.

8 In the **Credentials of any user on the Active Directory** dialog box, type the **Username** and **Password** to validate the users account on the specified Active Directory server. This validates the communication between DCS:SA Server and Directory Server.

9 Click **OK**.

   See “Creating users with Active Directory credentials” on page 270.
Creating users with Active Directory credentials

If you choose Active Directory authentication for user accounts, you must specify the Active Directory server from the list of configured Active Directory servers and the domain name. When an Active Directory user logs on to the DCS:SA console, the user must enter the user name in domain\user name format. You can assign an Active Directory user any role including the administrator role.

See “Assigning user accounts to a role” on page 261.

To create users with Active Directory credentials

1  In the management console, click Admin.
2  Click Users.
3  In the toolbar, click the Create a new User icon.
4  In the New User dialog box, on the General tab, specify the following information:

   - **User name**: Active Directory user name in Domain\User name format.
   - **Description**: A description of the user or the purpose of the account.
   - **Active Directory User**: Check Active Directory User to enable the Active Directory Server list box.
   - **Active Directory Server**: Select the Active Directory server name.

5  Click OK.

See “Adding Active Directory servers” on page 269.

See “Creating a user account” on page 254.

Viewing and exporting server configuration data

You must log on to DCS:SA console as an administrator to view the management server settings in the console. The management server configuration data appears only for the management server that is connected to the console.

To view server configuration data

1  In the management console, click Admin.
2  Under Admin, click Settings.
In the left-hand pane, under Server, click View Configuration.

In the Server Configuration Data page, click any of the following tabs to view the server configuration data:

- Tomcat: Displays the Tomcat configuration settings.
- SDCSS: Displays the DCS:SA server properties.
- Database: Displays the database runtime status.

You can export the server configuration data to a comma-separated value (CSV) file.

To export the server configuration data:
1. In the toolbar, click the Export Settings icon.
2. In the Export To dialog box, select the file path in Look In box, and then click Export.

Managing the Tomcat server and Web applications

You use the Admin page in the management console to perform the following Apache Tomcat server and Web application tasks:

- Access the Tomcat Web Server Administration tool to administer the Tomcat server.
- Access the Tomcat Web Application Manager to manage Web applications.
- Access the Server Status link to view the Tomcat Server Status.

To manage the Tomcat server and Web applications, you must log on to the selected Web page with the user name and password of a user who is assigned the Administrators role.

The Administration, Management, and Status tasks for the Tomcat server and Web applications are as follows:
Accessing the Tomcat Web server administration tool

Access the Tomcat Web Server Administration tool.

To access the Tomcat Web server administration tool

1. In the management console, click Admin.
2. In the Server pane, click Administration.
3. In the Tomcat Web Server Administration Tool browser window, enter your user name and password, and then click Login.
4. To exit the Tomcat Web Server Administration Tool, click Log Out.
Accessing the Tomcat Web Application Manager

Access the Tomcat Web Application Manager.

To access the Tomcat Web Application Manager

1. Access the Tomcat Web Server Administration tool.
2. In the Server pane, click **Management**.
3. In the Connect to local host dialog, enter your user name and password, and then click **OK**.
4. To exit the Tomcat Web Application Manager, close the browser window.

Accessing the Tomcat Server Status

Open the same Tomcat Server Status information as the Server Status link on the Management page.

To access the Tomcat Server Status

1. Access the Tomcat Web Server Administration tool.
2. In the Server pane, click **Status**.
3. In the Connect to local host dialog, enter your user name and password, and then click **OK**.
4. To exit the Server Status, close the browser window.

About Tomcat terminology

You use the following terminology to administer the Tomcat server and Web applications:

- A server is the entire servlet container, which is called Catalina.
- A service is an intermediate component of a server that ties one or more connectors to one engine.
- A connector handles communications with the client. Many connectors are available with Tomcat.
- An engine is a request processing pipeline for a specific service. A service may have multiple connectors, so the engine receives and processes all requests from the connectors and gives the response back to the appropriate connector for transmission to the client.
- A host is a virtual host, an association of a network name such as www.mycompany.com, to the Tomcat server. An engine may contain multiple hosts.
A context represents an individual Web application, which is associated with a corresponding host.

A valve is a component that can be inserted into the request processing pipeline for the associated container (engine or host). Different valves have different processing capabilities.

The variable name $CATALINA_HOME refers to the directory where Tomcat is installed. Relative path names used are relative to this directory. By default, this is `<drive>:\Program Files\Symantec\Symantec Data Center Security: Server Advanced\Manager\tomcat`.

### Using the Tomcat Web Server Administration tool

You can access the Tomcat Web Server Administration Tool from the Admin page in the management console. Before you make configuration changes to the Tomcat server, you should become familiar with Tomcat Server terminology and functionality. Refer to the Tomcat 5.5 documentation on the following Web site:

http://jakarta.apache.org

Do not make modifications to the Tomcat server that you do not fully understand. Inappropriate configuration changes can affect the server’s performance or debilitate it completely.

---

**Note:** The Tomcat server is configured to authenticate against the DCS:SA user database. The User Definition node that is normally used to configure users, groups, and roles from the Tomcat Administration Tool is invalid for DCS:SA.
DCS:SA log files

This appendix includes the following topics:

- About log files
- About bulk log transfer

About log files

DCS:SA uses log files to record events and messages related to agent and management server activity. The log files have information required for troubleshooting problems if they occur.

Multiple versions of a log file may exist, as old versions are closed and new versions are opened. The versions are denoted by a number (for example, SISIDSEvents23.csv, sis-console.3.log).

Agent log files

DCS:SA agent log files contain all events processed by an agent. Agent log files are stored on a local agent computer.

The agent event log file directory locations are the default directory locations. If different directory locations were specified during agent installation, please refer to those locations.

The agent event log files are normal text files. You can use any text editor, such as Notepad, to view the contents.

Table A-1 lists the DCS:SA agent log files.
### Table A-1  DCS:SA agent log files

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SISIPSService.log</td>
<td>Agent log service. Contains events that are related to the following:</td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td>■ Agent service operation</td>
<td>Program Files\Symantec\Data Center Security</td>
</tr>
<tr>
<td></td>
<td>■ Applying policies and configuration settings</td>
<td>Server\Agent\sdcsslog\</td>
</tr>
<tr>
<td></td>
<td>■ Communication with the management server</td>
<td>The directory name will remain scsplog if you are upgrading an existing SCSP agent to a DCS:SA agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNIX: /var/log/sdcsslog/</td>
</tr>
<tr>
<td>SISIDSEvents*.csv</td>
<td>Event log. Contains all events recorded by the DCS:SA agent. If bulk logging is enabled for the agent, this file is uploaded to the management server. The asterisk in the file name represents a version number.</td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Program Files\Symantec\Data Center Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server\Agent\sdcsslog\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The directory name will remain scsplog if you are upgrading an existing SCSP agent to a DCS:SA agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNIX: /var/log/sdcsslog/</td>
</tr>
<tr>
<td>SISIPSRTEvents*.csv</td>
<td>Real-time event log. Contains real-time events processed by the DCS:SA agent. This is a temporary file that is used to speed processing of real-time events. Some or all of the events in the file (as configured in the agent's log rules) are forwarded to the management server. The file is deleted once processing is complete. The asterisk in the file name represents a version number.</td>
<td>Windows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Program Files\Symantec\Data Center Security</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server\Agent\sdcsslog\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The directory name will remain scsplog if you are upgrading an existing SCSP agent to a DCS:SA agent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNIX: /var/log/sdcsslog/</td>
</tr>
</tbody>
</table>

### How agent log files are processed

Event log files are stored on a local agent computer.
An agent processes log files in the following manner:

- The agent creates the following log files:
  - The agent creates SISIDSEvents.csv, which contains all events processed by the agent.
  - The agent creates SISIPSRTEvents.csv, which contains real-time events processed by the agent.
- A log file is closed and a new log file is opened based on the agent's log rotation schedule. Rollover of SISIDSEvents.csv and SISIPSRTEvents.csv are controlled by the same parameters, but the rollover decision is made independently for each file.
- Once a SISIDSEvents.csv log file is closed, the file is renamed and then compressed into a .zip file. The renamed file uses the format YYYYMMDD_HHMMSS_QQQQ-FT_HOSTNAME, where QQQQ is a sequence number, F is the file type, T is the OS type, and HOSTNAME is the agent name, host name, or IP address.
- Log files that are queued to be uploaded for bulk logging are copied to the upload folder in <Install Folder>\Symantec\Data Center Security Server\Agent\sdcsslog\upload.
- If the option to delete log files after processing is disabled, the SISIDSEvents.csv files that were successfully uploaded are copied to the archive folder in <Install Folder>\Symantec\Data Center Security Server\Agent\sdcsslog\archive.

Management server log files

The following table lists the management server log files.

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>sis-agent.*.log</td>
<td>This log file is used for agent activity. The asterisk in the file name represents a version number.</td>
<td>Windows: Program Files\Symantec\Data Center Security Server\Server\Tomcat\logs</td>
</tr>
<tr>
<td>sis-alert.*.log</td>
<td>This log file is used for alert activity. The asterisk in the file name represents a version number.</td>
<td>Windows: Program Files\Symantec\Data Center Security Server\Server\Tomcat\logs</td>
</tr>
</tbody>
</table>
Table A-2  Management server log files (continued)

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Default location</th>
</tr>
</thead>
<tbody>
<tr>
<td>sis-console.*.log</td>
<td>This log file is used for console activity. The asterisk in the file name represents a version number.</td>
<td>Windows: Program Files\Symantec\Data Center Security Server\Server\Tomcat\logs</td>
</tr>
<tr>
<td>sis-server.*.log</td>
<td>This log file is used for general server messages. The asterisk in the file name represents a version number.</td>
<td>Windows: Program Files\Symantec\Data Center Security Server\Server\Tomcat\logs</td>
</tr>
</tbody>
</table>

## About bulk log transfer

Bulk log transfer lets you collect events of long-term interest without burdening the network or flooding the DCS:SA database.

If bulk log transfer is enabled, the agent event log file is transmitted to the management server, where it is stored. When you are ready to load the events into the database, you run the bulk loader utility. This utility interprets a compressed bulk log file and populates the database with the events from the file.

## How bulk log files are processed

DCS:SA processes bulk log files as follows:

- The bulk logging thread in the IPS service wakes up every ten seconds to look for files that require file completion processing, and zip files that require uploading.

- Bulk log files are processed based on the upload interval, file interval, idle interval, and backlog interval.

  - **Upload interval**: The interval at which the bulk logging thread uploads files.
  
  - **File processing interval**: The interval at which the bulk logging thread performs file completion processing.
  
  - **Idle interval**: The interval at which the bulk logging thread checks for files to process or upload when there is no other processing to perform.

  Default value: 5 minutes
Backlog interval  The interval at which the bulk logging thread performs file processing or uploads when there is a backlog of files to process or upload. Default value: 1 minute

- Initially, the upload interval and the file processing interval are set to the idle interval.
- If files are backlogged, waiting for file completion processing, the file processing interval is set to the backlog interval. Otherwise, the file processing interval is set to the idle interval.
- If files are backlogged, waiting for uploading, the upload interval is set to the backlog interval. Otherwise, the upload interval is set to the idle interval.
- Upon waking up from the idle interval, the bulk logging thread gets the files to process or upload. The oldest files are processed or uploaded first.
- If a communications error occurs while uploading a file to the management server, the upload interval is set to the idle interval.
- The values for the idle interval and backlog interval are pre-configured in the IPS agent.ini file. The values are not user-configurable.

Loading bulk log events into the management server database

You use the bulk loader utility to load bulk log events into the DCS:SA management server database.

The bulk loader utility interprets a compressed bulk log .zip file and then populates the management server database with the events from the file. Events are loaded into the management server database, in the analysis event table (the default) or the real-time event table (SDCSSEVENT option). You can view the events on the Monitors page.

The bulk loader utility is a command-line tool that communicates with the management server database independently of the DCS:SA management console. When running the bulk loader utility, you must provide the path/file name of the compressed bulk log file.

By default, the bulk loader utility is installed in the following directory:
C:\Program Files\Symantec\Data Center Security Server\Server\tools

The command format is as follows:

bulkload [switch] <event_log_file>

<event_log_file> is the path and file name of the compressed event log .zip file.
The bulk loader utility command-line switches are as follows:

- **-m**  
  <managername>  
  This switch is for use with virtual agent log files. It creates a manager subgroup named <managername>, and dynamically registers a virtual agent when no matching agent GUID is found. It assigns all events in the bulk log file to the virtual agent.

  Used with forwarded SDCSS events, the switch lets you specify the original manager's name so it can be saved in the events.

  The switch is useful when creating a common SDCSS server to collect events from all deployed DCS:SA management environments.

- **-f**  
  Forces the bulk load file to be loaded into the management server database, ignoring verification and validation warnings.

  The switch force-loads events, event if the agent is not found in the database.

- **-t** <tablename>  
  Loads events into the ANALYSIS_EVENT or SDCSSEVENT table.

  Use the <tablename> parameter to specify the table to use when loading the events.

  Valid parameter values are as follows:

  - **ANALYSIS_EVENT** (default)  
    Events that are loaded into the ANALYSIS_EVENT table appear in the Analysis view on the Monitors page.

  - **SDCSSEVENT**  
    Events that are loaded into the SDCSSEVENT table appear in the normal event views along with real-time events.

- **?**  
  Displays help for the bulk loader utility.

To load bulk log events into the management server database

1. From a command prompt, navigate to the following directory:

   C:\Program Files\Symantec\Data Center Security Server\Server\tools

2. At the command prompt, type the bulkload command, and then press Enter.

   The following command force-loads bulk log events as real-time events, and assigns the events to a virtual agent within the DMZ manager subgroup.

   BULKLOAD -f -t SDCSSEVENT -m DMZ

   F:\logfiles\Agent01\20070413_170421_001-EW_Agent01
Event variables

This appendix includes the following topics:

- About event variables
- List of event variables

About event variables

You use event variables to define event data.

Event variables are frequently used in detection policies. For example, in the Global_Watch_Policy, event variables are used to extract event data from an alert text file. For example:

*event_type={EVENT_TYPE}, event_sev={EVENT_SEVERITY}*

In the Windows_Template_Policy and the UNIX_Template_Policy, the event variable {Virtual Agent Tag} is used to extract the virtual agent name from a text log file that contains events captured from multiple virtual agents. For example:

*agent name={VIRTUAL_TAG}*

List of event variables

Enclose event variable names in curly brackets {}.

Variable contents may vary by event type.

Table B-1 contains an alphabetical list of event variables.
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{AGENT_GUID}</td>
<td>Unique ID used by the management server to authenticate an agent.</td>
</tr>
<tr>
<td>{AGENT_VERSION}</td>
<td>Complete agent version (such as 5.2.0.194).</td>
</tr>
<tr>
<td>{ASSET_RID}</td>
<td>Reference key to the corresponding source agent record in the asset table on the Assets page.</td>
</tr>
<tr>
<td>{BINARYDATA}</td>
<td>Additional data. Typically used for error conditions that were encountered while processing events sent to the management server. The field contains the original event contents received at the server.</td>
</tr>
<tr>
<td>{DESCRIPTION}</td>
<td>Description captured from the source, or descriptive explanation of an event.</td>
</tr>
<tr>
<td>{DISPOSITION}</td>
<td>One of the following single letter codes that represents event disposition:</td>
</tr>
<tr>
<td></td>
<td>■ A (allow)</td>
</tr>
<tr>
<td></td>
<td>■ D (deny)</td>
</tr>
<tr>
<td></td>
<td>■ S (success)</td>
</tr>
<tr>
<td></td>
<td>■ F (failure)</td>
</tr>
<tr>
<td></td>
<td>■ E (error)</td>
</tr>
<tr>
<td>{EVENT_CNT}</td>
<td>The event count is always one, unless it reflects the count of events represented by event consolidation.</td>
</tr>
<tr>
<td>{EVENT_DT}</td>
<td>The date (YYYY-MM-DD HH:MM:SS) that the event occurred.</td>
</tr>
<tr>
<td>{EVENT_DURATION}</td>
<td>For consolidated events, the time span from the first consolidated event to the last consolidated event.</td>
</tr>
<tr>
<td>{EVENT_END_DT}</td>
<td>The end date/time for a consolidated event. Always Null unless this is a consolidated event.</td>
</tr>
<tr>
<td>{LOCAL_EVENT_DT}</td>
<td>The event date expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_DAY}</td>
<td>The event day of month expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_DAYOFWEEK}</td>
<td>The event day expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_HOUR}</td>
<td>The event hour expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_MINUTE}</td>
<td>The event minute expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_MONTH}</td>
<td>The event month expressed in local agent time.</td>
</tr>
<tr>
<td>{LOCAL_YR}</td>
<td>The event year expressed in local agent time.</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>{EVENT_PRIORITY}</td>
<td>The priority (0-100) assigned to the event.</td>
</tr>
<tr>
<td>{EVENT_SEVERITY}</td>
<td>One of the following single letter codes that represents event severity:</td>
</tr>
<tr>
<td></td>
<td>■ I (Information)</td>
</tr>
<tr>
<td></td>
<td>■ N (Notice)</td>
</tr>
<tr>
<td></td>
<td>■ W (Warning)</td>
</tr>
<tr>
<td></td>
<td>■ E (Error)</td>
</tr>
<tr>
<td></td>
<td>■ C (Critical)</td>
</tr>
<tr>
<td></td>
<td>■ M (Major)</td>
</tr>
</tbody>
</table>

When setting the {Event Severity} variable, the E value cannot be assigned directly. The E value is logically derived when the event type equals MERR.
### Table B-1

#### Event variables (continued)

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(EVENT_TYPE)</td>
<td>Four-letter code representing the class and type of event. The first letter indicates general class (detection, prevention, management). The remaining letters indicate the sub-type.</td>
</tr>
</tbody>
</table>

The codes are as follows:

- **DFWW** (Filewatch Windows)
- **DFWU** (Filewatch UNIX)
- **DRGW** (Registry Watch)
- **DNTL** (NT Log)
- **DSYS** (Syslog)
- **DGEN** (Generic Log)
- **DWTM** (WTMP/WTMP)
- **DAUD** (IDS Audit)
- **DUC2** (UNIX C2)
- **DIPS** (IDS of IPS)
- **PNET/ANET** (IPS Network)
- **PFIL/AFIL** (IPS File)
- **PREG/AREG** (IPS Registry)
- **PBOP/ABOP** (IPS Overflow)
- **POSC/AOSC** (IPS System Call)
- **PMNT/AMNT** (IPS Mount)
- **PPST/APST** (IPS PSET)
- **PCRE/ACRE** (IPS Create)
- **PDES/ADES** (IPS Destroy)
- **MERR** (IDS Error)
- **MSTD** (IDS Status)
- **MSTP** (IPS Status)
- **MCOM** (COMM Status)
- **MOVR** (Agent Override)
- **MCON** (Agent Config Status)
- **MSTA** (Agent Status)
- **MSOF** (Header)
- **MEOF** (Trailer)
- **MREP** (File Create)
- **MEFR** (File Received)
- **MBIN** (Server Error)
- **ECAT** (Catalog Entry)
- **CAUD** (Console Audit)
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOSTADDR</td>
<td>IP address.</td>
</tr>
<tr>
<td>{HOSTNAME}</td>
<td>Computer name.</td>
</tr>
<tr>
<td>{IPOCT1} - {IPOCT4}</td>
<td>First through fourth octet of IP address of the source system.</td>
</tr>
<tr>
<td>{OPERATION}</td>
<td>OS system call or functions involved in the activity (for example, NtOpenKey).</td>
</tr>
<tr>
<td>{OSTYPE}</td>
<td>The operating system type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ W (Windows)</td>
</tr>
<tr>
<td></td>
<td>■ S (Solaris)</td>
</tr>
<tr>
<td></td>
<td>■ L (Linux)</td>
</tr>
<tr>
<td></td>
<td>■ H (HP-UX)</td>
</tr>
<tr>
<td></td>
<td>■ A (AIX)</td>
</tr>
<tr>
<td>{OSVERSION}</td>
<td>OS version string (such as XP Service Pack 1).</td>
</tr>
<tr>
<td>{POLICY_ID}</td>
<td>The identification number of the policy that generated the event.</td>
</tr>
<tr>
<td>{POST_DELAY}</td>
<td>Formatted display for the posting delay (nnnd hh:mm:ss). For example: 12d 11:54:37. Time difference from when event occurred and time posted to database.</td>
</tr>
<tr>
<td>{PROCESS_NAME}</td>
<td>Name of the policy applied to the agent that triggered this event.</td>
</tr>
<tr>
<td>{PROCESS_PATH}</td>
<td>The process path and name.</td>
</tr>
<tr>
<td>{PROCESS_FULL_NAME}</td>
<td>The fully qualified process name.</td>
</tr>
<tr>
<td>{PROCESS_ID}</td>
<td>The ID assigned to the process.</td>
</tr>
<tr>
<td>{FileName}</td>
<td>Target resource name (such as win.ini). Useful for comparing events to specific resources regardless of installation location.</td>
</tr>
<tr>
<td>{RULE_ID}</td>
<td>The identification number of the policy rule that generated the event.</td>
</tr>
<tr>
<td>{RULE_NAME}</td>
<td>The name of the policy rule that generated the event.</td>
</tr>
<tr>
<td>{TARGET_INFO}</td>
<td>The target file name, registry path, or source name.</td>
</tr>
<tr>
<td>{SESSION_ID}</td>
<td>The session identification number of the session that generated the event.</td>
</tr>
</tbody>
</table>
### Table B-1  Event variables (continued)

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(SYSTEM_STATE)</td>
<td>The state of processing characteristics (event processing, prevention policy, event source) when the event occurred.</td>
</tr>
<tr>
<td></td>
<td>Event processing states are as follows:</td>
</tr>
</tbody>
</table>
|                        | ■ R (real-time event)  
|                        | ■ V (virtual event)  
|                        | ■ I (injected event)  
|                        | Prevention policy states are as follows:                                                                                                        |
|                        | ■ P (prevention policy overridden)                                                                                                              |
|                        | ■ X (prevention policy overridden except self-protection)                                                                                      |
|                        | ■ G (policy globally disabled)                                                                                                                  |
|                        | Event source states are as follows:                                                                                                               |
|                        | ■ T (ITA forwarded)  
|                        | ■ C (SDCSS forwarded)  
|                        | ■ D (collector derived)  
<p>|                        | ■ L (logwatch policy generated)                                                                                                                  |
|                        | ■ F (config tool generated)                                                                                                                     |
|                        | ■ S (IPS service generated)                                                                                                                     |
|                        | Other event attributes are as follows:                                                                                                             |
|                        | ■ Z (Solaris non-global zone event)                                                                                                               |
|                        | ■ M (special SDCSS manager virtual agent; flag only exists in database, not CSV)                                                                |
|                        | Not all virtual events are injected events. Not all injected events are virtual events. All virtual and injected events must also specify an event source. The Solaris zone flag indicates the event processed came from a non-global zone |
|                        | Examples of system state usage:                                                                                                                  |
|                        | ■ PR (Real-time event, prevention policy overridden)                                                                                              |
|                        | ■ IS (injected IPS service event)                                                                                                                 |
|                        | ■ VT (virtual ITA event)                                                                                                                         |
| (TIMEZONE_ADJ)         | Positive or negative integer representing minutes offset from UTC time (for example, -300 is 5 hours).                                                 |
| (USER_TEXT)            | Additional descriptive text that the policy author recorded about the event.                                                                     |
| (USER_NAME)            | The user name from the event.                                                                                                                    |</p>
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{VALUE1}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>- DFWW: Old Permission Bitmask</td>
</tr>
<tr>
<td></td>
<td>- DFWU: Old Permission Bitmask</td>
</tr>
<tr>
<td></td>
<td>- DRGW: Old Value</td>
</tr>
<tr>
<td></td>
<td>- DNTL: Event Type</td>
</tr>
<tr>
<td></td>
<td>- DSYS: Priority</td>
</tr>
<tr>
<td></td>
<td>- DGEN: Generic Type</td>
</tr>
<tr>
<td></td>
<td>- DWTM: TMP Type</td>
</tr>
<tr>
<td></td>
<td>- DUC2: Source</td>
</tr>
<tr>
<td></td>
<td>- DIPS: IPS PSET</td>
</tr>
<tr>
<td></td>
<td>- PNSET/ANET: PSET</td>
</tr>
<tr>
<td></td>
<td>- PFILE/AFIL: PSET</td>
</tr>
<tr>
<td></td>
<td>- PREG/AREG: PSET</td>
</tr>
<tr>
<td></td>
<td>- PBOP/ABOP: PSET</td>
</tr>
<tr>
<td></td>
<td>- POSC/AOSC: PSET</td>
</tr>
<tr>
<td></td>
<td>- PMNT/AMNT: PSET</td>
</tr>
<tr>
<td></td>
<td>- PPST/APPST: PSET</td>
</tr>
<tr>
<td></td>
<td>- MERR: Message ID</td>
</tr>
<tr>
<td></td>
<td>- MSTD: Message ID</td>
</tr>
<tr>
<td></td>
<td>- MOVR: Override Duration</td>
</tr>
<tr>
<td></td>
<td>- MSOF: Source Type</td>
</tr>
<tr>
<td></td>
<td>- MEOF: Source Type</td>
</tr>
<tr>
<td></td>
<td>- MBIN: VALUE1</td>
</tr>
<tr>
<td></td>
<td>- CAUD: Object Version</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>{VALUE2}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWW: New Permission Bitmask</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: New Permission Bitmask</td>
</tr>
<tr>
<td></td>
<td>■ DRGW: New Value</td>
</tr>
<tr>
<td></td>
<td>■ DNTL: Event ID</td>
</tr>
<tr>
<td></td>
<td>■ DSYS: Msg ID</td>
</tr>
<tr>
<td></td>
<td>■ DGEN: Generic Attr 1</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: FileName</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PFIL/AFIL: OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PREG/AREG: OS Result</td>
</tr>
<tr>
<td></td>
<td>■ POSC/AOSC: OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PMNT/AMNT: OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PPST/APST: Parent PID</td>
</tr>
<tr>
<td></td>
<td>■ PCRE/ACRE: Parent PID</td>
</tr>
<tr>
<td></td>
<td>■ MSOF: Component Version</td>
</tr>
<tr>
<td></td>
<td>■ MEOF: Component Version</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE2</td>
</tr>
<tr>
<td></td>
<td>■ CAUD: ObjectType</td>
</tr>
<tr>
<td>{VALUE3}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWW: Old Size</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: Old Size</td>
</tr>
<tr>
<td></td>
<td>■ DNTL: Category</td>
</tr>
<tr>
<td></td>
<td>■ DGEN: Generic Attr 2</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: Group</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: LocalPort</td>
</tr>
<tr>
<td></td>
<td>■ PFIL/AFIL: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ PREG/AREG: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ PBOP/ABOP: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ POSC/AOSC: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ PMNT/AMNT: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE3</td>
</tr>
<tr>
<td></td>
<td>■ CAUD: Object Path</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>{VALUE4}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWW: New Size</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: New Size</td>
</tr>
<tr>
<td></td>
<td>■ DNTL: Computer Name</td>
</tr>
<tr>
<td></td>
<td>■ DGEN: Generic Attr 3</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: Action</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS Value4</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: LocalIP</td>
</tr>
<tr>
<td></td>
<td>■ PFIL/AFIL: Requested</td>
</tr>
<tr>
<td></td>
<td>■ PREG/AREG: Requested</td>
</tr>
<tr>
<td></td>
<td>■ PBOP/ABOP: Requested</td>
</tr>
<tr>
<td></td>
<td>■ POSC/AOSC: SDCSS Result</td>
</tr>
<tr>
<td></td>
<td>■ PMNT/AMNT: Device</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE4</td>
</tr>
<tr>
<td></td>
<td>■ CAUD: TableName</td>
</tr>
<tr>
<td>{VALUE5}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWW: New File Name</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: Old Link Name</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: RemoteHost/IP</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS Value5</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: RemoteIP</td>
</tr>
<tr>
<td></td>
<td>■ PBOP/ABOP: Injectee Process Name</td>
</tr>
<tr>
<td></td>
<td>■ PPST/APST: Parent Proc Name</td>
</tr>
<tr>
<td></td>
<td>■ PCRE/ACRE: Parent Proc Name</td>
</tr>
<tr>
<td></td>
<td>■ MREP: Checksum</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: Checksum</td>
</tr>
<tr>
<td>{VALUE6}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: New Link Name</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: ErrorText</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS Value6</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: RemotePort</td>
</tr>
<tr>
<td></td>
<td>■ PBOP/ABOP: Injectee Process ID</td>
</tr>
<tr>
<td></td>
<td>■ MSTP: Param1</td>
</tr>
<tr>
<td></td>
<td>■ MREP: CntTotal</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE6</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| {VALUE7}      | The value depends on event type, as follows:  
  ■ DFWW: Old Modification Date  
  ■ DFWU: Old Modification Date  
  ■ DIPS: IPS Value7  
  ■ PFIL/AFIL: NT Create Disp.  
  ■ PBOP/ABOP: Injectee Thread ID  
  ■ MSTP: Param2  
  ■ MREP: Orig File Size  
  ■ MBIN: VALUE7 |
| {VALUE8}      | The value depends on event type, as follows:  
  ■ DFWW: New Modification Date  
  ■ DFWU: New Modification Date  
  ■ DIPS: IPS Value8  
  ■ PNET/ANET: Module Path  
  ■ PFIL/AFIL: Module Path  
  ■ PREG/AREF: Module Path  
  ■ PBOP/ABOP: Module Path  
  ■ POSC/AOSC: Module Path  
  ■ PPST/APST: Module Path  
  ■ PCRE/ACRE: Module Path  
  ■ MSTP: Param3  
  ■ MREP: Compr File Size  
  ■ MBIN: VALUE8 |
Table B-1  Event variables *(continued)*

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{VALUE9}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>■ DFWW: Old Access Date</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: Old Access Date</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: IPS Value9</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PFIL/AFIL: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PREG/AREF: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PBOP/ABOP: Injector Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ POSC/AOSC: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PMNT/AMNT: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PPST/APST: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ PDES/ADES: Thread ID</td>
</tr>
<tr>
<td></td>
<td>■ MSTP: Param4</td>
</tr>
<tr>
<td></td>
<td>■ MREP: LocalFileName</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>{VALUE10}</th>
<th>The value depends on event type, as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ DFWW: New Access Date</td>
</tr>
<tr>
<td></td>
<td>■ DFWU: New Access Date</td>
</tr>
<tr>
<td></td>
<td>■ DNTL: USRVAL1</td>
</tr>
<tr>
<td></td>
<td>■ DSYS: USRVAL1</td>
</tr>
<tr>
<td></td>
<td>■ DGEN: USRVAL1</td>
</tr>
<tr>
<td></td>
<td>■ DWTM: USRVAL1</td>
</tr>
<tr>
<td></td>
<td>■ DUC2: USRVAL1</td>
</tr>
<tr>
<td></td>
<td>■ DIPS: Fmt OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PNET/ANET: Port service</td>
</tr>
<tr>
<td></td>
<td>■ PFIL/AFIL: Fmt OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PREG/AREF: Fmt OS Result</td>
</tr>
<tr>
<td></td>
<td>■ POSC/AOSC: Fmt OS Result</td>
</tr>
<tr>
<td></td>
<td>■ PMNT/AMNT: Fmt OS Result</td>
</tr>
<tr>
<td></td>
<td>■ MSTP: Param5</td>
</tr>
<tr>
<td></td>
<td>■ MREP: Start TimeStamp</td>
</tr>
<tr>
<td></td>
<td>■ MBIN: VALUE10</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| {VALUE11}     | The value depends on event type, as follows:  
  ■ DFWW: Old # of Hard Links  
  ■ DFWU: Old # of Hard Links  
  ■ DNTL: USRVAL2  
  ■ DSYS: USRVAL2  
  ■ DGEN: USRVAL2  
  ■ DWTM: USRVAL2  
  ■ DUC2: USRVAL2  
  ■ DIPS: R/W Flag  
  ■ PFIL/AFIL: R/W Flag  
  ■ PREG/AREF: R/W Flag  
  ■ MREP: End TimeStamp  
  ■ MBIN: VALUE11 |
| {VALUE12}     | The value depends on event type, as follows:  
  ■ DFWW: New # of Hard Links  
  ■ DFWU: New # of Hard Links  
  ■ DNTL: USRVAL3  
  ■ DSYS: USRVAL3  
  ■ DGEN: USRVAL3  
  ■ DWTM: USRVAL3  
  ■ DUC2: USRVAL3  
  ■ MBIN: VALUE12 |
| {VALUE13}     | The value depends on event type, as follows:  
  ■ DFWW: Old Creation Date  
  ■ DFWU: Old Creation Date  
  ■ DNTL: USRVAL4  
  ■ DSYS: USRVAL4  
  ■ DGEN: USRVAL4  
  ■ DWTM: USRVAL4  
  ■ DUC2: USRVAL4  
  ■ MSOF: Collector Agent GUID  
  ■ MEOF: Collector Agent GUID  
  ■ MBIN: VALUE13 |
Table B-1  
Event variables (continued)

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
</table>
| {VALUE14}     | The value depends on event type, as follows:  
|               | ■ DFWW: New Creation Date  
|               | ■ DFWU: New Creation Date  
|               | ■ DNTL: USRVAL5  
|               | ■ DSYS: USRVAL5  
|               | ■ DGEN: USRVAL5  
|               | ■ DWTM: USRVAL5  
|               | ■ DUC2: USRVAL5  
|               | ■ DIPS: IPS Event Cat  
|               | ■ MSOF: Collector Host Name  
|               | ■ MEOF: Collector Host Name  
|               | ■ MBIN: VALUE14 |
| {VALUE15}     | The value depends on event type, as follows:  
|               | ■ DFWU: DirectoryChange  
|               | ■ DNTL: USRVAL6  
|               | ■ DSYS: USRVAL6  
|               | ■ DGEN: USRVAL6  
|               | ■ DWTM: USRVAL6  
|               | ■ DUC2: USRVAL6  
|               | ■ DIPS: IPS Event Type  
|               | ■ MSOF: Collector IP Address  
|               | ■ MEOF: Collector IP Address  
|               | ■ MBIN: VALUE15 |
| {VALUE16}     | The value depends on event type, as follows:  
|               | ■ DFWU: SymlinkChange  
|               | ■ DNTL: USRVAL7  
|               | ■ DSYS: USRVAL7  
|               | ■ DGEN: USRVAL7  
|               | ■ DWTM: USRVAL7  
|               | ■ DUC2: USRVAL7  
|               | ■ DIPS: IPS PolicyID  
<p>|               | ■ MBIN: VALUE16 |</p>
<table>
<thead>
<tr>
<th>Variable name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{VALUE17}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>- DFWW: Old Owner</td>
</tr>
<tr>
<td></td>
<td>- DFWU: Old Owner</td>
</tr>
<tr>
<td></td>
<td>- DNTL: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DSYS: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DGEN: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DWTM: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DUC2: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DIPS: IPS RuleID</td>
</tr>
<tr>
<td></td>
<td>- MBIN: VALUE17</td>
</tr>
<tr>
<td>{VALUE18}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>- DFWW: New Owner</td>
</tr>
<tr>
<td></td>
<td>- DFWU: New Owner</td>
</tr>
<tr>
<td></td>
<td>- DNTL: USRVAL9</td>
</tr>
<tr>
<td></td>
<td>- DSYS: USRVAL9</td>
</tr>
<tr>
<td></td>
<td>- DGEN: USRVAL9</td>
</tr>
<tr>
<td></td>
<td>- DWTM: USRVAL9</td>
</tr>
<tr>
<td></td>
<td>- DUC2: USRVAL8</td>
</tr>
<tr>
<td></td>
<td>- DIPS: IPS Event Severity</td>
</tr>
<tr>
<td></td>
<td>- MBIN: VALUE18</td>
</tr>
<tr>
<td>{VALUE19}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>- DFWW: Old Primary Group</td>
</tr>
<tr>
<td></td>
<td>- DFWU: Old group</td>
</tr>
<tr>
<td></td>
<td>- DNTL: USRVAL10</td>
</tr>
<tr>
<td></td>
<td>- DSYS: USRVAL10</td>
</tr>
<tr>
<td></td>
<td>- DGEN: USRVAL10</td>
</tr>
<tr>
<td></td>
<td>- DWTM: USRVAL10</td>
</tr>
<tr>
<td></td>
<td>- DUC2: USRVAL10</td>
</tr>
<tr>
<td></td>
<td>- DIPS: IPS SequenceNum</td>
</tr>
<tr>
<td></td>
<td>- MBIN: VALUE19</td>
</tr>
<tr>
<td>{VALUE20}</td>
<td>The value depends on event type, as follows:</td>
</tr>
<tr>
<td></td>
<td>- DFWW: New Primary Group</td>
</tr>
<tr>
<td></td>
<td>- DFWU: New group</td>
</tr>
<tr>
<td></td>
<td>- DIPS: IPS PolicyName</td>
</tr>
<tr>
<td></td>
<td>- MBIN: VALUE20</td>
</tr>
<tr>
<td>Variable name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>{VIRTUAL_TAG}</td>
<td>The name of the virtual agent. See the detection policies Windows_Template_Policy and UNIX_Template_Policy.</td>
</tr>
</tbody>
</table>
Virtual agent examples

This appendix includes the following topics:

- Capturing static policy-based virtual events from a text log file
- Capturing variable policy-based virtual events from a text log file
- Capturing virtual events derived from the Windowsevent log
- Capturing events forwarded from DCS:SA

Capturing static policy-based virtual events from a text log file

This example monitors a mainframe text log file and assigns all the events in the file to the same agent. Symantec Data Center Security: Server Advanced processes the virtual events indirectly via a text log rule in the Windows_Template_Policy.

In the example, the virtual agent Mainframe01 is registered manually. The collector host is a DCS:SA agent that runs on Windows operating system. SalesMainframe is the name of the source system that originally processed the virtual events. The mainframe text log file is named mainframe01.txt; it is stored in C:\myevents on the Windows agent. All the events in the text log file are for virtual agent Mainframe01; each record corresponds to one virtual event. A user-defined application periodically populates C:\myevents\mainframe01.txt with new virtual events.

To capture static policy-based virtual events from a text log file

1. In the management console, on the Admin page, enable the virtual agent system-wide settings.
2. In the management console, on the Configs page, configure the log rules for the Windows agent that acts as the collector host.
3. On the Windows agent computer, copy mainframe01.txt to C:\myevents.
4 In the management console, manually register virtual agent Mainframe01.

Specify the following values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Mainframe01</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Type</td>
<td>External</td>
</tr>
<tr>
<td>Host Name</td>
<td>SalesMainframe</td>
</tr>
<tr>
<td>IP Address</td>
<td>(Leave blank)</td>
</tr>
<tr>
<td>Manager Name</td>
<td>(Leave blank)</td>
</tr>
<tr>
<td>Operating System</td>
<td>Other</td>
</tr>
</tbody>
</table>

5 In the management console, on the Policies page, in the Symantec folder, edit the Windows_Template_Policy and create a text log rule.

Enable the text log rule that you created, and specify the following rule options:

<table>
<thead>
<tr>
<th>Text log path</th>
<th>C:\myevents\mainframe01.txt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log file contains events coming from a virtual agent</td>
<td>Select this check box to indicate that the events in C:\myevents\mainframe01.txt are for a virtual agent. Value box: Mainframe01</td>
</tr>
</tbody>
</table>


6 Apply the modified Windows_Template_Policy to the Windows agent where the mainframe text log file is periodically populated with new virtual events.

7 In the management console, on the Monitors page, verify the virtual events. The Source Machine column should list Mainframe01. The Description column should list the events collected from C:\myevents\mainframe01.txt. The Source Type should be External. The Collector Host should be the Windows agent that collected the virtual events. The Collector tab should list the Windows agent that collected an event for Mainframe01.

Capturing variable policy-based virtual events from a text log file

This example monitors a text log file and assigns the events in the file to multiple virtual agents. DCS:SA processes the virtual events indirectly via a text log rule in the DCS:SA template policy.
In the example, the virtual agents are registered dynamically, based on the virtual agent name in the event data. The collector host is a DCS:SA agent that runs on Windows operating system. The mainframe text log file is named mainframe01.txt; it is stored in C:\myevents on the Windows agent. The events in the text log file are from multiple virtual agents, and each record corresponds to one virtual event. A user-defined application periodically populates C:\myevents\mainframe01.txt with new virtual events.

To capture variable policy-based virtual events from a text log file

1. In the management console, on the Admin page, enable the virtual agent system-wide settings.
2. In the management console, on the Configs page, configure the log rules for the Windows agent that acts as the collector host.
3. On the Windows agent computer, copy mainframe01.txt to C:\myevents.
4. In the management console, on the Policies page, in the Symantec folder, edit the Windows_Template_Policy and create a text log rule.

Enable the text log rule that you created, and specify the following rule options:

- **Text log path**: C:\myevents\mainframe01
- **Log file contains events coming from a virtual agent**: Select this check box to indicate that the records in C:\myevents\mainframe01.txt are from a virtual agent. In the Value box, specify the virtual agent name variable as {VIRTUAL_TAG}.
- **Parse definitions**: Select this check box to indicate that a parse string defines the virtual agent name. In the Value box, specify the parse string as agent name={VIRTUAL_TAG}


5. Apply the modified Windows_Template_Policy to the Windows agent where the mainframe text log file is periodically populated with new virtual events.

6. In the management console, on the Monitors page, verify the virtual events. The Source Machine column should list the virtual agent name. The Description column should list the events collected from C:\myevents\mainframe01.txt. The Source Type should be External. The Collector Host should be the Windows agent that collected the virtual events. The Collector tab should list the Windows agent that collected all the virtual events.
Capturing virtual events derived from the Windows event log

This example captures virtual events derived from the Windows event log. The virtual agents are registered dynamically as part of the event flow. The example assumes that an environment was set up for multiple remote systems to forward Windows event log events to a collector computer where the DCS:SA agent is installed. This setup includes configuring the remote computers to forward events, configuring the collector computer to collect events, and specifying which events are forwarded to the collector computer. The example assumes that the event log collectors were modified to automatically derive the source system from the event data and represent the events as coming from those systems.

To capture virtual events derived from the Windows event log

1. In the management console, on the Admin page, enable the system-wide virtual agent settings.
2. Set up an environment for multiple remote systems to forward Windows event log events to a collector computer where the DCS:SA agent is installed.
3. On the Windows agent, set the local agent.ini Derive Virtual Agents switch to 1, and restart the IDS service.
4. Perform activities on the remote systems that periodically forward events to the Windows agent.
5. In the management console, in the Master view, on the Assets page, verify dynamic virtual agent registration.

   Virtual agents not previously registered should be registered dynamically in the appropriate OS Forwarded Master group.

6. In the management console, on the Monitors page, verify the virtual events.

   Verify that the Source Machine column lists the virtual agent name, the Description column lists the events derived from the Windows event log, the Source Type is Derived, and the Collector Host is the Windows agent that collected the virtual events. Verify that the Collector tab lists the Windows agent that collected all the virtual events.

Capturing events forwarded from DCS:SA

This example forwards events from multiple DCS:SA servers into a common DCS:SA server (and console) that can display events from agents in the entire deployed environment.
Event capturing is accomplished using the bulk loader utility, which interprets a compressed bulk log file and populates the database with the events from the file. In this example, multiple DCS:SA servers exist in the demilitarized zone (DMZ), Richmond, Chicago, New York, and San Francisco. Each DCS:SA management environment produces bulk log files. Using the bulk loader utility, events are force-loaded as real-time events to a virtual agent within the DMZ subgroup.

To capture SDCSS forwarded events

1. In the management console, on the Admin page, enable the system-wide virtual agent settings.
2. Establish a remote file share for each DCS:SA management environment.
3. Use a batch script to force-load bulk log files on a scheduled basis into the common server.

   The batch script only needs to detect new files added since the last script execution.

   The following is a typical command to load a bulk log file:

   ```bash
   BULKLOAD -f -t SDCSSEVENT -m DMZ
   F:\logfiles\Agent01\20070413_170421_001-EW_Agent01
   ```
About the agent config tool

This appendix includes the following topics:

- About the agent config tool
- About the commands
- Running the agent config tool

About the agent config tool

The agent config tool is a command-line tool that you can use to view and modify a Symantec Data Center Security: Server Advanced agent's configuration. The agent config tool has many uses, including the following:

- Set the management server port and host name
- Set the management server communications protocol
- Set the path to the SSL client certificate file
- Display and modify an agent's management server list
- Force an agent to re-register with the management server
- Enable or disable the state of IPS driver
- Force the agent log file to rollover

The agent config tool is located in the following directories on an agent computer:

**Windows agents**  
Named sisipsconfig on Windows agents, the agent config tool is located in the agen/ips/bin directory.

**UNIX agents**  
Named sisipsconfig.sh on UNIX agents, the agent config tool is located in the agen/ips directory.
About the commands

The agent config tool commands are as follows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Describe all available commands and syntax.</td>
</tr>
<tr>
<td>-view</td>
<td>Display an agent's current management server list.</td>
</tr>
<tr>
<td>-host (-h)</td>
<td>Set the management server host name.</td>
</tr>
<tr>
<td>-port (-p)</td>
<td>Set the management server port. The port number must be between 1 and 65535.</td>
</tr>
<tr>
<td>-protocol</td>
<td>Set the management server communications protocol.</td>
</tr>
<tr>
<td>-certfile (-c)</td>
<td>Set the path to the SSL client certificate file.</td>
</tr>
<tr>
<td>-failbackinterval</td>
<td>Set the failback interval for the agent to try to communicate with the primary management server.</td>
</tr>
<tr>
<td>-test (-t)</td>
<td>Test the connection information with the nth server in the management server list.</td>
</tr>
<tr>
<td>-forcereg</td>
<td>Force the agent to re-register with the management server.</td>
</tr>
<tr>
<td>-setpolicy (-s)</td>
<td>Replace the current policy with the applied policy.</td>
</tr>
<tr>
<td>-resetpolicy (-r)</td>
<td>Replace the current policy with the default policy.</td>
</tr>
<tr>
<td>-toggleIPSState (-i)</td>
<td>Enable or disable the state of IPS driver.</td>
</tr>
<tr>
<td>-trace</td>
<td>Set Trace to the desired value.</td>
</tr>
<tr>
<td>-rollagent (-a)</td>
<td>Force the agent log file to rollover.</td>
</tr>
<tr>
<td>-rollcsv (-csv)</td>
<td>Force the CSV log file to rollover.</td>
</tr>
<tr>
<td>-retranslate (-n)</td>
<td>Force a policy re-translation.</td>
</tr>
<tr>
<td>-export (-export)</td>
<td>Print the config file.</td>
</tr>
</tbody>
</table>

Running the agent config tool

**Note:** To run the agent config tool, you must have administrative privilege.

If an agent's policy prevents running the agent config tool, do one of the following:

- Apply the null policy to the agent.
- Override the agent’s current policy.


**To run the agent config tool**

1. Log on to the agent computer.
2. Navigate to the directory that contains the agent config tool.
3. At a command prompt, type `sisipsconfig` (Windows) or `sisipsconfig.sh` (UNIX) followed by a command, and then press Enter.

   **Example:** `sisipsconfig -view`
Additional Resources

This appendix includes the following topics:

- Where to get more information

Where to get more information

Product manuals for DCS:SA are available on the DCS:SA product media. Updates to the documentation are available from the Symantec Technical Support and Business Critical Services (BCS) Web sites.

The DCS:SA product manuals are as follows:

- Installation Guide Online Help
- DCS:SA Online Help
- Planning and Deployment Guide
- Overview Guide
- Administrator's Guide
- Prevention Policy Reference Guide
- Detection Policy Reference Guide
- Agent Guide
- Implementation Guide Integration with VMware NSX (for Security Virtual Appliance)
- Operations Director Reference Guide
- vSphere Support Guide
- Release Notes
- Platform and Feature Matrix
The following table lists additional information that is available from the Symantec Web sites.

Table E-1  Symantec Web sites

<table>
<thead>
<tr>
<th>Type of information</th>
<th>Web address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Knowledge Base</td>
<td><a href="http://www.symantec.com/business/support/">http://www.symantec.com/business/support/</a></td>
</tr>
<tr>
<td>Releases and updates</td>
<td></td>
</tr>
<tr>
<td>Manuals and other documentation</td>
<td></td>
</tr>
<tr>
<td>Contact options</td>
<td></td>
</tr>
<tr>
<td>Virus and other threat information and updates</td>
<td><a href="http://securityresponse.symantec.com">http://securityresponse.symantec.com</a></td>
</tr>
</tbody>
</table>